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Getting Started

Welcome to SmartDraw!

SmartDraw is the easy-to-use program that lets anyone
draw great looking flowcharts, diagrams, forms and other
business graphics. You don't have to be an artist to get
results with SmartDraw.

SmartDraw automatically aligns shapes, lines and text. Its
unique, built-in library of design styles lets you pick
professional looking color schemes, shadows, and textures
for your drawings with the click of a mouse. Libraries of
SmartDraw Symbols provide an unlimited selection of clip-
art that you can edit or add to.

SmartDraw works as a stand-alone program, and as part of
Microsoft Office and other programs that support Object
Linking and Embedding (OLE). You can insert a
SmartDraw drawing directly into Microsoft Word for
Windows, using the Insert Object command. With the
Professional version of SmartDraw, you can also insert
Office documents, like graphs, equations, and spreadsheets
into your drawings as SmartDraw symbols.

There are three different versions of SmartDraw:

SmartDraw Standard

This is the standard edition of SmartDraw. It is a 32-bit
Windows application and requires a Pentium (or better) PC
running Microsoft Windows 95, 98, NT 4.0, 2000 or later.
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Professional

SmartDraw Professional

The Professional Edition of SmartDraw has all the features
of SmartDraw Standard plus a collection of more advanced
features, including:

e Spelling checker

Find and Replace

Advanced import and export filters

OLE Client Support

The Microsoft Office Companion

SmartDraw Professional Plus

Professional Plus has the same features as the Professional
Edition of SmartDraw, but also includes a license to all
nine of the SmartDraw Library and Template Collections,
which include more than 30,000 symbols and example
drawings.

This Manual
This manual is common to all three versions. The icon in
the margin to the left indicates professional-only features.

What's New In SmartDraw 5

For users upgrading from earlier versions of SmartDraw,
we highlight here some of the new features found in
SmartDraw version 5.

More than 30,000 New Symbols

In SmartDraw 5 there are almost 20 times as many symbols
as in SmartDraw 4. These are organized into nine different
collections:

e Business & Charting

e Software Design

e NetDrawing

e Floor Plans & Facilities
e Electrical Engineering

e Mechanical Engineering

8 e Getting Started
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e Science & Math
e Clipart & Flyers
e Maps & Geography

The SmartDraw Explorer

The new SmartDraw Explorer makes it easy to browse
these vast symbol collections and to search for the symbol
you are looking for by name.

& wlA] || ||| Ololo]|d]e|clo]| o]

x| |01 |0
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The SmartDraw Explorer

The SmartDraw Explorer shows all of the libraries and
templates, organized into folders, in a tree similar to the
Windows Explorer. Clicking on the folders opens and
closes them. Inside the folders there are icons for each
symbold library or drawing template.

A Preview appears when your mouse hovers over any file
in the Explorer, showing you exactly what's inside that
library or template file. To open the file, simply drag it into
the drawing area, or double-click it.
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Previews and on-demand installation

With SmartDraw’s new library and template previews, you
can search and browse the entire collection using only
about 1% of the disk space that a full installation requires.
When you find a symbol you want to use, opening the
preview file lets you install just what you want,
automatically, either from the SmartDraw Web site or from
your CD.

The Library Builder Wizard

You can import your own symbols into SmartDraw
Libraries using the new Library Builder Wizard. The
wizard will convert thousands of images in many popular
formats (including WMF, Postscript, DXF and others) into
SmartDraw libraries in minutes.

Drawing to Scale

SmartDraw’s new Floor Plans & Facilities collection
really shines with the new drawing-to-scale features. You
can now set the origin of the rulers anywhere in the
drawing. Shapes you add from libraries scale themselves to
the ruler-settings automatically and can be precisely
positioned using the improved Position and Size Dialog.

Tighter Organization Charts

SmartDraw 5 lets you adjust the spacing between the
branches of an organization chart, and any other tree built
with an automatic connector, for better looking charts.

Dropping Shapes on Lines

Drawing circuit diagrams, process flows, and similar
diagrams is literally a snap with SmartDraw 5’s new drop-
on-line feature. You can link electronics symbols like
resistors and capacitors to lines and slide them up and down
the lines like beads on a string.

Export to HTML

Now you can take your great-looking diagram and publish
it on your web site with SmartDraw’s new Export to
HTML feature. Hyperlinks you assign to shapes are

10 e Getting Started
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Profeszional

preserved when you export to HTML, making SmartDraw
the ideal way to draw clickmaps for the web.

SmartDraw Professional

Features

SmartDraw Professional has the following exclusive
features.

Spelling Checker

SmartDraw’s spelling checker works similarly to the one in
Microsoft Office. Words are checked in the background as
you type, and misspelled words are underlined with a red
wavy line. Right clicking on a misspelled word presents a
menu of suggestions.

You can also check the spelling of an entire document upon
command. Automatic correction of popular misspellings is
supported, and you can add your words to your own custom
dictionary.

Most European languages (including British English) are
supported, and you can switch languages on the fly with a
single menu command.

Advanced Import and Export Filters

SmartDraw Professional gives you access to Postscript
Import and Export, plus the vast libraries of technical
symbols in AutoCAD format. It supports many more file
import and export formats than the regular edition of
SmartDraw. These include:

Encapsulated Postscript (EPS)
AutoCAD (DXF)

CGM

HPGL

PDF

Adobe Illustrator

CorelDraw (Import Only)
MicroGrafx Draw

Visio (Import Only)

SmartDraw User's Guide
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OLE Client Support

SmartDraw Professional is an OLE client. As with
Microsoft Word and other Office applications, you can
insert graphs, WordArt, Spreadsheets and other OLE
objects into SmartDraw Professional drawings.

In SmartDraw an OLE object behaves like any shape. It can
be flipped, rotated, moved and re-opened for editing by the
program that created it.

OLE objects in SmartDraw drawings can also be added to
SmartDraw symbol libraries, while retaining their OLE
object properties. Dragging an OLE symbol (like a graph,
for example) from a library into your SmartDraw drawing
creates an OLE object that can be edited by the program
that created it.

The Microsoft Office Companion

If you have Office installed on your system, the Office
Companion adds many more exciting features to
SmartDraw Professional, including the ability to add
bitmaps, graphs, equations and WordArt®, directly from the
SmartDraw toolbar. The Companion also includes galleries
of pre-designed graphs, text styles, and equation symbols,
placed at your fingertips in SmartDraw libraries.

Global Search and Replace
SmartDraw Professional supports global search and replace
for an entire drawing.

Installing SmartDraw

Before you can run SmartDraw, you must first install it by
running the Setup Program. There are two ways you can
obtain this file:

e By downloading over the Internet.
e OnacCD

12 e Getting Started
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Internet Download

You can freely download the SmartDraw Trial Edition
from www.smartdraw.com. You can also download full
versions of the program that you have purchased.

In either case, the file you download to your computer is an
install program. You must run it to install SmartDraw
onto your system.

The simplest way to do this is to download the file to your
desktop. This creates an icon on your Windows desktop.
You can then run the install program by double clicking on
its desktop icon. You can also run the install program using
the Run command under the Windows Start menu.

CD

If you purchased SmartDraw on a CD, all you have to do is
put the CD in your CD drive, and the setup program,
setup.exe, will start automatically. If this does not happen,
you must run setup.exe manually.

The easiest way to do this is to use the Run command,
found by pressing the Windows Start button. Run presents
a dialog that prompts you for the name of the program you
want to run. If you placed the SmartDraw CD in Drive D,
just type:

D:\SETUP

Follow the directions displayed by the Setup program.

Installing SmartDraw on a

Network

To install SmartDraw on a network, simply install it on the
server in the normal way described above. For each client
that will have access to the server, create a shortcut (or
icon) for SmartDraw on the client system and run the
program once. SmartDraw will install itself properly on the
client system.

You must have a network license to share one copy of
SmartDraw between multiple users on a network.

SmartDraw User's Guide
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SmartDraw will not run from a network drive unless you
have a network license.

SmartDraw measures the number of different users that
have accessed the program on the network (not including
the server itself) and limits the number of unique users to
the number of licenses you have purchased. If a user has
accessed the program but no longer needs to use it, you can
free that user's license using the network administration
features under the License command.

Running SmartDraw

Once installed, SmartDraw is added to your start menu, and
a SmartDraw icon is added to your desktop. To run
SmartDraw, double-click on this icon, or run SmartDraw in
the same way that you run your other applications.

Welcome to SmartDraw!

— Toztart,..

_ 0K
@ LCreate a new drawing

Cancel
ﬁl Open an existing SmartDraw Drawing.

@l Open a recently uzed Drawing

ID:\.SDrawﬂr‘sarra_l,J.sdr j

*— Beginning Users

SmartDrawv can provide hints that pop-up the first time that you ty
zomething new. Check the box below if you would like to zee hints.

el

Help

r Tipz for uzing SmartDaw

':@:' Tip #1: *'ou can draw ines and shapes by drawing with the
mouze, as well az by drag and drop.

<< Prev. Tip Mexst Tip 2> Detailz... |

v Show welcome Dialog
To stop showaing this dialog on startup, uncheck the box above. You can reset thiz in

the Tools: Dphiong dialog.

The Welcome Dialog

The first time you run the program you are presented with
the Welcome Dialog.

This lets you choose how to start your first drawing and
shows you useful tips for using SmartDraw.

14 e Getting Started
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You can start by creating a new drawing or by opening an
existing drawing file. If this is the first time you have used
SmartDraw, you will probably want to create a new
drawing.

Later, once you have a list of previously saved drawings,
typing Enter at the Welcome dialog opens the last one you
were working on.

You can make one of these start-up choices permanent (if
you want to skip the Welcome dialog each time you run the
program) by using the Options dialog. (See page 222). As a
shortcut to this, you can un-check the Show Welcome
Dialog checkbox at the bottom of that dialog, and you will
automatically create a new drawing each time you run
SmartDraw.

The Show Hints checkbox controls whether or not you see
beginner's hints while you are using the program. These are
dialogs that pop up automatically when you try to use
certain features of the program for the first time. They
attempt to explain what you are about to do and provide a
direct route to more detailed help.

Each hint will only appear once in each SmartDraw
session, and the hints can be switched off from any Hint
dialog. We recommend that you leave the Hints switched
on the first few times you use the program.

Once switched off, hints can be switched on again using the
Options dialog.

Getting Help
SmartDraw has extensive on-line help. There are several
ways to access the help system.

Help Menu
The Help menu shows several commands that open the
help window.

View Tutorial displays a quick, 12-lesson Tutorial on
drawing with SmartDraw. It covers just the basics to get
you up and running fast.

SmartDraw User's Guide
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Contents shows the table of contents. Double clicking on
any of the underlined items takes you to the screen for that
topic.

Index presents the index to the help system. If you start to
type the name of the subject you are looking for, the
scrolling list of topics will show any words that match.

Using Help opens the help files for the Windows help
application. If this is not installed on your system (by
Windows), this command will not work.

Help in Dialogs

All dialogs contain a help button. Pressing this button, or
typing the F1 key, opens the help system showing a screen
that describes that dialog’s controls.

Context Sensitive Help

When a dialog is not showing, pressing Shift-F1, or
pressing the help button on the toolbar (shown at left), puts
you in the help state. While in this state, selecting any of
the menus, or pressing any of the buttons in the toolbar or
library window, opens Help with the appropriate screen
displayed. The Help State is canceled after you click or
show a help screen.

Tips

Tips are helpful hints that bring some of the richer features
of the program to your attention. A new tip is shown each
time that you see the Welcome dialog. You can also look at
tips at any time using the Tips command under the Help
menu. This presents the Tips Dialog.

Tips
Tipz Far Uzing SmartDiraw

Tip #18: Make fine adjustments in the size of zelected
ohjects by typing the amow keps with the hift key
held down.

<< Prev. Tip Detailz. . Mext Tip =

The Tips Dialog
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You can browse through all the tips using the Next and
Previous buttons. The Details button brings up a help
screen describing the tip in more detail.

SmartDraw Advisors

SmartDraw Advisors are special help screens that appear in
the Advisor Window when certain libraries and templates
are opened. They provide tips for using the template or
library in question.

& 5D Advisor - organization chart M= E

Tips for Organization Charts:

This organization chart was created using a
combination of rectangular shapes and branching
Auto-Caonnecting lines (the right-most of the four line
futtons an the SmartDraw toolbar).

You can add new shapes to the org chart by simply
dragging therm from the toolbar and positioning them
near the spot where you want to insert them. The
Auto-Connector will "grab" the shape and display
several positions where the shape can be linked.
Release the shape near the appropriate link point and
the Auto-Connector will autamatically add it to the chart
in that position.

|~

The SmartDraw Advisor Window

The Advisor window always floats on top of the drawing
window. You can drag it (by its title bar) to any convenient
position. If you open (or simply click in) a second
document or library that has a different advisor screen, the
contents of the Advisor window will change to display the
new information.

If you close the Advisor window by clicking in the "X" box
in the title bar, you can choose to turn off this particular
advisor so that it does not show automatically in the future.
You can also turn off all advisors. If you make this choice
you can turn them on again using the Options Dialog (see
page 222).

You can create your own advisors and associate them with
drawings and libraries. See page 220.

SmartDraw User's Guide
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Creating a New Drawing

A new drawing is created (a) when you start the program,
or (b) when you press the New Drawing button on the
toolbar, or (c) when you use the New... command under the
File menu. In all cases, SmartDraw shows the New
Drawing Dialog.

Create New Drawing

| e | S
e | engeing | MG
| @ |
Maps ks Bhsia.

IF your dior't see a buston for the drawing pou waant, just pick the: one most smilan or press Help,

Help ] I:nrnell gwturpnu...l Ernalzﬂl.nrkl'.'lrm

The New Drawing Dialog

This shows a button for each type of drawing you can
create with SmartDraw.

If you double-click on a picture button (or select one with a
single click and then press Create Blank Drawing) you
create a new empty drawing space with the correct settings
for this kind of drawing. These settings include ruler
properties, line- and shape-linking properties, and
sometimes a special toolbar for this type of drawing.

If you don’t see a button for the type you want, select the
one that seems most similar.

The View Examples button allows you to select a
SmartDraw Template. A template is a drawing that already
contains objects, as well as the correct settings and
toolbars. Some templates are Example Drawings, while
others are designed to serve as a starting point (like an
empty form template that is ready to be filled in)..

There is a detailed discussion of how to modify the buttons,
or create your own, in New Drawing Buttons on page 215.
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Selecting a Template

Pressing the View Examples button in the New Drawing
dialog takes you to the Template Dialog.

Create a New Drawing From a Template or Example HE

—Open atemplate or example:——— [ Preview
Maps Geography

L, =)

British unties
Canada

East Asia
EL

Europe

Example-County Territories

Example-Zip Code Custormer Map

MORE - v
South Armerica
Southeast Asia =

Hint:

Click on the name of atermplate to see a preview.
Ornce you hawe selected the template that vou want, press the << Back
Create Buttan.

Create

Help

dil

The Template Dialog

The Template Dialog allows you to preview each template
by selecting its name in the list. Once you have made your
selection, pressing the Create button creates a new untitled
document that has the same settings and contains the same
shapes as the currently selected template.

Templates are described in more detail on page 218.

Each drawing has its own scrollable window. Normally
drawing windows are opened so that they fill the entire
SmartDraw program window (they are maximized).
Depending on the settings on your system, you may have
up to 32 different drawings open at the same time.

Closing and Saving Drawings

You may close a drawing window using the Close
command under the File menu, or by clicking the window’s
close box in the title bar. Any changes you have made to
your drawing DO NOT become permanent unless you save
them. If you have made changes since you last saved, you

SmartDraw User's Guide
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are reminded to save your drawing before the window
closes.

You can save drawings to a file on your hard disk using the
Save or Save As commands under the File menu. Pressing
the Save File button on the toolbar also saves the drawing.

New drawings must be given a name before they are saved.

You do this with the standard Save Dialog you see in all

Windows programs.
Save HE
Save jn: Ia Sdprods vl

Diagrams @ Samplez.zdr
Flyers
Frames

Libramy
Styles
@ Samplel.sdr

File name:

S ample2. s Save I
Save az lype: | SmartDraw File[”. SDR] j Cancel |
Help |

The Save Dialog

For drawings that have been saved, and already have a file
name, the Save As command can be used to save the
drawing to a different file name. The Save command saves
the drawing to same filename.

While you can save templates with the Save Dialog, if you
want them to show in the SmartDraw Explorer, use the
Save As Template command (File menu) instead.

Opening an Existing Drawing

Once a drawing has been saved to a file on disk, you can
re-open it using the Open command under the File menu or
by pressing the Open File button on the tool bar. These
commands show you the standard Windows Open Dialog.

20 e Getting Started
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Open

Laak in: I £5] Sdpro9s
Diagrams
Flyers
Framesz
Library
Styles
@ Samplel. sdr
File name: ISamNeZsm Open I
Files af twpe: |SmartDraw File[*SDR]) j Cancel |
Help |

The Open Dialog

You can also open the SmartDraw drawing files by simply
dragging them from the Windows Explorer and dropping
them anywhere in the SmartDraw window.

Drawings and Windows

Each SmartDraw drawing has its own document window.
SmartDraw is a Multiple Document Interface (MDI)
application, and up to 32 drawing windows can be open at
the same time.

When these windows are maximized, as is usually the case,
the front-most window covers the entire screen, or program
window, so that none of the other drawing windows can be
seen. This can be changed using the commands under the
Window menu.

Cascade Windows and Tile Windows commands both
show all the drawing windows, the former by overlapping
them, the latter by dividing up the program window.

The remaining items on the Window menu are the names of
the open drawings. Selecting one of the items brings that
drawing to the front.

All menu, and other, commands apply only to the front-
most drawing.
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Right Mouse Button Menus

Clicking with the right mouse in the document window
displays a context-sensitive menu. The contents of this
menu depend on what you have clicked on. You will find
this a convenient shortcut to many of the features found on
the main menu bar.

The Program Toolbar

The Program Toolbar lies above any drawing windows
and below the menu bar.

DizE SlR| &|BlE|-| 2|o| | &| =B|s]u|ajab o #l@
[5 #|A| /| |r|-|=] Slolo|olelalo]o|2|VIalalola|o| 0]
The Program Toolbar

The program toolbar can be shown or hidden by selecting
the Show Toolbar item under the View menu.

The buttons on the top row are shortcuts for menu
commands. You can find out what each one does by
holding the cursor over a button for a second or more. A
small yellow window pops up describing its purpose. This
is called a ToolTip.

The buttons in the second row are used for drawing. One of
these buttons appears to be pushed in, indicating that this
button is selected. The button selected determines what will
happen when you click with the mouse in the drawing.

When the arrow button is selected, clicking in the drawing
selects, moves or resizes existing objects.

When the multiple selection button is selected, clicking on
an object selects it without deselecting other selected
objects. This makes it easy to select more than one object at
a time.

When the text button is selected, clicking on a shape opens
it for text entry. If you click in the background of the
drawing, you create a new background text object.

When the line button is selected, clicking and dragging in
the drawing draws a straight line. Dragging and Dropping
also draws a line.
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When the arc button is selected, clicking and dragging in
the drawing draws an arc of a circle. Dragging and
Dropping also draws an arc.

When the segmented line button is selected, clicking and
dragging in the drawing draws a segmented line. Dragging
and Dropping also draws a segmented line.

When the curve button is selected, clicking and dragging in
the drawing draws a curved version of a segmented line.
Dragging and Dropping also draws a curve.

When the Connector button is selected, clicking and
dragging in the drawing draws an Automatic Connector.
Automatic Connectors are described in more detail in
Automatic Formatting with Connectors on page 134.

The remaining buttons draw the shape shown on their face.
The shape buttons can be configured to show any of the 24
standard shapes, and to control the default size and
proportions of the shapes that are dragged and dropped.
You can change the button settings, by double clicking on
the button, or selecting the Toolbar item under Tools
menu. This is described in Changing the Toolbar on page
224.

The Document Toolbar

A Document Toolbar appears at the top of a document
window. When the document is maximized, the document
toolbar appears to be a third toolbar below the program
toolbar.
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Document Toolbar below the Program Toolbar.

A document toolbar is a SmartDraw Library window that
has been dragged to the top a window and “docked” there.
It behaves just like a library window and is fully
customizable. Many of the built-in templates have their
own specialized toolbar.
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Document toolbars are described in more detail on page
145.

Rulers and Grids

Rulers are normally displayed along the top and left edges
of the drawing window.

E Untitled 1 M=] E3
1 2 3

B |||||||||||l|||||||||||l|||||||||||l||||||||

. i

:4' | bl

Drawing Window with Rulers and Grid Showing

The divisions on the ruler define the spacing of a grid that
covers the drawing area. You can show or hide the grid
using the Show Grid command under the View menu. The
same grid (whether showing or not) controls the spacing of
the snaps.

The top-left corner, where the rulers cross, shows a digital
display of the current position of the cursor in the units of
the ruler.

Clicking in a ruler displays a temporary dotted line, called a
Guide, that follows the position of the cursor. This can be
used to measure the position of an object in the drawing.
Clicking in the corner, where the two rulers cross, and then
dragging displays two of these lines forming a "cross hair"
arrangement.

Symbol Library Windows

Symbol Library Windows contain symbols that can be
added to SmartDraw drawings, just like any of the standard
shapes on the toolbar.
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Groups of symbols are stored in Libraries. Libraries are
usually groups of similar symbols that are used for a
particular type of drawing. SmartDraw has hundreds of
libraries with symbols for flow charts, computer networks,
floor plans, clip art, engineering, geometric shapes, and
many more.

Once a library has been opened, its symbols are displayed
in a Library Window that “floats” above the drawing. Up
to 16 library windows can be open at the same time, each
showing the contents of a different library. The Libraries
menu shows the most recent libraries that were opened and
shows a check mark next to the names of those that are
currently open. Selecting one of these menu items either
opens it or brings it to front.

Any library window that was left open when the last
drawing was closed is always re-opened automatically (in
the same location) whenever a drawing is opened again.

Flowchart [HE

Libraries
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A SmartDraw Library Window

The library window shows rows of buttons, each displaying
a different symbol from the current library. The name of
the current library is shown in the window title bar.

The SmartDraw Explorer

All of the libraries, templates and example drawings that
are included with SmartDraw are shown in the SmartDraw
Explorer panel on the left of the drawing area. You can
show or hide this panel using the View menu, but it is
shown by default.
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The panel shows the libraries and templates installed as
icons in an explorer-like tree organized into categories.
Double clicking on a library icon or dragging it into the
drawing area opens the library window. Double clicking or
dragging a template icon into the drawing area opens the
template into a new window. The SmartDraw Explorer is
described in much more detail on page 70.

Undo

Almost any change you make to a drawing can be undone
using the Undo command, under the Edit menu.

When you undo, the undo menu item changes to Redo.
Using Redo returns the program to its state before the undo
command was used. Repeated use of Undo toggles the
program between the current state and the state before the
most recent operation.

If the command is gray, there is no previous state to return
to.

The Undo button on the toolbar can also be used to perform
an undo or redo.
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Changing the Page Size and
Orientation

All SmartDraw drawings have the same 50x50 inch
drawing area. This fixed area is divided up into “tiles”
equal in size to the printable area of the printer paper
currently selected.

Unless your drawing is large, you normally work only with
one page in the top left corner of the 50x50 area. However,
this system allows you to draw very large charts that flow
across many pages, print them out on normal paper, and
then join the sheets together to re-create the drawing at full
size.

You can change the size and landscape/portrait setting of
the pages using the Page Setup command under the File
Menu. Just select a new paper size and orientation using
the Page Setup dialog. This will not change your drawing
area, but it will change the way the drawing is printed out.
You can see the page boundaries in the drawing area as
dotted lines. Change the View to Fit to Window to see this
quite clearly.

Page Margins

Because SmartDraw drawings are often printed on several
pages and then re-assembled again into one large chart,
SmartDraw always prints on as much of the page as is
allowed by the printer.

Most printers reserve a small margin of about ¥4 on each
page that cannot be printed on.

If your drawing fits onto just one page and you want larger
margins than this, simply leave extra space at the edges of
your drawing. You can center your drawing on the first
page using the Center Drawing on Page command under
the Arrange menu.
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Storing Two or More Drawings in
the Same Document

Because SmartDraw supports 24 or more pages per
document, you may be tempted to put independent
drawings on different pages in the same file.

Don’t do this! Store each independent drawing in
its own document.

The multiple page feature of SmartDraw is intended to
allow you to draw one drawing, larger than a single page. It
is not intended to allow you to put 6 different flowcharts in
one file. Commands like Center Drawing on Page and
Print on One Page assume that the contents of a file are
one drawing. There is nothing to gain by storing multiple
drawings in one file. Put all the drawings you want to print
separately in their own drawing file.

If you have already put more than one drawing in the same
file, it is easy to separate them using Copy and Paste as is
explained on page 178.

Default Settings

In SmartDraw you change the default characteristics (color,
thickness, font, etc.) for new objects by changing the
characteristics of an existing object.

When you change a property of an existing object, such as
the fill color of a shape, the next shape you create will have
this fill color automatically. When you change a property,
you change the default setting for new shapes and lines at
the same time.

The few exceptions to this rule are specialized settings that
users are unlikely to want as a default.

You can also set the initial defaults for new drawings. This
is described in Settings for Empty Drawings on page 220.
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Exiting SmartDraw

You can exit SmartDraw by using the Exit command under
the File menu. You can also click in the program window
close box. Before the program quits, you are prompted to
save any open drawings that have been changed.

The Basics of Flow Charting

Flow charts are diagrams that portray the flow of
information and the decision-making process that controls
the flow. While many styles of flow-charting have
developed, each with its own set of specialized symbols,
most processes can be represented using just a few simple
symbols.

This represents an activity such as "signing a check", or
"requesting a bid".

This represents an alternate type of process. You can use
the two types of process symbols to classify processes into
two groups: customer vs. supplier, for example.

This is used to represent a decision that must be made.
Lines representing different decisions are often drawn
coming out of some of the 4 different points in the shape.

This symbol is used to represent information coming in and
going out of the system, such as a customer order (input) or
a product (output).

This symbol is used to represent printed information
generated by the system such as an invoice or other report
(output).

This symbol is used to connect multiple lines together, or
when labeled with a letter, to indicate that the flow
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continues at the connector with the same letter on another
page, or somewhere else in the system.

This symbol represents the starting or ending point of the
system. It is usually labeled "Start" or "End".
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The SmartDraw Quick Tutorial

SmartDraw Quick Tutorial: The
Basics of SmartDraw in 12 Easy
Lessons

What Can | Do With SmartDraw?

SmartDraw is the easy-to-use graphics program that takes
the drawing out of drawing. With SmartDraw you simply
drag and drop lines and shapes with your mouse to create
beautiful, professional-looking drawings and diagrams:

FlowCharts  FloorPians -
7 ) I L= |
: - - W | ma _
- T T T -
e 2 5o L __"-
Science Networks Forms
Plus:

Circuit Diagrams

Fishbone Diagrams

Chemical Formulae

Mechanical and Electrical Engineering Diagrams
Maps

Flyers, Invitations, Signs, Certificates

Timelines

Many other types of business and technical graphics

Drawing Made Easy

SmartDraw automatically aligns shapes, lines and text for
you. Its built-in library of design styles lets you pick
professional-looking color schemes, shadows, and textures
with the click of a mouse. You’ll find over 30,000 ready-

SmartDraw User's Guide

The SmartDraw Quick Tutorial e 31



made shapes and images in the Symbol Libraries, and you
can even add your own, for a truly limitless collection.

Working with Other Programs

SmartDraw works as a stand-alone program, and as part of
the Microsoft Office, and other programs that support
Object Linking and Embedding (OLE). You can insert a
SmartDraw drawing directly into Microsoft Word for
Windows with Cut & Paste, or with the Insert Object
command.

Tutorial Lesson 1: Starting the

Program

When you run SmartDraw, you are presented with the
Welcome Dialog. (A dialog is window that gives you
choices.) You can choose to Start a New Drawing or Open
an Existing Drawing.

If you Start a New Drawing, SmartDraw displays the
Create a New Drawing dialog. You can start your drawing
with an Example or Template (a ready-made drawing that
serves as a “starting point”), or you can simply click
Create Blank Drawing to start with an empty page.

Create New Drawing

Lol
Fhmm LS | ok | o | enpmeenng | Pomfncd
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T
IF wour dior't see a buston for the: drawing wou want, just pick the one most smiar or press Help,

Help ] Eurnell Wiew Exarrgles.. | Erualeﬂlurktlrm

The “Create a New Drawing” dialog

If you don’t see a button for the kind of drawing you want,
you can press More to see additional types. If none of the
available types are exactly what you want, just pick the one
most similar.
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To create a new blank drawing, just click on the button for
the desired type, then click Create Blank Drawing. If you
want to see some ready-made examples or templates for
your chosen type of drawing, click “View Examples.”

Create a New Drawing From a Template or Example [ 7] x|

— Open atemplate or example:——— [ Preview
Maps Geography

alla
titish Counties
Canada
East Asia
EU
Europe
Example-County Territaties
Example-Zip Code Customer Map

MORE = u

South Armerica

Southeast Asia 4|
Hint. Create
Click on the name of atemplate to see a preview.
Once you hawve selected the template that ywou want, press the << Back

Create Button,

Help

]

The Template Dialog

Clicking View Examples displays the Template Dialog.
You can choose from the list of examples and templates
available for your type of drawing. Finally, click Create to
start your drawing with the chosen Template.

Tutorial Lesson 2: Basic Drawing

You begin most drawings by dragging Shapes from a
library or Toolbar and dropping them on the page. With
the left mouse button, click down on the desired shape on
the SmartDraw toolbar; drag the shape into the drawing
area, and release.
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Dragging a rectangle from the Toolbar

You can connect shapes with Lines. To connect two shapes

with a straight line, click on the Straight Line Tool “lon
the Toolbar and release.

Now your cursor looks like a pencil. & Touch the pencil to
the edge of one shape and click down with the mouse
(you’ll see black dots on the edge of the shape). Drag the
pencil to the edge of another shape, and release.

I

starting a line from a shape

Anchoring a Line to a Shape

The black dots are Connection Points.

These points mark the places where a shape can be attached
to a line or another shape. When you see Connection
Points, you know your shape is ready to be attached to

something. The Anchor Symbol ‘5} appears when a Line is
anchored to the edge a shape.

Once connected, lines and shapes stay connected, even if
they are moved or stretched.
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Shapes stay connected
when one is moved.

(Note: if your lines don’t stay connected to your shapes,
make sure ““Allow Lines to Link,” under the Arrange menu,
is turned on.)

Infinite Connection Points

If you want more Connection Points on a particular shape,
you can choose Connection Points from the Shapes menu
and select Infinite Connection Points. This allows you to
attach lines to any point on the shape’s perimeter.

Dropping Shapes on Lines
You can also "drop" a shape on a line, when Allow Shapes
to Link to Lines is turned on under the Arrange menu.

mmmmmmmmm e ————
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slide along the ling—»

Dropping a Shape on a Line
The center point of the shape will attach to the line. Once
attached, the shape will stay with the line if the line is
moved. You can slide the shape along the line like a bead
on a string. This is ideal for making electrical circuits and
other engineering diagrams.

Repeating an Operation (or, Making a Toolbar
Button “ Stick”)

When you need to perform the same operation several
times in a row (for example, drawing a series of lines), you
need not select the same button on the Toolbar time after
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time. To make a Toolbar button “stick” in the selected
position, hold the shift Key while you click on it.

Tutorial Lesson 3: Selecting
Objects

Before you can move, stretch, color, or manipulate a line or
shape on your page, you must Select it. The Selection Tool
[ (at the far left of the Toolbar) is your normal cursor. To
Select a line or shape on the page, simply click on it with
the Selection tool.

A selected object has black Selection Handles at the
corners.

By dragging these handles, you can stretch or resize the
object.

Growing an object
A selected object also has a Rotation Handle.

By dragging the rotation handle, a shape or line can be
rotated to any angle.
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Selecting Multiple Objects

You can select several objects at one time. (This is useful
for Grouping objects or for applying a common property,
like a color, to all of them).

SmartDraw offers three ways to select several objects:
1) Hold the shift-Key down while clicking on each object in
turn with the normal selection tool.

2) Choose the Multiple Selection Tool %! on the toolbar
(beside the regular selection tool) and click on a series of
objects with it.

3) Trace an imaginary “box” around the group of objects
with the mouse. Click in an empty area of the page, hold
the mouse button down, and drag the mouse until the dotted
box encloses the objects you want to select. Then release.
All of the objects inside the box will be selected.

"Boxing" with the mouse N\S

All objects selected %

Boxing is useful for deleting unwanted objects from your
page. Simply trace a box around the area you want to
delete, then hit the delete key.

Select All
You can select all the objects in your drawing at once by
choosing Select All from the Edit menu.

SmartDraw User's Guide

The SmartDraw Quick Tutorial e 37



Tutorial Lesson 4: Using Lines
SmartDraw has four basic types of lines.

The Straight Line | draws a straight line between two
points. In Lesson 1, we connected two shapes with a
straight line. You can also connect lines to other lines.

The Arc 7~ draws a section of a circle, of any size and
curvature you want. You can bend the arc (using its
handles) create anything from a straight line, to a complete
circle of any desired radius.

C O

Some of the things you can do with an Arc

The Segmented Line | attaches itself perpendicularly to
objects. It travels from point A to point B in straight
segments with 90-degree turns. (Don’t worry if it flops
around while you’re drawing it. When you finally anchor it,

it will fall neatly into place.)

NS

A Segmented Ling connecting two shapes

The Curved Line |i attaches itself perpendicularly to
objects, and it travels from point A to point B in a smooth
curve.

NS

A curved ling connecting two shapes
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Change Line Shape

Any line in your drawing can be instantly converted to a
line of another type by using the Change Line Shape
command under the Lines menu.

(M Toxt  Draw  Libraer  Window  Help

Style L4 nlt
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Change Line Shape — || 1l > |~
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Tutorial Lesson 5: Adding Text to
Your Drawings

SmartDraw makes it easy to add text to your drawings. If
you want the text to appear inside an object, simply select
the object (click on it) and start typing. Your text will
automatically appear inside the object, and it will stay there
even when the object is moved.

If you type more text than the object can hold, the text will
automatically shrink (to a minimum size that you can
control). Or, if you choose, your shapes can grow to
accommodate more text as you type. You control this
behavior using the Text Entry Properties command under
the Shapes menu.

Text Text Text Text
Text Text Text

Obijects can grow to accommodate text

/ ; f Text Text /
/ Text / Text Text

Or text can shrink to fit the object
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By default, your text will appear in the center of your
objects. But you can always change the position and
alignment of the text with the Alignment feature on the

Text menu.
Elﬂliﬂ
al EEIE]
BEEEl
The text alignment menu
Editing Text

To modify a piece of existing text, double-click on it to
enter the Editing mode. All of the normal Windows text
editing conventions apply: Dragging with the mouse selects
text. Selected text can be cut, deleted or copied. The font,
size, style and color of selected text can be changed using
commands on the Text menu.

Adding Text to Lines

SmartDraw makes it easy to label the lines in your
drawings. As with shapes, you can add text to any line by
selecting the line (clicking on it) and typing text.

Ir - x‘l

—Text on a]me@ m? :.,HNJ'
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The text stays attached to the line, even when the line or its
adjoining shapes are moved.

Background Text Objects

Text in SmartDraw does not have to be attached to a shape
or line. You can create Background Text Objects, free-
floating, independent objects that can be moved, rotated, or
repositioned anywhere in your drawing.
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Text obfects can be selected, rotated and repositioned

To create a Background Text Object, first select the Text
Tool [Al by clicking on it. Then click once anywhere in the
empty background of your drawing. A blinking “insertion
cursor” will appear. Enter your text, then click once in an
empty area of your drawing to end the text entry session.
Any text you typed will become a free-floating object. You
can move, rotate, or reposition this text object anywhere in
your drawing.

Tutorial Lesson 6: Colors,

Shading, Borders, Arrowheads
You can fill a SmartDraw shape with color or change the
weight, style and color of its borders. Select the shape,
then choose the appropriate command from the Shapes

amjes)l |

Lines can be modified using the Lines menu. You can
change the weight and style of a line, or put arrowheads on
it with the Arrowheads command. Each end of a line can
have a different kind of arrowhead.

A

Basic Line Heavy Style Dash Style Arrowheads
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Tutorial Lesson 7: Automatic
Connectors (the Easy Way to
Draw Perfect Charts)

The Automatic Connector ﬂ is a special kind of line that
automatically connects several shapes together into evenly

spaced patterns.
S —

Organizational Chart  Network Diagram — Fishbone Diagram

To use a new connector, drag and drop a connector ﬂ
from the toolbar onto the page. Then drag a shape from the
tool bar and drop it on the connector, so it looks like this:

Then drag another shape to the connector, and another, so it
looks like this:

Three boxes on a Connectar
The connector arranges the shapes in a straight line and
spaces them evenly.

To change the connector’s shape, select the connector line,
then choose Change Connector Shape from the Lines
menu. Choose from the array of connector shapes:
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The result

Loose Ends

The ends of the connector stick out so they can be attached
to other objects. To get rid of the loose ends, select the
connector line, then grab the end and tuck it under the
nearest line or shape.

] k

Tucking away a loose end

To get the end back, select the connector and pull the end
out from the nearest line or shape.

Lines (and connectors) can be attached to a connector to
make a hierarchy of levels.
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Organizational chart with 2 connectors

Adding Shapes to a Connector

When a shape or line is moved near a connector, Link
Points appear, and the outline of the moving object jumps
to the closest link point, showing its position if linked.

Releasing the mouse attaches the object to the connector,
inserting the object at the link point.

—Link—»=
."L—‘—J_ o1 |

Linking to a Connector

Moving a shape away from the connector disconnects it,
and the shapes still linked to the connector draw together to
fill the space.

— Link Femoved 2w
| |

Breaking a Link to a Connector
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Dragging a shape from one link point to another changes
the order of the shapes.

— Shape Moved 2=
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Re-arranging a Link to a Connector

Tutorial Lesson 8: How to Line
Things Up

SmartDraw can automatically arrange the objects in your
drawings into neat, regular patterns. First, Select the objects
you want to arrange. Do this by clicking on each object in

turn with the Multiple Selection Tool. ]

f - i -
o \ / —H

0 = il Target Object

O £l
The last object you click is called the Target Object. It has
black selection handles. When you use Align or Make Same
Size (under the Arrange menu), all the selected objects will
be aligned or re-sized to match the Target Object.

When you choose Space Evenly, the objects at each end of
a series stay fixed, and the others are spaced evenly
between them.

Results after using: Align, Make Same Size, and Space Evenly

Using Grid Snaps

Behind the SmartDraw page is a Grid, an invisible set of
lines that can help align your objects. To see the Grid,
select Show Grid from the View Menu. When you draw
with Use Snaps turned on (Arrange menu), the objects in
your drawing automatically align themselves with the
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nearest Grid line. This makes it easy to get straight lines
and neat arrangements.

Using the Define Rulers and Grid command (View menu),
you can choose which point in your objects aligns with the
grid (you can snap to either the center or top left corner).

To position your objects freehand, without using to the
grid, turn off Use Snaps under the Arrange menu.

Making Fine Adjustments in Position

To move any line or object in the smallest possible
increments (1 pixel at a time) select the object you want to
move, and “nudge” it with the arrow keys. This technique
is much more precise than moving with the mouse.

Other Commands on the Arrange Menu

e Flip (mirror) an object.

e Rotate an object to a specific angle (permitting greater
precision than the manual Rotation Handle.)

e Send to Back, or Send to Front. If the object you want
is hidden behind another, select the obstructing object
and Send to Back.

e Allow Lines to Link - When this is on, lines “link” and
stay connected to lines or shapes.

e Allow Shapes to Link - When this is on, shapes “link”
and stay connected to each other.

e Allow Shapes to Link to Lines - When this is on,
shapes “link” and stay connected to lines. They can be
moved up and down the line like beads on a string.

Tutorial Lesson 9: Grouping and
Un-Grouping Objects

Sometimes several objects are more conveniently handled
as a Group. When objects are Grouped, they are treated as
a single unit. They maintain their positions relative to each
other, even when moved or rotated. A change made to one
applies to all.
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To Group several objects, first select them all (using the

Multiple Selection Tool). | Then select Group from the
Arrange menu.
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Separate Shapes  Select All After "Group” Rotated Group

Once Grouped, the objects can no longer be selected
individually. If you rotate or re-size a group, all the objects
rotate or re-size together. If you change a property (like a
color), all objects in the group change.

To use the Grouped objects individually, you must
UnGroup them. Select the Group, then pick UnGroup
from the Arrange menu.

Tutorial Lesson 10: Using the

Libraries

SmartDraw has hundreds of Symbol Libraries, containing
special shapes, objects, and pieces of clip-art ready to be
dropped into your diagrams.

Clicking on the Open Library button EI on the Toolbar, or
choosing Open SmartDraw Library from the Libraries
menu, opens the SmartDraw Explorer. This is normally
already open.

You can see all your SmartDraw libraries and templates in
the Explorer Tree.
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As your mouse hovers over each library in the tree, a
Preview pops up showing the contents of that library.

Double-click the library to open it, or drag it to the drawing
area. The newly opened library floats above your
document. You can move it by dragging on the title bar of
the library Window.

£ NETWORK M= E3
Libraries

wf = = s
Dlatla=

A floating Library Window

@Hlﬂﬂ

2

Docking

If you drag a library window to the top of your document
window, it will Dock and become a Document Toolbar.
You can Detach a docked toolbar by right-clicking on it
and selecting Detach.

D= Sl =@« 2o | &
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o o] ][] o] 3 D o] e P 2 el =

Document Toolbar below the Program Toolbar

The Document Toolbar is a Library of symbols appropriate
to a particular kind of diagram. It appears below the
Program Toolbar (the “normal” toolbar) at the top of the
SmartDraw Window.

Drag and Drop from Libraries

Drag shapes and objects from the library onto your page
(by clicking and dragging with the mouse), just as you
would from the Toolbar.
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Adding Shapes to Libraries

You can add a shape or symbol (even one you created) to
any SmartDraw Library. Open the library to which you
want to add the shape. Then simply drag the shape from
your page and drop it in the library.

If the shape is a new one that you created, you can use the
Join to Make a New Shape command (Lines menu) to join
your separate lines into a shape that SmartDraw recognizes
as a single unit.

Drawing To Scale
Obijects in libraries can automatically scale themselves to
your drawing as you add them.

To use auto-scaling, double-click on any symbol button in a
floating library window to bring up the Edit Symbol
dialog. Click on Scale to Ruler Settings and type in the
real-world size of your object.

Preferned Size: Image
" Use Fixed Size % Scale to Fuler Setting?

fidth: I'IE.EE Hgight:ldE.DD
Urits: Ilnches vI

Make sure the ruler settings for your drawing are set to the
appropriate scale (see Define Rulers and Grid under the
View menu). When you add the object to the drawing, it
will scale itself according to the ruler settings.

For example, if a drawing has rulers set so that one screen
inch is equivalent to 48 inches, then a 36-inch desk symbol
will be sized automatically to be 0.75 inches long in the
drawing.

This is useful for scaled drawings like Floor Plans.

Creating New Libraries

To create a Library of your own, select Create New Library
from the Libraries menu. You will be prompted for the
name and location of your new library. (For more details,
see Libraries, New in the SmartDraw Help.)
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Add shapes to your new Library by dragging them from
your page, or from other libraries. You can make a custom
library of the shapes you use most often, and Dock it as a
toolbar for your convenience.

Tutorial Lesson 11: Tables and
Forms

You can create a table by clicking the Table Button @ on
the toolbar, or by selecting Add New Table from the
Tables menu. Tables are particularly useful for creating
timelines, organizational charts, software diagrams, and
business forms.

Adding a new table presents the Format Table Dialog,
where you define the properties of your new table:

Format Table E

— Select a Table Format

Preview oK.
| Cancel |

i

Simple Grid
Simple Colurng

Simple Rows

Headings with Grid
Headings with Columns
Columne 1

Calurnz 2 LI

Help

— Parameters

Muriber of Baws: IB MNumber of Calurmns: IE BedaEe

™ Resize the table to fit inside the shape
Bemove...

ik

[ Do not include any of the text shown when applying this format.

The Format Table Dialog
You can choose from among the ready-made table formats,
or define your own by specifying the number of rows and
columns. Click OK to add the new table to your drawing.

You can even insert tables inside shapes, to create multiple
text-entry areas:
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Different Shapes Containing the Same 2x4 Table

You can manipulate a table’s rows, columns and cells in
countless ways. You can join, split, or color the cells. You
can drag the cell dividers to create wider or narrower rows
and columns. You “lock” the text in certain cells so it can’t
be modified (very useful for creating the prompts in
business forms.) SmartDraw can even automatically fill in
the cells with numbers, dates, days of the week, months of
the year, and other common data patterns, saving you the
trouble of typing long series of data.

YES

Some different table formats

You can even create business forms containing “live” data
fields that can be filled-in on-screen:
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This entire business form consists of a single table

To learn more about the powerful features of SmartDraw’s
Tables, browse through the commands under the Table
menu or see Adding Tables to a Drawing.

Tutorial Lesson 12: The
Professional Finish (Colors and
Shadows)

SmartDraw provides dozens of pre-formatted Styles to give
your drawings a polished, professional look. Choose
Colors and Shadows from the Edit menu to see a list of
styles you can choose from.

Selecting a style affects your entire drawing—each shape
and line in the drawing is modified to match the selected
Style. You can choose from different background colors,
border and fill colors, shadows, and three-dimensional
(raised and lowered) edge effects.

Here are just a few examples:
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Basic Black & White Colar on White

==

Fastel Haised

'

Enjoy SmartDraw

We hope this quick overview has helped you get started
with SmartDraw. For complete information on
SmartDraw’s features, which go well beyond those
described here, consult the rest of the on-line or printed
SmartDraw User’s Guide.
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Drawing with SmartDraw

Adding Objects

A SmartDraw drawing is made up of shapes and lines.
Shapes and lines are called Objects.

You add shapes and lines to your drawing using the bottom
row of buttons on the program toolbar,

[k Al A s =] glololole|al

The Line and Shape Toolbar

Or from Symbol Libraries, show in floating windows above
the drawing.

[ 1§
Exd FLOW_EXT M= E2

Librariez
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Symbol Library Window

There are two ways to add shapes and lines to your
drawing:

Drag and Drop

This method requires only one mouse click and gives you a
shape or line with a standard size and shape. This is best
explained with an example.

To add a rectangle shape, first click on the rectangle button
on the toolbar without letting go of the mouse button.
While still holding down the mouse button, move the
cursor onto your drawing. (This is called dragging with the
mouse.) A rectangle shape follows the cursor. Once you let
go of the mouse button, a new rectangle is added to your
drawing.
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Dragging a rectangle from the toolbar

Drag and Drop

Double clicking on the shape button can set the size of the
shapes you drag from the toolbar.

Lines created by Drag and Drop are always the same size
and shape. (Lines are usually drawn using the Pencil
method instead, described below).

Symbols can also be dragged and dropped in the same way
by clicking on the buttons in a library window.

Pencil Drawing
The pencil method requires two clicks but gives you full
control over the size and shape of the object that you draw.

To add a rectangle shape using this method, first click on
the rectangle button in the toolbar, and then let go of the
mouse button. As the cursor is moved into the drawing
window it changes to the pencil cursor. Now if you click in
the drawing window and keep the mouse button pressed
and you move the mouse, a rectangle is drawn, as if the
mouse were a pencil. This method can be used for shapes,
lines and library symbols.

For shapes that can be stretched to any proportion, like
rectangles, perfectly square versions can be made using the
pencil draw method. To do this, simply hold down the Ctrl
key while drawing the shape. This trick with the Ctrl key
also applies when resizing a shape with the mouse.

Sticky Tool Selection

Normally, after you have drawn an object using the pencil
method, the selection (pointer) tool is selected
automatically. If you want to draw several copies of the
same kind of object, you can force the drawing tool that
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you are using to remain selected by holding the Shift key
down the first time you click on it. Holding the Shift key
down when you select any drawing tool, causes it to remain
selected until you click on another tool, or drag and drop a
shape.

Drawing Lines and Curves

Lines and curves are usually drawn using the pencil
method. There are four kinds of line: straight lines, arcs,
segmented lines and curved lines.

Straight Lines

Straight lines connect any two points. They may be drawn
at any angle, but will snap to perfectly horizontal or vertical
directions if drawn close to these directions.

Lines may have one of three different shapes shown on the
Change Line Shape menu.

Plain Line
/\/ Comtnunications Linl
’_|_1 Drigital Link
Line Types

A straight line is initially drawn as a plain line. You can
change its shape by selecting it and applying the Change
Line Shape command.

Arcs

Arcs connect any two points with the arc of a circle. Like
straight lines, arcs can be rotated and converted to other
line shapes using the Change Line Shape command. The
degree of curvature of an arc can be adjusted using the
special selection handle at its center.
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Adjusting the Curvature of an Arc

Segmented Lines

Segmented lines are designed to connect shapes. When
linked to a shape (see Connecting Lines and Shapes on
page 128) the end linked becomes perpendicular to the side
of the shape that it is linked to (i.e. it sticks out from the
side). If the other end is linked to another shape, it also
becomes perpendicular to the side of the shape that it is
attached to.

Moving the shapes around causes the segmented line to
change its shape to maintain the directions of its starting
and ending segments. Segmented lines can have from 1to 5
segments, depending on the arrangement of the shapes
linked.

You can change the shape of segmented lines using the
Change Line Shape menu. The Flip command (page 68)
can also be used to create additional variations.

(MLEM Text  Draw  Librarez  Window  Help

Style 3 nl_+
f | i} |An| |j_
LColor 4 A

]

Change Line Shape
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Change Line Shape

You can also change segmented lines into straight lines and
curves using this command.

Curved Lines

Curved lines are the same as segmented lines with rounded
corner. They too are designed primarily to link two shapes
together. They follow the same rules as segmented lines,
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always maintaining a direction that sticks straight out from
the side of the shape they are linked to.

When not linked, a curve is initially a simple “S”. The
Change Line Shape command can be used to change its
shape to a semi-circle, an “S” curve, or any other line
shape.

Automatic Connectors

An Automatic Connector is a special type of line that
changes shape as other objects are linked to it. The best
way to explain this is to consider an automatic connector
designed to create the classic horizontal organization chart,
as an example:

—D'wop Shape =
|
] 1

______

Adding a new shape to an automatic connector

As the figure shows, dropping a shape on an automatic
connector automatically adds the shape to the group of
shapes on the connector, with all necessary lines added
automatically.

Connectors are described in their own chapter, Formatting
with Automatic Connectors, on page 134.

Connectors are either perfectly horizontal or vertical. The
arrangement of the shapes attached to them can be changed
using the Change Connector Shape command on the
Lines menu. This replaces the Change Line Shape
command when a connector is selected. Connectors cannot
be changed into the other line types and vice-versa. The
Flip command (page 68) can also be used to create
additional variations.

58 e Drawing with SmartDraw

SmartDraw User's Guide



Text Draw Libranez:  'Window  Help

Style r nl_+
2 Flu A, -
oo 1w Al A

| | [ | 4
Change Connectar Shape H—+ |
Armowheads. . + j '—;: :l: j—
Show Length
Join to Make a Hew Shape... el kxal el el e

Change Connector Shape

Selecting Objects
Before any menu operations, such as color changes, can be
applied to an object, it must first be selected.

Selected objects are shown with Handles on the corners
and sides as shown below.

= P = &1

Selecte?Target Eéelected I":iﬁn-Targei:J

The most recently selected object is always shown with
solid (black) handles and is called the Target. Other
selected objects are shown with hollow handles. The target
object is called the target because other selected objects are
aligned or re-sized to match it when you use the Align and
Make Same Size commands.

Objects that are linked to other objects have round handles
at the connected points.

Objects are selected by clicking on them with the mouse
while the Arrow button on the toolbar is depressed. Shapes
filled with the transparent color must be clicked on their
border.

Selecting an object by clicking on it de-selects all other
selected objects unless you hold the Shift or Ctrl key down
while you click. With the shift or Ctrl key held down,
clicking on a selected object de-selects it.
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Selecting Multiple Objects

The easiest way to select more than one object is to first
click on the Multiple Selection tool on the toolbar. With
this tool selected, clicking on an object does not de-select
others. You can select more than one object by simply
clicking on them one at a time. Clicking in the background
of the drawing cancels the selection of the Multiple
Selection tool.

You can also select more than one object by dragging the
mouse with the Arrow button depressed. To drag the
mouse, hold the left mouse button down and move the
mouse. Then let the mouse button up.

Dragging the mouse this way across the drawing window
draws a temporary dotted rectangle. Any objects
completely enclosed by this rectangle are selected once the
mouse button is released. Holding the Shift key down while
dragging adds the enclosed objects to any existing
selection.

Sometimes, it’s hard to click on the object that you want
because other objects lie on top (or in front) of it. There are
two ways to overcome this:

You can select the objects on top and use the Send to the
Back command under the Arrange menu.

You can also drag around all the objects, selecting them all.
Shift clicking on the objects in the front now de-selects
them, leaving only the object you want still selected.

To select all the objects in a drawing use the Select All
command under the Edit menu.

Once selected, the colors, borders and other attributes of
objects can be changed using the menu commands.
Selected objects can also be cut, copied and duplicated.
Typing from the keyboard when a shape is selected adds
text to it. These actions are described in much greater detail
later.

Moving Objects

Using the Mouse
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You can move an object simply by clicking on it with the
mouse, and then moving the mouse, while keeping the
mouse button pressed down. An outline of the object
follows the mouse as you move it.

If you hold the shift key down while you use the mouse to
move an object, it moves only horizontally or vertically
(not diagonally).

Moving a Group of Objects

If more than one object is selected, clicking on one of them
moves all of the selected objects as a group. More than one
object may also be moved if the object clicked on is linked
to others. When a group of objects is moved, an outline of

the rectangle that encloses the group follows the mouse.

Using the Arrow Keys

You can use the arrow keys to move a selected object very
precisely. Typing an arrow key moves the object by one
screen pixel (1/100 of an inch at normal viewing
magnification) with each keystroke. The right and down
arrows move the object to the right and bottom. The left
and up arrows move it to the left and up. If more than one
object is selected, all are moved.

Aligning Objects

The Align command under the Arrange menu can be used
to align all selected objects with the selected target object.
This is described in detail in the Arranging Objects section
on page 125.

Spacing Objects Evenly

The Space Evenly command under the Arrange menu can
be used to arrange all selected objects so that they are
separated by equal distances. This is described in detail in
the Arranging Objects section on page 126.

Centering the Drawing on the Page

The Center Drawing on Page command under the
Arrange menu can be used to move all the objects in the
drawing so that they are centered in the minimum number
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of pages needed to print them. This is described in detail in
the Arranging Objects section on page 126.

Sizing Objects

Using the Mouse

To change the size and shape of an object you must first
select it, and then click on one of the selection handles (or
black squares) with the mouse. Moving the mouse, while
keeping the mouse button pressed down, moves the handle
and changes the size of the object.

Growing an Object

Only one object at a time can be resized this way.

Some shapes, like rectangles, can be sized to any
proportion. Others, like circles, can grow so as to maintain
their proportions.

Handles drawn in the middle of the sides of the rectangle
grow the object only in the direction perpendicular to that
side. Handles at the corners grow in all directions for non-
proportional shapes.

Proportional shapes (like circles) have no handles on their
sides, and their corner handles grow the shape only
proportionately.

For shapes that can be stretched to any proportion, like
rectangles, perfectly square versions can be made by
holding down the Ctrl Key while dragging with the mouse.

Holding down the shift Key forces them to grow in
proportion to their current shape.
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For shapes that can normally only be sized proportionately,
holding down the shift Key while dragging with the mouse
allows them to be sized to any proportion.

Sizing with the Arrow Keys

You can finely adjust the size of a selected object using the
arrow keys . Typing an arrow key, while holding down the
Shift Key, increases or decreases the size of the object by
one screen pixel (1/100 of an inch at normal viewing
magnification) with each keystroke. The right and down
arrows increase the size at the right and bottom. The left
and up arrows decrease the size at the right and bottom.

You can apply these changes to more than one object
simultaneously, by selecting more than one first.

Make Same Size

The Make Same Size command under the Arrange menu
can be used to make all selected objects the same size as
the selected target object. This is described in detail in the
Arranging Objects section on page 125.

Grouping

Objects may be combined into Groups. When grouped
they may be sized proportionately as a single object. This is
described in detail in the Creating Your Own Shapes
section on page 163.

The Shape Properties Dialog
The Shape Properties Dialog allows you to change the
sizing and other behaviors of a shape.
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Shape Properties

Grow:
:
' Proportionally Select the way the shape can
: he re-sized.
® Loiizantelly @il Proportional growth maintains Cancel
= Werically anly a gymhbal's original shape and
presvents distortion, Help

" Mo restrictions

This box applies anly to picture objects. Checking itwill allow you to attempt
to change the colors of borders and shapes in the picture, using the Shape

frEnL.
This may notwork far all images. Press Help for mare details.

[ Do not check spelling

Checking this box turns off spelling correction for any text contained inside the
shape.

Shape Properties Dialog
There are four choices of sizing behavior:

Proportional objects have only four grow handles (one at
each corner) and maintain their proportions when re-sized.
Imported images (and many library symbols) are initially
set to resize proportionally.

Horizontal Only objects have only two grow handles and
can be re-sized only in the horizontal direction.

Vertical Only objects have only two grow handles and can
be re-sized only in the vertical direction. This is good for
objects that represent vertical lines.

No restrictions allows objects to grow in all directions
without maintaining proportions. These objects have the
usual 8 grow handles.

The Change Colors box applies only to certain library
symbols and imported images and is described on page
179.

The Do not check spelling check box turns off (or on)
spelling correction for the text inside this particular shape.
This is useful if you want to keep spelling correction turned
on for your drawing in general, but want it off for a
particular shape that contains a proper name or some other
text that is flagged as misspelled by the spelling checker.
When you group objects, spelling correction is turned off
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for text inside the group. You can turn it back on again with
this setting.

The Position and Size Dialog

You can set the size and position of an object to an exact
value using the Position and Size Dialog. This allows you
enter dimensions and position for a single object in the
same coordinate system shown on the rulers (page 167).
You show the dialog by first selecting an object and then
using the Position and Size command under the Arrange
menu.

Position and Size

— Position Size

Left Bight |2.19 Wit [1.00 &l
Cancel

Top |5.UE Bottom |5.56 Height IU.EU 4|

Help

— Changing the Right and Bottom Positions changes...
% The Object's Size " The Ohject's Position

— Units
Allwalues are in Inches.

The Position and Size Dialog

You can specify the left, top, right, and bottom of the shape
in the units shown.

Changing the left and top values also changes the right and
bottom, shifting them to maintain the same width and
height.

The two radio buttons control whether changing the
object's bottom or right value changes the object’s size (by
leaving the left and top unchanged) or changes the object’s
position (by changing the left and top to maintain the
dimensions).

Lines have position dialogs that differ from shapes,
allowing you to enter the length of the line.
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Rotating Objects

o All shapes, text and straight lines can be Rotated by any
angle. You can do this manually by selecting the rotation
handle that these objects show when selected. The cursor
changes to the “rotation” shape shown in the margin when
positioned over a rotation handle.

A Rotation Handle

Clicking on the rotation handle and dragging with mouse
rotates the shape about its center.

Rotating a Shape

When the Snap to Grid feature is turned on, the angle of
rotation snaps to an increment of 15 degrees (15, 30, 45 and
So on.).

You can also rotate objects using the Rotate commands on
the Arrange menu The Rotate sub-menu provides
commands to rotate objects by 90 degrees in either
direction, and to return an object to the horizontal position.

The Set Angle command allows you to specify the exact
angle of rotation within one tenth of a degree, via the Set
Rotation Angle Dialog.

66 e Drawing with SmartDraw SmartDraw User's Guide



Set Rotation Angle Ed |

— Ratation Clackwize From Harzantal:

e
Degress: —

— Hint
Thiz dialag zets the angle of ratation. [t Help |

does not add ko it
Far example: ta return an object ta the
unrotated position set the angle to 0.00.

Set Rotation Angle Dialog

The rotation commands on the menu apply to all selected
objects. This allows you to rotate a group of objects by the
same angle. Furthermore, the angle shown in the Set
Rotation Angle dialog is the one associated with the last
object selected (the target object, described on page 59).

This feature allows you to align the rotation angle of a
group of objects to one particular object: Simply select the
objects that you wish to align, then, holding the Shift key
down, select the target object that you wish to align them
to. Now select the Set Angle command and press OK.

You can rotate straight lines, any shape, and most imported
images. Segmented lines, curves, bitmapped image objects,
and automatic connectors do not rotate. Also, objects linked
to others do not rotate. (Since they cannot maintain their
link if they do!) However, you can rotate a shape or line
before you link it. Objects that do not rotate do not show a
rotation handle.

When an object is rotated, the text associated with it rotates
too.
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Rotated Shapes with Text

If you want the text in a rotated object to remain horizontal,
you can change it into a new (rotated) shape, before you
add text. This is described in Creating Your Own Shapes on
page 162.

Flipping Objects
All objects, except bitmapped images, can be Flipped,
either horizontally or vertically.

Horizontal flipping changes an object as if it were reflected
in a mirror down its middle.

,:: ! Fli
Shape Q;)-Hummtaﬂ? =hape

Horizontal Flipping

Vertical flipping changes an object as if it were reflected in
a mirror across its middle.

Shape
Wirror" N Wﬁiﬂﬂﬂ? Shape

Vertical Flipping
Note that text is unaffected by flipping.

Flipping can be used to generate even more styles of
connectors and segmented lines than are available on the
Change Connector Shape and Change Line Shape
menus.

F]ip}

COC D COC D

Changing Connector Styles with the Flip Command
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Deleting Objects

You can delete objects from a drawing by simply selecting
them and then typing either the Del key, or the Backspace.
The Clear command under the Edit menu has exactly the
same effect.

Duplicating Objects

The Duplicate command, under the Edit menu, makes a
copy of the selected objects and adds them to the drawing,
offset by a small distance from the original objects.

e,

P, b1

0 T [
Duplicating Two Objects
The duplicated objects are automatically selected so that
they can be moved as a group by clicking on one of them.
If the newly duplicated objects are moved with respect to
their original copies, the new distance between them and
the original set is used as the offset for further duplications.
You can use this feature to create rows and columns of
evenly spaced lines or shapes very easily.

The illustration below shows the steps involved in making
a column of evenly spaced lines.
B H

=

E———1

Step 1 - Draw a line Step 2 - Duplicate it Step 3 - Adjust the offset Step 4 - Duplicate
again and again
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The SmartDraw Explorer

The SmartDraw Explorer Panel
The SmartDraw Explorer shows a list of libraries,
templates, and examples in a panel on the left of each
drawing. This panel is open and visible by default.
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L[ Auditing

¥ Banking Symbols

¥ Banking Use Case
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The SmartDraw Explorer Panel
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You can close the panel by clicking in the close box at its
top-right, or by dragging the divider that separates the panel
from the drawing area all the way to the left. This divider
can also be moved to adjust the width of the panel. It can
never be more than 50% of the document window.

You can re-open the panel by using the Show Explorer
command on the View menu, by pressing the Open
Library button on the toolbar, or by selecting the Open
Symbol Library command from the Libraries menu.

The Explorer Tree Control

The SmartDraw Explorer panel contains a Windows
Explorer-like tree control that shows all of the libraries,
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templates and examples installed on your system, organized
into a hierarchy of categories.

Each category appears as a folder icon. If you click on a
folder it opens up showing either more folders representing
sub-categories, or icons for libraries and templates.

Category (Collection)
E{:I {ibrarieé, Templates and Examples
=-#1 Business & Charting

--{:I Backgrounds
@3 Clip At & Symbaols

=-{31 Flowcharts

Library Icon
E-1 !'?raries Y
- Auditing

¥ Banking Symhbals

anking Use Cases
[ Catalyst

M| ﬂmplates and Examples
----- [ Empty

----- T Example- File Hierarchy

Template icon

Sub-category Folder

SmartDraw Explorer Tree Control
This organization lets you browse through each category
looking for the library or template that you want, like a
table of contents.

Browsing is made easier still by the Preview images of the
libraries and templates that pop up as your mouse hovers
over the library or template icons.

it emrsnssmanas

- {%¥ Auditing
-%¥ Banking Syrbaols

% Banking UDouble-dlick name to open.
- [¥ Catalyst i

@ aeroo| B | QB |5
¥ DIN 6600

B Entity Rel| [—* ‘(,» v v
@ Flowchart

Frare | LS

@ Process

Preview Images
Clicking on an open folder closes it again.

You can also open and close folders by clicking on the +
and — buttons next to the folder icons. Folders with + icons
contain other folders and clicking on the + opens them. An
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open folder containing other folders has a — next to it.
Clicking on this closes the folder.

Searching the Tree

At the very top of the SmartDraw Explorer panel is the
Search Bar. Typing a word into this bar and pressing the
Enter Key, or clicking on the Go button in the bar, searches
all of the libraries and templates in the tree for matches to
the word.

smartdrawexplorer |

@k Searchforasymbol
D) |audiing

The Search Bar

In addition to their titles, every SmartDraw library and
template contains keywords that describe its content. These
too are searched. If browsing the tree is like looking in the
table of contents of a book, then using the Search Bar is
like looking in the index.

Once the search has been completed, the folders that
contain matching libraries or templates are expanded and
shown in bold with the search icon next to them:

smartdrawexplorer |
#% Search for a symbol

) [auditing

77 SmanDraw Explarar -]

--C.] by Fanvatites
E--ME] Libraries. Templates and Exal
-4 Business & Charting
- -7 Block Diagrams
. &-#4(7 Flowcharts
. E-¢4(7 Libraries
- #4% Auditing
- [%¥ Banking Symbols
Results of a Search

If you search with no search string, or no matches are
found, all search icons and bolding are removed and the
tree is closed up to its default state.

You can enter more than one word into the Search Bar,
separated by spaces or commas. SmartDraw finds matches
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for libraries that contain any of the words, but not
necessarily all of the words. (OR not AND).

The search is not case-sensitive. (It doesn’t matter if the
words are in capital letters or not). Partial matches are
found as long as the word begins with the search word. For
example, if you searched for Form, matches would be
found for Forms and Formula but not Perform.

The first time you search, SmartDraw has to build the word
index. This can take several minutes. However, the next
time you search, finding the symbol you are looking for is
almost instantaneous.

Each time you cause the tree to be rebuilt, either by
command or because you installed new collections, the
word index also has to be rebuilt the next time you search.

Opening Libraries and Templates
Once you find the desired library in the Explorer tree , you
can open and use it by simply dragging its icon to the
drawing area. You can also open it by double-clicking on
the icon, or selecting it and typing the enter key.

You can open a template in the same way. When you open
a template, it normally opens in a new document window.

Favorites

At the very top of the tree is a folder called Favorites. You
can drag library and template icons from the Libraries,
Templates and Examples section of the tree into
Favorites. You can also add an open library to your
favorites using the Add To Favorites menu item under the
Libraries menu that shows in the library window itself.

Your Favorites folder contains short cuts to any library or
template you add to it. It provides quick access to the
libraries and templates you use most often.

You can create your own sub-categories inside Favorites
by clicking on the folders with your right mouse button.
(See page 74). You can also drag icons (and sub-folders)
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from one Favorite sub-folder to another. You can organize
this section of the tree however you wish.

Because your Favorites folder contains only a short cut to
the library or template itself, you can clear or delete
favorite short cuts without deleting the libraries themselves.

Your Favorites folder is stored in your personal
preferences and is not shared with any other user.

Right Mouse Button Menus

Clicking on the icons in the SmartDraw Explorer with the
right mouse button displays a menu that depends on the
type of icon clicked-on.

Library and Template Icons

Right clicking on a library or template icon lets you open it,
add it to your favorites, or display a Preview that stays up
until you click somewhere else.

Favorite Library and Template Icons

Right-clicking on a library or template icon in your
Favorites folder lets you open it, remove it from your
favorites, or display a Preview that stays up until you click
somewhere else.

The Favorites Folder
Right-clicking on the Favorites folder itself lets you clear
all favorites.

Favorites Sub-Folders

Right-clicking on a Favorites sub-folder lets you create
your own sub-folder within. If the sub-folder is one you
created, you can also delete it and rename it.

SmartDraw Explorer

Right-clicking on the SmartDraw Explorer folder at the
top of the tree lets you refresh the tree or clear the favorites.
Refreshing the tree is not normally something you want to
do.
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Refreshing the Tree

Closing the SmartDraw Explorer folder in the tree control
and then re-opening, causes the tree structure to be rebuilt.
There is rarely a reason to do this, since it will cause your
next search to rebuild the word index.

Sometimes installing new libraries or templates will cause
this to happen automatically.

If SmartDraw sometimes crashes when the tree is rebuilt,
your Windows system has a mismatched set of system files
that manage the tree control. You can normally correct this
by installing Microsoft Internet Explorer 5.0 (or above).
See Troubleshooting on page 231.

Previews and on-demand

installation

SmartDraw’s preview files provide all the benefits of
having SmartDraw’s complete catalog of symbols
available, while using about 1% of the disk space required
by the full libraries and templates.

A preview is a copy of a library or template file that
contains only the ToolTip preview shown when you browse
the tree and the keywords used when you search. Previews
let you browse and search the catalog as if it were
completely installed on your system. Previews are shown in
the tree with white instead of yellow icons.

When you attempt to open a library or template preview
file, you are given the opportunity to install the full copy,
using the Install Dialog.

Install Library?

The library wou wish to open is only a preview. -
Y'ou can replace this, and the others in the same falder, with a

complete wersion by downloading from SmantDraw's web site or by

installing fram the SmanDraw CD ([ if wou hawve one). Caneel

ek ]

Choose Installation Method: Help

* Download the |atestversion (Size=206 kB
Estimated download tirme using  [56K Modem = <1 min.

" Install from your SmartDraw CO

The Install Dialog
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You can install either from your SmartDraw CD, or, if you
are connected to the Internet, by downloading directly from
smartdraw.com. Installing from smartdraw.com has the
advantage that you are always getting the most recent
version of the library or template.

If the library or template you are about to install requires a
Collection License that you don’t have, the Install Dialog
warns you. You can use unlicensed symbols and then later
purchase a license without having to repeat your work
(images already placed in documents become licensed
when you install a Collection license).. See page 77 for a
complete description of Collection Licensing.

Downloading Your Installation

If you choose to install by downloading, selecting your
connection speed gives you an estimate of the time required
to complete the download. Pressing the OK button presents
the Download Dialog.

Before you begin your download....

1. Make sure wou are connected to the Intemet
If wou are an AOL user. connectto AOL and minimize the AOL window:

2. Press the Download button below to begin the download

Youwill see a "progress" window appear if the download starts. If this does not
happen oryou get an eror message, press the Troubleshooting" button below

3. Press the Close Dlalog button and continue drawing while vou wait.
By closing this dialog you can continue to work in SmantDraw while the

download takes place. Once it is complete you will be ahle to use the updated Close Dialog
libraries ortemplates.

4. lfwou experience problems...

If wou do not see the download process begin, or an error is reported, press

the Troubleshooting button for possible explanations and corrections Troubleshooting

The Download Dialog

Press the Start Download button to begin the download
and wait for a window to appear that shows the progress of
the download.
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Installing | X]

Downloading file:
CATEMPYI_business & charing_flowchans. exe

Progress Dialog

Once downloading has begun, you can close the Download
Dialog and continue with your work. When the download
is successfully completed the library or template you
wanted to install will open automatically.

You must have access to ftp to install from smartdraw.com.
Some corporate users have this service blocked. Talk to
your network administrator if you have difficulties.

Installing from the CD

If you choose to install from the CD, the CD Dialog
appears. Place the SmartDraw CD into your CD Drive and
select its path using the Browse button.

Install from the SmartDraw CD | %]

Flease insertyour Smanlraw CO in the drive shown below, or
select another location.

Cancel |

Select COD Locatian

Ifthe drive shown is notvour CO Drive, use the Browse button to select the
correct location.

Install fram drise: |D:\ Browse... |

The CD Dialog

Pressing the Install button begins the install process. The
library or template that you want to install is opened
automatically once the install has successfully completed.

SmartDraw Collection Licenses

All of the SmartDraw libraries and templates are organized
into nine Collections covering specific subject areas such as
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Business & Charting, Network Design and others. These
appear as top-level folders under Libraries Templates and
Examples in the SmartDraw Explorer tree.

All of the collections are freely available for download
from smartdraw.com. They are also included on the
SmartDraw CD. However to use them without restriction
you must install a license for each collection. SmartDraw
Professional Plus includes all nine licenses automatically.

Using Unlicensed Symbols

When you use a symbol or template that requires a license
without that license installed on your system, the symbols
are displayed superimposed with an unlicensed stamp.
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Unlicensed Symbol

When you install a valid license for the collection that the
symbol belongs to, the unlicensed stamps go away. This
happens even in drawings that have been drawn with
unlicensed symbols, so you can use symbols in their
unlicensed state without having to recreate any of your
work later when you obtain a license.

The Baseline Set

Some of the libraries and templates in a collection require
no license. SmartDraw includes selections from all of the
collections in a baseline set of libraries and templates that
require no additional licenses.

Every SmartDraw user has full, unrestricted use of these
symbols and templates.
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Changing the Appearance of

a Drawing

Changing the Appearance of
Shapes

The Shapes menu can be used to change the color and
border style of existing shape objects.

The first step is to select the shape or shapes you wish to
change, by clicking on them. (See Selecting Objects on
page 59.) Selecting a color from the Fill Color menu will
change the fill color of any selected shape. This color will
also be the fill color of any new shape added to the drawing
afterward. Lines, Image objects and symbols that are not
re-colorable (See Changing the Settings for a Symbol on
page 146) are not affected by fill color.
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Tranzparent E_'{:
The Color Menu
The fill color can be transparent, which means that the
background of the drawing shows through the shape.

You can also pick from any of the 16 million colors
supported by Windows using the More Colors selection.

Shapes have a border around their edge. This can be dotted,
dashed, or solid with several weights. Heavy borders
always grow towards the center of the shape.
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Symbols that can be re-colored respond to border style
changes by changing their appearance. Those that do not,
show a border around the rectangle that encloses the
drawing.

Shapes may also have no border (None). These shapes
must have a different fill color than the background or they
will not be visible.

The Border Color and Border Style menus change the
appearance of selected shape borders. The values selected
also become the default settings for the border of any new
shape added to the drawing.

M ane
v Hairline

Border Style Menu

The Shading menu is used to fill a shape with a hatched
pattern. The menu shows five hatched patterns and a plain

(no hatching) choice.
W

il
B

The Shading Menu

The hatched patterns use the border color for the hatching
on a background determined by the fill color (including
transparent fills). If a hatched pattern is selected and the
border and background colors are the same, the border
color is changed to a contrasting color.
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Changing the Shape

The shape of an existing shape object can be changed to
any of the other 24 standard SmartDraw shapes, using the
Shape command under the Shapes menu. This displays the
Change Shape menu.

Change Shape Menu

Any selected shapes are converted to the shape chosen
from this menu. The command has no effect on library
symbols or images.

Adjusting Shape Outlines

The outline of many of the standard toolbar shapes can be
adjusted (for example, the degree of roundness of rounded
rectangles or the angle between the vertical and horizontal
sides of a parallelogram). The defaults for these quantities
can be set when editing the toolbar. (See Changing the
Toolbar on page 224.)

You can adjust the outlines of objects already in the
drawing by clicking on their Adjustment Handles.

Adjustment Handle

[
Adjusting Shapes
To adjust the outline of an adjustable shape, click and drag

on the open diamond-shaped handle that appears when an
adjustable shape is selected. You can see the effect of the
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changes you are making in real time as a temporary dotted
image shows the new outline of the shape. Release the
mouse and the shape changes its outline to match the dotted
image.

Redesigning Shape Outlines

Shapes can also be completely decomposed into their
component lines and curves using the Edit Shape Outline
command. . You can use this feature to redesign the outline
of a shape, and then join the outline back into a new shape
using the Join to Make a New Shape command under the
Line menu. This is described in more detail on page 162.

Changing the Appearance of

Lines

The Lines menu can be used to change the color and
thickness of selected straight lines, arcs, segmented lines,
curved lines and connectors.

The Line Style command changes the style. This can be
dotted, dashed, or solid with several weights.

The Line Color command changes the color of any
selected lines.

Arrowheads

You may add arrowheads to either or both ends of any line.
There are 35 different built-in arrowhead styles, and you
can also create your own. The style, size and placement on
the line may be set using the Arrowhead Dialog. This is
presented via the Arrowheads... command under the Lines
menu.
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The Arrowheads Dialog

The buttons lets you pick an arrowhead style for each end
of the line:

Left (Top)

Clicking on one of the 36 style buttons changes the type of
arrowhead that will appear on the left end (or top end if
vertical) of the lines currently selected. A preview of the
effect of this selection on a horizontal line is shown in the
preview window. The “None” selection results in no
arrowhead at the left end.

Right (Bottom)
Clicking on these buttons changes the style of the right end
(or bottom end if vertical) of the lines currently selected.

Displacement

This property controls whether the end of a line with an
arrowhead is drawn to its full length or a little short. This is
useful when lines are linked to shapes. If the line is
displaced, it does not appear to touch the shape but still
remains linked to it. This property can be controlled
independently for each end of a line, and does not apply to
ends with no arrowhead.
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Size
Clicking on one of these three buttons controls the size of
the arrows and applies to both ends of the line.

Arrowheads in the Center of Lines
Three of the arrowhead styles place an arrowhead at the
center of the line instead of at the end.

>

T
Y

Centered Arrowheads

AR A

Lines with different settings

If the Arrowhead dialog shows no setting for a property,
then the lines currently selected have different values for
this property. For example, if two lines have different right
arrows, no right-arrow buttons will appear to be pushed in
when the dialog is displayed. If you leave the style buttons
un-pushed, but you push one of the size buttons, then, when
you press the OK button, both arrowheads will change size
but they will retain their different right arrow styles.

Once assigned, an arrowhead remains fixed on the end to
which it was assigned, despite any later changes in the
line’s direction.

Creating Your Own Arrowheads

In addition to the 35 built-in arrowhead styles, you can
create your own. There are four steps involved:

1. Create an image for your arrowhead

Begin by drawing the symbol you want to use as an
arrowhead, either with SmartDraw, or with some other
drawing program. You can draw the symbol at a
comfortable size. It need not be as small as the eventual
arrowhead. SmartDraw will eventually scale it to the right
size.
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The arrowhead design should be for a right-facing
horizontal arrow. SmartDraw will handle transforming the
image for other directions. The arrowhead will eventually
be drawn with dimensions that are 1.75x longer than wide.
For best results, draw your symbol with that ratio of length
to width.

New Arrowhead Image

2. Copy it to the clipboard
Use the Copy command to transfer your image to the
clipboard (page 178).

3. Open the arrowhead dialog
Select a line and use the Arrowheads command under the
Lines menu to open the arrowhead dialog.

4. Double-click on a right-facing button.

You may replace any of the standard arrowheads with your
custom design. Select the arrowhead you want to replace
and double-click on its right facing button. (When you
replace an arrowhead on the right-facing button you
automatically replace it for the left-facing button also.) You
are presented with the Customize Arrowhead Dialog.

Cusztomize Anmowhead [ x|
— Select Amowhead
o —00 Carcel
' Original Setting € Curent Ficture, 090 Help |
— Drawing Optiohs
[ Diraw with the line thickness and colar ™ Fill shapes with the line calar

— Hint
r'ou may replace the curment getting with a new picture pagted from the clipboard,
The new picture should show the arrowhead in the right-facing horizontal position.
SmartDiraw will rotate the image accordingly for other directionz. For best results,
the picture should 1.75 times longer than it iz wide,

To transfer a picture to the clipboard, just copy it from SmmartDraw or any ather
windows, program before pou open this dialog.

Customize Arrowhead Dialog
You should see your design attached to the end of a line

above the Clipboard Picture radio button. Selecting this
radio button replaces the built-in arrowhead with your
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image. You can also use this dialog to return to the standard
arrowheads at any time.

There are two other choices you can make with this dialog:
To draw the outline of the custom arrowhead with the same
thickness and color as the line it is attached to, and to fill
any shapes in the design with the same color as the line.

Both bozes unchecled Lo
Dy with the line thiclhess and color
i

Fill shapes with line color
Effect of Custom Arrowhead Dialog checkboxes

The effects of these choices are shown above.

Once you have assigned a custom arrowhead to a button in
the arrowhead dialog, you may assign it to any line in the
normal way. The arrowhead is stored in your SmartDraw
preferences (smartd4.opt) in your Windows directory. You
can revert all of your arrowhead settings back to their
default using the Revert Arrows to Default button in the
arrowhead dialog

Changing Line Shape

Lines and Automatic Connectors can have many different
shapes, and you can convert one line shape into another
using the Change Line Shape and Change Connector
Shape commands. Note than you cannot change a line into
an Automatic Connector, and vice-versa. These commands
are described in the section beginning with Straight Lines
on page 56.

Changing the Background Color
The background of the drawing itself may be colored. You
change the background color using the Background Color
command under the View menu. One of the selections is
transparent. Drawings with this colored background differ
from those with white backgrounds only in the way their
images are exported. Drawings with transparent
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backgrounds export transparent images that acquire the
background color of the document that displays them.
Drawings with white backgrounds export images that have
opaque white backgrounds, no matter where they are
displayed.

The background color is one of the settings specified in the
Color and Shadow style.

Colors and Shadows

The Colors and Shadows command, under the Edit menu,
allows you to apply a design Style to your drawing. A
style is a color scheme, specifying the color of the drawing
background, shapes, borders, lines, text and shadows, and a
shadow type. Using the command presents the Colors and
Shadow Dialog.

Colorz and Shadows
— Select a stule:
B (]4
Black & White Sample
B & Dirop Shadow
(B & W Cont Shadow Cancel |
B &' Offzet Shadow
30 Raised Text Sarmple Help |
30 Sunken
Frirnary ;I .
Define. .. |
— Shadowsz LColors
[~ Apply to lines v Apply to lines
[ Apply to text v Apply bo fills
— Hint
Selecting a style applies the colors and shadows shown to all the
zhapes and lines in your picture, To change colorz of individual
shapes and lines uze the commandsz in the menus.

The Colors and Shadows Dialog

SmartDraw provides many ready-made styles. These are
listed in the Select a style list box. A preview of the style's
appearance is shown in the Sample window to the right of
it. Changing the style selection changes the preview. You
can browse through the available styles using the up and
down arrow keys to change the selection.
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Once you have selected the style you want, pressing the
OK button applies the colors and shadow styles to your
drawing. This is a very quick and easy way to change all
the colors in a drawing to a consistent style in one
operation. You can undo any change you make, or you can
apply another style to try any number of different "looks".

If you select a shadowed style, shadows are applied to your
shapes. Some styles also apply the same kind of shadow to
lines and to text. The 3D styles give the raised and sunken
looks common in Windows dialogs.

You can control whether a shadowed style applies the
shadows to lines and text by checking the boxes in the
shadow section of the dialog:

Apply To Lines

Checking this box applies the selected shadow style to lines
as well as shapes. This is only visible if a shadow style is
selected, and is forced to be on for the raised and sunken
shadow styles.

Apply to Text

Checking this box applies the shadow style to text as well
as shapes. This is only visible if a shadow style is selected.
Text does not look good shadowed unless it has a point size
of 18 or greater.

Reverse Text Shadow

This option is only available if the raised or sunken 3D
shadow styles are chosen. Checking this box applies the
reverse text shadow: raised if the shape shadow is sunken,
sunken if the shape shadow is raised. This can give an
interesting effect.

Controlling Color Changes

You can also control whether color changes are applied by
checking the boxes in the Colors section of the dialog. If
the Lines box is checked, changes are applied to both
borders and lines. This is forced to be on for 3D shadowed
styles. If the Fills box is checked, then color changes are
applied to both text and fill colors.
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Overriding Shadows
SmartDraw allows you to override the shadow styles for
individual shapes, lines and text blocks.

Shape and Line Shadow

You can use the Hide Shadow command, under the
Arrange menu, to turn off any shadows for shapes or lines
that are currently selected. If any of the shapes or lines
selected already have hidden shadows, the menu item
changes to Show Shadow, and selecting it turns the
shadows back on for these objects.

Show Shadow has no effect on selected lines if the current
style does not normally apply shadows to lines.

Usually it is not a good idea to remove shadows when
using the three dimensional sunken or raised styles, since
borders and lines are the same color as the background and
will look as if they have disappeared if their shadows are
removed.

Text Shadow

The Shadow command, under the Text menu, has an effect
on text shadows similar to the effect Hide and Show
Shadow have on the shadows of lines and shapes. Selecting
this command toggles text shadows on and off for selected
objects. Its status is shown by a check mark. This command
has no effect if the current style does not specify text
shadows. Again, it is not a good idea to remove the
shadows of sunken or raised text.

Defining Your Own Styles

Pressing the Define button in the Colors and Shadows
dialog allows you to add your own styles, or to modify the
standard ones, by presenting the Define Colors and
Shadow Styles Dialog.
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Hilite |_

Define Colors and Shadow Styles EE

— Select a ztyle to edit:

Black & W hite

B & Drop Shadow
B & Cont. Shadow
B W' Offzet Shadow
3D Raised — Text Sample Help

3D Sunken

Frimary ;I

X

—Sample———————————————— o

Cancel

e

— Set the stule properties: b adon
Cont. Shadow ~Shyle Angle Add
— Colors
Change
Borders .. Lines I (i ID ] (il |
Fill |_. Text —_|= DlD Renarme |
Shadow . ni  Bkgnd 1 [~ Applytalines | Delste |
Hilite: |_ [ Apply to text

The Define Colors and Shadow Styles Dialog

Selecting a Style to Edit

Selecting an item in the scrolling list selects the style to be
edited. The style's name is copied into the Name field, and
the Change button becomes active. Changing the style
selected in the list cancels any changes made to the
previously selected style.

The Sample window shows a preview of the current style
as the selection in the list is changed, and as the settings for
the selected style are changed.

Changing Style Settings

The style settings are controlled by the color and shadow
controls. Seven color panels are displayed showing the
current color scheme. Pressing on any color panel with the
mouse displays the color menu. The menu changes the
color selection.

The selection on the color menu shown with a dotted
border represents the Transparent color.

The Border color sets the color of shape borders. Line
color sets the color of lines, segmented lines and curved
lines. Fill Color sets the color of the inside of shapes. This
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can be transparent. Text color sets the color of text.
Shadow color sets the color of any shadows. Highlight
color is only used by the raised and sunken three-
dimensional shadow styles.

Background color sets the color of the drawing
background. This, too, can be transparent.

There are six shadow styles to choose from. These are
shown in the array of shadow buttons, with the top left
button representing no shadow. If a shadow style in the
right column is selected the angle of the shadow can also be
controlled using the controls labeled Angle.

The four angle buttons show the current angle for the
shadow. Pressing one changes the selection to the angle
shown on its face. These controls are only visible if one of
the shadow styles in the right column of the shadow control
is selected.

Shadows can be applied optionally to lines and text. Check
boxes control these selections.

Adding a Style

You can add a new style by pressing the Add button. This
button becomes active when you change the Name field so
that it no longer matches the style selected in the list, and
the settings for colors and shadow have been changed.
Pressing it adds the current color and shadow settings as a
new style with the name you choose.

Changing a Style

You can change the currently selected style by pressing the
Change button. This button is active when the name in the
Name field matches the style selected in the list and the
settings for colors and shadow have been changed. Pressing
it changes the selected style to the current color and shadow
settings.

Renaming a Style

The Rename button becomes active when the name of the
selected style has been changed, but the parameters have
not. Pressing it renames the current style.
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Deleting a Style

The Delete button is active when the name in the Name
field matches the style selected in the list. Pressing it
removes the selected style from the list.

Overriding Styles
All new shapes and lines added to your drawing adopt the
color scheme and shadow style of the current style.

You can change the colors of any object, after it has been
created, using commands on the Shapes and Lines menus.
This changes the color scheme of the current style, and any
new objects added adopt the new scheme. Existing objects
that are not selected when a color is changed are
unaffected.

You cannot change the shadow style of individual objects.
Every object follows the shadow scheme of the current
style. To change the appearance of shadows, you must
select another style, or modify the current style's shadow
scheme.
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Adding Text

There are two ways to add text to your drawing: inside a
shape or as a background text object.

Entering Text in Shapes

You can enter text inside the 24 standard SmartDraw
shapes displayed on the toolbar, and inside most library
symbols.

A shape can be opened for text entry by simply selecting it
and starting to type. Shapes can also be opened for text
entry by double clicking on them or by pressing the text
button on the toolbar and clicking once on the shape.

When a shape (or background text object) is opened for text
entry, the standard Windows insertion point appears. This
is a flashing vertical line. All of the normal Windows text
editing conventions apply: Dragging with the mouse selects
text (shown as inverted). Selected text can be cut, deleted
or copied. The font, size, style and color of selected text
can be changed using commands on the Text menu.

Automatic Text Resizing

As you add text to a shape it word-wraps like a word
processor until the shape is full. Then, as you enter more
text, the size of the text shrinks automatically to allow more
to fit inside the shape. Finally, when the text has shrunk to
a minimum size, the shape grows to accommodate more
text. This is shown below.

Blary had a Little lanh. Its

Iary had a little Mary had a little fleece was white as stov, and
latnt lamb. Its fleece was everywhere that Mary went

that lanh was sure to zo.

The text shrinks, and then the box grows, as you add more text.

The way a shape grows to accommodate more text is
determined by both the alignment of the text in the shape,
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and the sizing rules chosen using the Text Entry
Properties Dialog.

Text Entry Properties

The Text Entry Properties Dialog is displayed using the
command of the same name under the Shapes menu.
Changes made with this dialog apply to any selected shape
(including a shape that contains a table).

Text Entry Properties

—Shapes change size when you add textl ok
This dialog controls the way shapes change size as you add and remove
text The choices vou make apply only to the shapes that are currently Cancel
selected. Press help for more information.

il

Help

—oelect a sizing rule:

& Change harizontally and vertically

Shapes change size in both directions, maintaining their shape.

" Change horizontally

Shapes change size horizontally as you add text, and vertically only if you
type a cartiage return <Enters.

© Change vertically

Shapes change size verically as you add text.

—Allow text to shrink
W Allow the size of text to shrink to IE points,

hefore forcing the shape to increase in size.

— Text Margins
Set the gap between the text and the inside edge of the shape to I:2
screen pixels (1,100,

Allow Text Editing of a Shape with &:
’76' Doukle-click € Singla Click " Do not allow text editing ‘

Typing the Enter key...
’76‘ Ingerts & new line. " Tahs to the next shape ar cell (Crl-Enter inserts a line) ‘

Text Entry Properties Dialog
This dialog allows to you to set:

e The way shapes grow as you add text

e The gap between the edge of the shape and the text it
contains

e How to begin text entry by clicking with the mouse.

Text Sizing Rules
There are three different ways shapes can grow as you add
text.

Horizontally and Vertically
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This is the default for most shapes. The shape grows so as
to maintain its proportions.

More Text
rfl.ﬂ:;f —= | More Text
More Text

Horizontal and Vertical Text Sizing

Horizontally

This is the default for background text objects and the text
that appears below or above image objects and symbols.
New text is added on the current line. New lines occur only
when the Enter Key is typed.

More Text —J | More Text More Text More Text

Horizontal Text Sizing

Vertically

Text "wraps" within the width of the shape, like a word
processor does when the text reaches edge of the page. The
shape grows vertically as new lines are added.

More
Yore | | Tex

More
Text
More
Text

Vertical Text Sizing

Effect of Text Alignment

As a shape grows according to these rules, it maintains a
fixed point according to its text alignment. If text inside a
shape is centered, the center of the shape remains fixed and
the shape grows outward from the center. A shape with
left-aligned text remains fixed at its left edge and grows on
the right. Shapes with top-justified text grow downward,
and so on.
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Allowing Text to Shrink

You can force the text inside a shape to attempt to shrink
before it causes the shape to grow by checking the Allow
Text to Shrink checkbox. You can also specify the
minimum size that the text will shrink to before it forces
the shape to grow.

Text Margins

The gap between the edge of the text inside a shape and the
inside of the shape border is set using the Text Margins
control. This setting is in 1/100 of an inch and defaults to 2.
Reducing this value will allow more text to fit inside a
shape.

Text Entry and Mouse Clicks

The three Allow Text Editing with a... choices allow you
to set whether a single-click or a double-click on a shape
opens it for text editing, or whether it can be opened for
text editing at all!

Normal shapes require a double-click for text editing. (A
single click is used to move and select them.) Shapes that
contain tables, on the other hand (see page 106), normally
require only a single click to begin editing.

Sometimes it is useful to require a single click for editing
normal shapes. A good example of this is using SmartDraw
to fill-in a form. Equally, if you have created a multiple-
text-entry-area flow-charting symbol, you will probably
want it to require a double-click for text editing like normal
shapes.

The Do not allow text editing choice is also useful for
forms. It prevents the labels and prompts in the form from
being changed while filling-in the form.

Text Entry and the Enter Key

Normally, typing the Enter Key inserts a new line into the
text you are editing. Selecting the Tab to the next shape...
option causes an Enter Key to behave like the Tab Key and
move you to the next shape or cell within a table (see page
176). shift- Enter moves back, just like Shift-Tab. This
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behavior is very useful when using SmartDraw to design
and fill-out forms.

When the Enter Key is set to behave like the Tab Key,
holding the Ctrl Key down while you type the Enter Key
adds a new line in the normal way.

Defaults

All of the settings in the Text Entry Properties dialog
become the defaults for newly created objects once applied
to a selected object, with the important exception of the
mouse-clicks setting.

Entering Background Text

If the text button on the toolbar is pressed, then clicking in
the background of the drawing starts a text entry session.
Any text entered forms a new object called a Background
Text Object. This is a rectangle shape that initially has no
border, and has a transparent fill.

You can select background text objects and open them for
further text entry like any other shape. You may assign
them a border and colors and rotate them, like any other
shape. However, they do have some properties that differ
from a normal shape.

Text objects align to the Snaps according the baseline of
the first line of text, not their center or top-left corner like
other shapes. Also, they are removed from the drawing if
all their text contents are deleted, so that your drawing does
not become cluttered with invisible empty shapes.

Attaching Text to Lines

In addition to adding text to shapes, you can also label lines
with text. To do this, simply select a line and begin typing.
A background text object will be created and attached to
the line, normally in the center.

This text object will remain attached to line when you
move it. It can change its orientation to match that of the
line, or it can remain horizontal. You control this using the
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Align Shapes and Text on the Line command settings,
found on the Lines Menu. There are two choices: Along
the Direction of the Line, and Horizontally.

Text attached to a line

The text is positioned on the line according to the current
text alignment setting for the line (not the text object
attached to it). You can change this by selecting the line
and using the Alignment command on the Text menu.

When the text is added on top of the line, the text is
automatically given an opaque background that hides the
line underneath. When text is added below or above the
line, the text is given a transparent background so that the
line shows through.

You can show the line through the text (or vice versa) by
selecting the text object itself and changing its fill color to
transparent, using the Shape menu.

The text entry position for an imported image or a library
symbol can be set so that text goes above or below it and
not inside. These shapes behave similarly to lines with
respect to entering text. Selecting the shape and starting to
type creates a background text object that remains linked to
the shape.

Dimensioning: Showing Line
Length

You can set lines to show their length in the same units as
currently displayed on the rulers (see page 167) using the
Show Length command under the Lines menu. This causes
any lines that are selected to display their current length as
an attached text object, or Length Label.
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show

-~ Length™ -y

0"
Show Length Command

The length label changes its value as the length of the line
is adjusted. Changing the ruler scale, or its units, using the
Define Rulers and Grid dialog also changes the value of
the line length label.

A length label is removed from a line by clicking on the
label itself and deleting it.

If you want to use your own units or descriptions, you can
attach your own text to any length label simply by typing it
in. Text that is not part of the length value is preserved as
the line changes length:

Width: 1.9 Cubits
Grlcuw
Width: 2.6 Cubits
User-defined Text in a Length Label
Length labels are used to create automatic dimension lines.

There are arrowhead styles that can be placed at each end
of line to complete the appearance. Segmented and curved
lines can also show their length. For segmented lines, the
length is the distance between the ends in the direction of

the text label:

? fm'x\f?\.l

=
L(
1. n
p——

Length Labels

Changing Fonts, Size and Style
You can change the font, size and style of text using the
Font command under the Text menu. This presents the

standard Font Dialog.
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Fant style:

IH egular

Ties New Fonan— PSW Fegus B

T %45 Round Italic

T Yilage Square Bold
“westminzter Bold Italic

% “wide Latin £y
“windsor

T windsor Condensed ;I LI

—Sample

| A aBhYyZz

Script:
IWestem ;I

This iz a TrueTppe fant. This same font will be used on both
wour screen and vour printer.

The Font Dialog

There are three controls in this dialog, along with a Sample
window that shows the selected typeface.

Font

This shows a list of all True Type fonts in the system. If
none is highlighted, the range of text or shapes selected has
more than one font. Leaving this list un-selected will result
in no change to the font.

Size

This shows a list of sizes for the selected font. If the size
you want is not listed you may enter it in the size field. If
no size is highlighted, the range of text or shapes selected
has more than one size. Leaving this list un-highlighted will
result in no change to the size.

Style

This shows a list of styles (or weights) for the selected font.
If no style is highlighted, the range of text or shapes
selected has more than one style. Leaving this list un-
highlighted will result in no change to the style.

Applying the Change

Selecting a new font from the Font Dialog changes the
typeface for any of the characters that are currently selected
in your drawing. Selected text is shown in reverse color as
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in other Windows programs. If no characters are selected,
the next character you type will be in the new typeface.

When one or more shapes that contains text, rather than the
text itself, are selected, applying a change using the Font
Dialog changes all the text inside the selected shapes. You
can change the typeface of all the text in a drawing by
using the Select All command (page 60), followed by the
Font command.

The typeface applied using the Font Dialog becomes the
new starting typeface for text entered into empty shapes, or
as background text.

Changing Text Using the Toolbar
You can also change the size and style of a shape that
contains text, or text that is being edited, using toolbar
buttons.

Pressing the buttons for bold, italic, etc. toggles the text
style. For example, pressing the Bold button when it is not
depressed turns bold on. Pressing it again, when it is
already depressed, turns bold off. If the B on the button is
gray, then the objects or text currently selected is a mixture
of bold and plain.

The following keyboard short cuts can also be used to
change styles:

Bold Ctrl+B

Italic Ctrl+

Underline Ctrl+U

Superscript  Ctrl+ +

Subscript Ctrl+ -

Superscript and Subscript behave in a similar way to the
other styles (bold, italic and underline), except that they can
only be applied to selected text and not to selected objects.

The size of text can be increased or decreased using the
text-sizing buttons. The "+" button increases the text size,
and the "-" decreases it.
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Positioning Text Inside Shapes
Text entered inside a shape does not always fill it
completely. You can control the position of the text inside
the shape using the Alignment command under the Text
menu.

Text can be aligned in shapes in all possible combinations
of four horizontal positions (left, right, center or flushed)
and three vertical positions (top, bottom or center). The
resulting twelve alignment styles are shown graphically on
the Alignment menu under the Text menu.

The Text Alignment Menu

The Alignment command can be used when a shape that
contains text is selected, or when a shape is open for text
entry. Alignment affects both the way text is displayed
within the shape, and the way the shape grows when text is
added. (See Text Entry Properties).

When text is open for editing, different alignments may be
applied to individual paragraphs within the same shape.

Flush alignment is similar to left alignment except that
wrapped lines have smooth right edge as well as left edge.
Left-aligned text has a ragged right edge. This paragraph is
flush justified. All of the others are left justified.

Changing the alignment of background text often has little
noticeable effect because the text fits inside its shape
exactly. Changing whether it aligns right or left has no
visible effect if the text is already touching both sides of its
shape. The direction that the background text object will
grow as text is added is affected however.

Positioning Text Along Lines
The text alignment command also changes the position of
text associated with a line:
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Left/Top Center/Top Right/Top

‘Left/Center: Center/Center Right/Center:

Left/Bottom Center/Bottom Right/Bottom

Text Alignment and Lines

Deleting Text

If you delete text from a shape, or make the text a size
smaller, so it occupies less space, the shape may or may not
shrink.

The “real” size for any shape is the size set using the
normal sizing commands, such as clicking and dragging on
a selection handle. If the shape is forced to grow because
more text is entered inside than will fit, it remembers its
original size. When text is removed from the shape, it
shrinks back to its original size if it can. If the shape is
already at its "real™ size, then removing text has no effect.

Inserting Symbols

The Insert Symbol command, under the Text menu,
allows you to quickly insert a character in a particular font.
It presents the Insert Symbol Dialog and is active only
when a text entry session is open. Selecting one of the
symbols from the dialog inserts it into the stream of text.

— Select Character to Insert:
Eont:INormalText j Add Font | Bemovanntl
Cancell
INE R NN EE L EEHE EI B
=|=[=]7|alala|c|ole|e|a[H] 1|J k] mr]a]r]alr]s| Tu] v HE'P|
HIVIZ( DT ] (alklc|d|e| flalh]i]i|k]mnjolpjalr|s
tlu|viwlx|y|z[ 1] ~[ofa]al. [f].] | t]t] 45| |Eofo|o
ol "B - ™ & | o]y B EEIHEI N E
S[-18{ 7] === {ula] -2 s el o [ A ALA] Al &] AlEl ¢
elelgle|i|i]i]ile{R|ao|a]o|a]={a|Ofu]O{u]v|e|r]a| 44| 4
alales|c|e|a|&la|i|i|i|i|a|f|ald|afd|a|=|a|afa)d|dalv]p|V

The Insert Symbol Dialog

You select a symbol by clicking on it. Pressing OK, or a
double-click, inserts the symbol and closes the dialog.
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If the font drop-down list shows “Normal Text”, the
typeface of the inserted character is the same as the current
font. If a specific font is selected, the inserted symbol has
this font.

You can add new fonts, or remove them from the list, using
the Add Font and Remove Font buttons.

Special Characters
SmartDraw supports text entry of the following special
characters:

e Tab. You can enter a tab character by typing Ctrl-
Alt-Tab. (Normally tabs move you from one object
to another)

e Hard Space. Typing Ctrl-Space enters a hard space.
This joins two words so that they are not separated
by word wrapping. Hard spaces are also not hidden
at the end of lines when they wrap, like normal
spaces are.

e Soft Hyphen. Typing Ctrl-hyphen enters a soft
hyphen. This is invisible but allows a word to be
split by word wrapping, in which case it shows as a
hyphen at the end of a line.

Bulleted Text

You can use the Bullets command, under the Text menu, to
automatically format text with one of four bullet styles,
with proper indentation. Bullets can be applied to the entire
shape, or individual paragraphs within a shape.

¢ Line |
¢ Line 2
& Line 3

Bulleted Text
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Changing Text Color
You can change the color of text using the text color menu
(under the Text menu).

You can change the color of individual characters. The
color selected from the menu is applied only to the range of
text currently selected.

Changes can also be applied to selected shapes that contain
text. In this case, the new color is applied to all the text
inside the selected shapes.

Changing Text Shadows

Whether the text in a drawing shows a shadow is
determined by the properties of the current Color and
Shadow style, and whether this has been overridden for a
particular shape, using the Shadow command under the text
menu. These issues are described on page 89.
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Using Tables

What are Tables?

Tables are particularly useful for creating timelines,
organizational charts, Gantt charts, software diagrams, and
business forms. We’ll discuss each of these at the end of
this chapter, but first let’s look at the basics of tables.

Normally, text entered into a SmartDraw shape occupies a
single text entry area that fills the shape. However,
SmartDraw also supports Tables, or multiple text entry
areas within the same shape.

Normal Shape Table

Entry Area 1| Entry Area 2| Entry Area 3

One entry area
Entry Area 4 etc......

Each text entry area (or cell) acts like a separate shape as
far as text entry is concerned. Each cell has its own text
alignment and background color and the text inside shrinks
or grows independently of other cells.

Adding Tables to a Drawing

You can add a new table to your drawing simply by
clicking on the table button. This is a shortcut to the Add
New Table command under the Table menu.

This command presents the Table Dialog, which shows a
list of pre-defined table formats. Pressing the OK button
adds a new table with the selected format to your drawing.

In addition to the format, you can choose the number of
rows and columns you want your table to have by changing
the values shown in the dialog.
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Add Hew Table

Select a Table Format
Previgw

fSimple Grid
Simple Columnz
Simple Rows
Headingz with Grid
Headings with Calumns

1] |
Cancel

Help |

TimeLine 1 hd!

Parameters

Murnber of Bows: |2 Mumber of Columns: |2

-
Bemove. .
[ Do not include any of the text shown when applving this farmat.

The Table Dialog
As a shortcut you can also drag and drop a table into your
drawing from the toolbar table button. This creates a table
using the most recently selected format from the Table
Dialog.

Tables created by the table button or the Add New Table
command are always rectangular.

Changing a Normal Shape into a
Table

Existing shapes can be converted into tables by the
Convert to Table command under the Table menu. As
with a new table, you select the format from the Table
Dialog. This inserts the desired table into the shapes
currently selected. Any text inside the shapes is placed in
the first cell of the table.

Non-rectangular shapes may also contain tables:

TN \

1 /

Different shapes containing the same 2x4 table.
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Changing a Table into a Normal
Shape

You can also change a table into a normal shape with a
single text entry area using the Convert to Text command
under the Table menu. Any text contained in the table cells
is joined together as one text block inside the converted
shape.

Rows, Columns and Cells

Tables are composed of one or more rows of cells. Usually
the cells in each row are lined up underneath each other to
form columns, but this need not be the case.

Each cell is an independent rectangular area that may have
its own block of text, background color and other attributes.
The boundaries of the cells are like the borders of shapes.
They may have their own thickness, color and pattern. Cell
borders may also be hidden. Some examples of table
formats are shown below.

Note that columns may differ in width and rows may differ
in height. Column arrangements may differ among rows.
Cells may also span more than one row.

YES

Different Table Formats
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Formatting Tables

You can change the appearance and cell arrangements of an
existing table, by choosing Format Table from the Table
menu. This shows the Table Dialog (see illustration on
page 107).

SmartDraw maintains a list of table formats. These are
shown in the scrolling list on the left of the dialog. A
preview of the format currently selected in the list appears
on the right.

The number of rows and columns in any particular format
can be adjusted using the text fields in the Parameters
section of the dialog.

A checkbox lets you can choose whether to include the text
labels associated with the selected format, or not.

A second checkbox gives you the choice of whether to try
to resize the table to fit inside your existing shape, or to
grow your shape to fit the normal dimensions of the table.
Note that it is not always possible to fit the new table
format inside your shape, particularly if you add rows,
since rows have a minimum height given by the height of
the cell’s text setting.

Adding Table Formats of Your

Own

When you use the Format Table command on an existing
table, its format is added to the list and shown in the dialog
as [Current Settings]. You can add the current setting to the
permanent list of formats by pressing the Add to List
button. This presents the following dialog:

Add To The List E|

Tvpe a name far the new format;

Il Cancel |

Help |

Adding the current table to the list of table formats
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Enter a name for the format and press OK to add it to the
list.

You can remove formats you added by selecting a format in
the list and pressing the Remove button. Permanent built-in
formats cannot be removed.

Formats you have added are stored in your personal
preference file and are not available to other users sharing
the same copy of the program on a network.

Adding Text to Tables

By default, tables are opened for text editing with just one
click of the mouse in a cell. You can change this using the
Text Entry Properties command under the Shapes menu
as described on page 96. If you created your table by
converting an existing shape, then, by default, a double-
click is required for text entry. This too can be changed to a
single click using the same command.

Text entry in a cell behaves exactly the same way as text
entry in a shape.

Preventing Changes to Text

Sometimes you may want to prevent text in a cell from
being changed (or to prevent text being entered into a cell
at all), particularly in forms where you may want to freeze
the field labels while allow editing in the field themselves.

You can allow or prevent text editing on a cell-by-cell basis
using the Do Not Allow Text Editing command under the
Table menu. This shows a check mark if one of the cells
selected has the No Editing parameter set to true. Using the
command toggles the ability to edit text on and off for the
selected cells.

Text Resizing and Tables

If you enter enough text, the cell will be forced to grow. To
maintain the row and column arrangements of the table, the
cell’s entire row or column will also grow.
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All the cells in a table follow the text resizing rules of the
shape that contains the table. (See Text Entry Properties
on page 94.)

By default, shapes containing tables are set to grow
vertically as text is added. This means that text wraps
within a cell, and rows get taller as text is added.

Shapes containing tables can also be set to grow
horizontally or proportionately as text is added. Horizontal
growth requires that columns (and tables) get wider as text
IS entered.

More text than
will fit

Change Vertically

More text than will fit

Change Horizontally

Text Sizing in Tables

Moving Around the Table

When you are entering text into a cell, typing the Tab key
moves the text insertion point to the next cell to the right. If
the cell is at the end of a row, the insertion points wraps
around to the first cell on the row below. shift-Tab does the
reverse.

The Up and Down arrow keys also move the insertion point
up and down rows within a column.

The Right and Left arrow keys move the insertion point left
and right within the text of the current cell, but to the left
and right cell respectively if the cell contains no text.

Note that cells with the No Editing attribute are skipped
when moving the insertion point.
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Selecting Cells

Clicking and dragging the mouse within a table selects a
range of cells, highlighting their centers with black, just as
in Excel® and other spreadsheets. Rows and columns can
also be selected by clicking at the leftmost or topmost edge
of the table. When a click would select a row or column,
the cursor is displayed as a wide arrow (shown at left).

Selecting the shape that contains the table implicitly selects
all the cells and dividers in the table. The shape itself is
selected by clicking on the border of the table. The cursor
appears as the normal selection tool (shown at left) when a
click would result in the selection of the entire shape, rather
than the cells it contains.

Clicking anywhere in the table in Multiple Select mode
always selects the shape containing the table, rather than
individual cells.

Holding the ctrl key down while clicking on a cell allows
you to select a discontinuous group of cells, one cell at a
time. Ctrl-clicking on a selected cell de-selects it.

Holding the shift key down while clicking on a cell extends
the selection rectangle from the Anchor cell to the clicked
cell. The anchor cell is the cell in the table that was initially
selected.

Once a cell is selected, the selection can be moved using
the arrow keys. Holding the shift key down while typing an
arrow key extends the selection in that direction, just like
shift-clicking does. Tabbing also moves the cell selection.

Applying Changes to Selected
Cells

Once selected (either for text editing, or with a black center
by “highlighting”), cells may have their attributes changed
with many of the menu commands.

The Cell Background Color and Cell Background
Shading submenus under the Table menu can be used to
change these properties for selected cells. The equivalent
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commands under the Shapes menu also work in the same
way.

The Grid Line Style and Grid Line Color submenus,
under the Table menu, can be used to change the borders of
the selected cells. (Note that the equivalent commands
under the Shapes menu change these attributes for the
border of the shape, which contains the table.).

Most of the Text menu commands may also be applied to
cell contents: Font, Text Color, Alignment, Bullets etc.

Selecting Cell Dividers

You can also select the lines or dividers between cells with
the mouse. When a mouse click would result in the
selection of a divider, the cursor becomes two parallel
lines, as shown in the margin to the left.

Selected dividers are shown as green dotted lines. Once a
divider has been selected, the selection range may be
extended by shift clicking on lines parallel to it. Ctrl-
clicking adds just the line clicked-on to the selection range.

You can change the attributes of the selected dividers with
the menu commands in the Grid Line Style and Grid Line
Color submenus. The equivalent commands under the
Lines menu also make the same changes.

Partially Selecting Row and Column Dividers
Normally, when a cell divider is clicked with the mouse,
the whole divider for the row or column is selected. If the
Alt key is held down while clicking, however, only the
segment of the row or column divider for the local cell is
selected. Alt clicking on other divider segments adds them
to the selection. Holding down both the Alt and Ctrl keys
toggles the Selection State of a divider segment.

This feature allows the application of attributes to parts of a
row or column divider, and more importantly, allows parts
of them to be moved!
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Moving Cell Dividers

Clicking on a row or column divider not only selects it, but
also allows you to move it. You can increase or decrease
the width of columns and the heights of rows by dragging
the dividers with the mouse.

When whole column dividers are moved, only the width of
the column to the left of the divider is affected. The
columns to the right remain the same size. Hence the table
grows wider or narrower to accommodate the change in
width of the divider’s column. The same principal also
applies to row dividers.

Using the Alt key to select a segment of a column divider
allows the small selected segment to be moved, changing
the width of the immediately adjoining cells. This is one
way to create tables with cell arrangements that are more
complicated than regular rows and columns.

More text than >
will fit

Alt-Drag just the top row column divider

More text than will fit |

Moving Partial Column Dividers

When column dividers are moved while holding down the
Alt key, the column to the right of the divider becomes
narrower as the one to the left becomes wider (and vice
versa). The width of the table remains unaffected, unless
forced to grow to maintain a minimum width for a column.

Changing the Width and Height

of Cells.

There are several ways to adjust the height and width of
cells, and hence rows and columns, within a table.
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Dragging Cell Dividers

We have already described how row and column dividers
can be dragged to change the width of columns and the
height of rows, using the mouse.

The invisible Snap-to grid affects the position of cell
dividers. When the Snaps are active, row heights snap to
whole line heights, as determined by the height of the first
line in the table. Column dividers fall only on the lines of
the grid. This makes it easy to re-align column dividers that
have been separated by dividing cells or by dragging partial
dividers.

The far right and bottom edges of the table behave like
dividers and can be dragged with the mouse. The divider
cursor appears just inside these edges. Dragging on this
“phantom” divider changes the width of the last column, or
height of the bottom row.

Spacing Rows and Columns
Evenly

These commands, under the Table menu, make all the rows
or columns in the table the same height or width, while
changing the size of the table as little as possible.

Resizing the Table Object
Resizing the object that contains the table scales the table
as a whole to fit the new dimensions of the object.

The combined table and object cannot be reduced in height
to less than the minimum height of all the rows. You can
quickly minimize a table’s height by shrinking the object
vertically as far as it will go.

Holding the shift key down while resizing the object with a
corner selection-handle will scale the object, and the table,
proportionately.
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Joining and Splitting Cells.
The Join Cells and Split Cells commands, under the Table
menu, allow you to create complex table structures.

The Join Cells command joins selected cells into one cell,
combining any text in the cells into a single block of text.
When cells from multiple rows are selected, cells adjacent
to each other in the same row are joined first. Cells adjacent
to each other in the same column are joined only if they
have no selected neighbors in the same row.

Joining cells in the same row simply removes the cell

divider(s) between them.

Join Cells in a Fowr

More text than will fit

Joining Cells Horizontally

Joining cells in the same column creates a single cell that
spans the rows containing the selected cells. Cells that span
more than one row always span a whole number of rows. It
is not possible to create a cell that lies partially in a row.

vore text than

wll fit

Joitn Cells in a Cohatrn

fore text than
wall it

Joining Cells Vertically

The Split Cells command does the reverse of Join Cells. If
a cell spans more than one row, splitting creates a cell for
each row spanned. Any text in the split cell is placed in the
top, or left, cell.
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If no selected cell spans more than one row, all selected
cells are split into two cells within the same row and
occupying the same space as the original cell: A vertical
cell divider is added to the center of the cell.

Inserting Rows, Columns and
Cells

You can insert columns and cells anywhere in the table
using the Insert command under the Table menu.

When whole rows are selected, the Insert command shows
Insert Row. It adds the same number of rows as are
selected, inserting them above the uppermost selected row.

1
I
3
4
Insert
1
2
3
4
Insert Row

When whole columns are selected, The Insert command
becomes Insert Column. It inserts the same number of
columns as are selected, inserting them to the left of the
leftmost selected column.
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2
3

4

Insert Columns
When a rectangular block of cells is selected that is not a
whole row or a column, the Insert command says Insert
Cells and presents a dialog with four options for inserting:
Insert Cells

Insert
" Shift cells right

i« Shift cells down m

" |nsert entire row

" |nsert entire column Help

Insert Cells Dialog

In addition to inserting whole row and columns, cells may
be inserted in just the selected rows or columns. This
provides an easy way to shuffle a whole column down (or a
row right), to insert a missing value, for example.
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[ 1]
[ 0]
3
4

Do m| =

Shift Cells Dowm

Olo|m| =

P | LD B —=

Inserting cells within a column

Shift Cells Right
1 A
2 B

3 C

4 D

The same table inserting within a row

Appending Rows and Columns

The Format Table command (Table menu) provides an
easy way to append rows and columns to a table. This
command presents the Table Dialog. The format of the
currently selected table appears as [Current Settings]. You
can append rows or columns by increasing the values for
the number of rows or columns shown in the dialog and
pressing OK.

You can also completely change the arrangement of cells in
the table by selecting one of the other formats from the
scrolling list shown in the dialog.
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Deleting Rows, Columns and
Cells

You can remove selected cells from the table with the
Delete Cells command. This works in essentially the
reverse way of the Insert Cells command described above.
When whole rows and columns are selected, the Delete
command shows Delete Rows and Delete Columns,
respectively.

When you delete partial rows and columns with the Delete
Cells command, values are moved up or left, but the total
number of rows and columns remains fixed. To remove
spare rows or columns, if desired, simply make a second
Delete operation.

You can use the Format Table command to remove rows
and columns from the bottom and right edge of the table.
Just reduce the number of rows and columns shown in the
Table dialog and press OK.

Deleting, Copying and Pasting
Text

With a single keystroke you can delete the text contents of
a cell, without removing the cell itself. Typing the
Backspace Or Delete key erases the text in all selected cells.

The content of selected cells can be copied to the clipboard
using the Copy or Cut commands under the Edit menu.
Pasting the content back into a SmartDraw table preserves
its row and column arrangement along with fonts,
alignment and other text attributes. You can even paste the
table data from SmartDraw into another application, such
as an Excel spreadsheet or Word table, and it will retain its
tabular format.

The reverse also works. Pasting tabular data from another
program into a SmartDraw table preserves the row and
column arrangements of the data, placing each field in its
appropriate cell. This allows data from spreadsheets and
other applications that generate tabular data to be formatted
as a table in SmartDraw.
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Changing the Appearance of a
Table Object

As we discussed above, the color, pattern, borders and text
properties of cells may be changed by first selecting the
cells and then using the appropriate menu commands under
the Table and Text menus. Selecting the entire object
containing a table implicitly selects all the cells and
dividers in the table, and any changes to the attributes then
apply to the entire table.

AutoFill

The row and column headers in a table are frequently a
series of numbers, months or days. SmartDraw can create
these series for you, with the AutoFill command under the
Table menu. This presents the AutoFill dialog.

AutoFill Table
Tvpe Freview = .
{* Numbers 1
" Days of the Week 2 Cancel
" Manths ]
" Years 4 Help
" Constant =
Parameters

Starting Yalue |1 Ending %alue a Prefix
Increment 1 Humber of Waluez |8 Suaffix

Inzert

" Inzert across the row 0+ Do the calumn

The AutoFill Dialog
SmartDraw will automatically type the selected series
across a range of rows or columns, beginning with the
currently selected cell.

There are five choices for the type of series: Numbers,
days-of-the-week, months, years, and a constant value.

For days-of-the-week and months, the sequence can begin
at any value, and it repeats until the Number of Values is
reached. A checkbox lets you choose between full and
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abbreviated names for the days or months. A preview
appears showing the current selections.

For years and other series of numbers, a prefix and a suffix
can be specified to create a string. For example, the
parameters:

Parameters
Starting Y alue |1 Ending *alue |5 Prefis I
Ihcrement |1 Mumber of ¥ alues |4 Suffig I,'IEIEIB

Result in the strings Q1, 1998, Q2, 1998, Q3,1998 and so
on.

The radio buttons at the bottom of the dialog indicate
whether to insert the series across the row containing the
currently selected cell or down its column.

Using Tables
The ability to divide shapes into multiple text areas opens
up a whole new world of flexibility in diagramming:

Timelines
Timelines are diagrams that consist of one large table.

Mon  Tuva |'ﬂ'nd | Thur  Fri Zat Sun |

Begin War k
Milestone 1
Milestone 2
Milestone 2

Timeline

SmartDraw’s table features make it very easy to maintain
and manipulate complex tables.

Software Diagramming
Many of the symbols used in software diagramming require
independent text entry areas:
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f G "

Bottom

\ Locaton

Multi-Text Entry Symbol

Organizational Charts
Multiple text entry areas in a single shape allow you to
store complex information in organizational charts or

family trees.
Mary Johnsan
CEQ
X239 Rrrz4
Jim Chang Arthur Lewis Jean Dubios
WP Finance Wi Eng. WP, Sales
x241 Rrm23 X282 Rrmg w200 Rrm &

Organizational chart with multiple fields per position
In the example above, each position has four cells: Name,
title, extension and room. The last two share the same row.
The cell dividers are white.

Forms
SmartDraw’s sophisticated table functions make it an

excellent form designer:

46 hain Street

TTas

Country

Designing Forms with SmartDraw
View the templates in the Forms drawing-type for more
examples.
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Arranging Objects

Arranging Objects

SmartDraw includes several features that make it easy to
align shapes and lines, and to control their front-to-back
order. These commands are grouped under the Arrange
menu.

Using Snaps

The Snaps are a grid of imaginary lines that extend from
the minor ticks on the rulers. When snaps are turned on, the
centers (or sometimes the edges) of shapes and lines
automatically align themselves with the tick marks on the
rulers as they are created, moved, or resized with the
mouse. This makes aligning the centers of very easy: You
simply drag them with the mouse. The grid used by the
snaps is the same one that is displayed by the Show Grid
command under the View menu.

You can choose whether the Top-Left or Center of your
objects will snap to the grid. You set this property for the
entire drawing in the Define Rulers and Grid dialog.
(Page 167).

The default setting of Center is best when lines are used to
link shapes together, as in flowcharting. The Top-Left
setting is best when the edges of shapes must line up, as in
form design or when drawing floor plans.

When you move or resize objects using other methods,
such as with the arrow keys, they do not align with the
snaps. This makes it easy to make fine adjustments in
position without turning the snaps off.

The Use Snaps command, under the Arrange menu, toggles
the snap mechanism on and off. When Snaps are on, the
menu item shows a check mark.
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Aligning Objects
The edges of several objects can be aligned with each other
using the Align command under the Arrange menu.

The Align command aligns the edges of selected objects
with the target selected object. The target selected object is
the one that shows solid handles, rather than hollow
handles. It is the most recently selected.

The Align Left and Right commands align the left or right
edges of the selected objects with the left or right edge of
the target object, respectively.

Target Target
3 |
[ ]
] —
Before After

Align Left Command
Aligning the Top and Bottom works similarly.

The Center Vertically command aligns the midpoints
between the left and right edges of the objects. Center
Horizontally works similarly, aligning the midpoints
between the objects’ top and bottom.

Making Objects the Same Size

You can make several shapes the same size in height, width
or both using the Make Same Size command under the
Arrange menu.

Like the Align command described above, Make Same
Size uses the target selected object as the template for
changes to all the other selected objects. The Make Same
Size Width command makes all non-target selected objects
the same width as the target. Height and Both work
similarly.
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Target Target

Before After
Make Same Size Command
Objects that can only shrink or grow proportionally
maintain their proportions under this command.

Spacing Objects Evenly

Using the Space Evenly commands, you can arrange three
or more shapes so that there is the same amount of space
between them. This is useful for creating an equally spaced
array of lines or shapes. The Space Evenly menu item has
three choices on its sub-menu: Horizontally equalizes the
space between objects in the horizontal direction only.
Vertically does the same in the vertical direction, and Both
does the same in both directions at the same time.

Centering the Drawing on the
Page

The Center Drawing on Page command under the
Arrange menu can be used to move all the objects in the
drawing so that they are centered in the minimum number
of pages needed to print them. The drawing is also moved
to the top-left of the 50x50 inch drawing area. This
command applies to all objects, not just selected objects.

If your drawing does not fit on one page, you can still print
it on a single page by checking the Print on One Page
check box in the Print dialog.
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Changing the Front-to-Back
Order

Objects may lie on top of other objects. You can change the
front-to-back order of the objects in your drawing using the
Bring to Front or Send To Back commands under the
Arrange menu.

=D - ul®

Before After
Bring to Front
Bring to Front moves any selected objects in front of the
non-selected objects. Send to Back does the reverse. These
commands have no noticeable effect unless objects overlap
one another.

=) - u

Before After
Send to Back

Locking Objects

You may lock or unlock selected objects using the Lock
Object command. Locked objects show selection with gray
handles instead of black and cannot be moved until they are
unlocked. This is useful if you want to place an object
behind others and don't want to accidentally move it while
clicking on the objects in front of it. Locked objects cannot
be opened for text editing. However, their properties (color
etc.) can be changed using the menu commands.
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Connecting Lines and Shapes

Linking Objects to Each Other

SmartDraw lets you link objects together so that they stay
connected when you move or re-size them. This is
particularly useful for flowcharts.

The most common case is a line linked to two shapes.
Moving one of the shapes changes the size and shape of the
line as shown below.

A Line Linked to Two Shapes

Linking a Line to a Shape

When line linking is enabled, you can link a line to a shape
by moving one end over the border of the shape, either by
resizing or moving the line with the mouse.

When the end of the line approaches the shape's border, a
series of round solid circles appear on the shape, indicating
the points on the border where the line may link. These are
called connection points. This is shown below for fixed
connection points. (Connection points can also be infinite,
see page 129).

Connection Points

5}; The end of the line then snaps to the closest connection
point and the mouse cursor becomes an "anchor".
Releasing the mouse while in this state establishes a link
between the line and the shape.

You can even link one line between two shapes in a single
drawing operation. Just click on one of the line tools on the
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toolbar (but not the automatic connector) and release.
(Your cursor now looks like a pencil). Touch the pencil to
the border of one shape and click down with the mouse.
Drag the pencil to the edge of the second shape and release.
The two shapes are now linked to the line, and they will
stay connected even if one or both of the shapes are moved
or resized.

Line Linking and Flowcharts

Linking lines to the edges of shapes is a key feature when
creating flowcharts. By linking lines in this way, you can
move the shapes and the lines remain attached.

Normally in flow diagrams of all types, you link a line to
the center of the side of a shape. If the centers of shapes
joined by a line do not align exactly with each other, the
line will be kinked. Because of this, the centers (rather than
the top-lefts) of shapes are set to snap to the grid when
drawing flowcharts. This is one of the parameters set when
you choose a Flowchart type from the New Drawing
dialog.

If you choose a floor plan, or a drawing where exact
placement of edges is important, then shapes are set to snap
their top-left corners to the grid.

The way shapes snap to the grid in the current drawing is
set in the Rulers and Grid Dialog (page 167).

Breaking a Link

Links may be broken using the reverse of the link creation
process. First, click on the line, so that it shows round
handled where it connects to the shape. Then grab the
handle and pull it away from the shape to break the link.
When only one end of a line is linked to shape you can also
break the link by moving the line away from the shape.
Deleting either object also breaks the link.

Infinite and Fixed Connection

Points
Shapes can have either Fixed or Infinite connection points.
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With fixed points, shapes have 16 fixed connection points,
four at the corners of the shape, four in the center of the
sides, and one between each these points. Fixed connection
points make it easy to connect a line exactly in the center of
a side and are the best choice for simple flow charts.

With infinite connection points, lines can connect to any
point on the perimeter of the shape. Infinite connection
points allow you to connect many lines to the same side of
a shape. Certain library symbols can only have fixed
connection points, but you can adjust the position of the
fixed points using the Edit Symbol dialog (page 146).

You can choose the kind of connection points a shape has
using the Connection Points command under the shape
menu. This presents a dialog, which explains each choice
and allows you to change it.

Linked Targets and Linked Objects

In any linking relationship, the object that displays the
connection points is the Linked Target, and the object
linked to it is called the Linked Object. The target object
usually controls the positioning of the linked object. If the
target is moved, the linked object either moves, or re-sizes
to maintain the link.

Lines are allowed to have one or two targets. With one
target, lines move when their target moves. With two, they
change shape and/or re-size when one of their targets
moves.

When a line that is linked to one target is moved, the link is
broken. When a line that is linked to two objects is moved,
all three are moved as a group.

Turning Linking On and Off

You can turn linking on and off. This is very useful when
you want to draw a finely detailed picture, and you don't
want lines and shapes that you draw close to others to
automatically link to them.

The Allow Lines to Link command toggles the ability of
lines to link to other objects. New drawings of the type that
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make use of line linking, like flowcharts, usually have this
turned on automatically.

The Allow Shapes to Link command toggles the ability of
shapes to link to each other. In most drawing-types this is
turned off.

Linking Shapes to Lines

When Allow Shapes to Link to Lines under the Arrange
menu shows a check mark, shapes can link to lines. This is
the opposite of the behavior of lines linking to shapes
described above.

Shapes link to lines via one attachment point, usually in the
center of the shape. You link a shape to a line by dragging
it over the line so that its center (or attachment point) is
close to the line. As the shape’s attachment point comes
into contact with the line, the cursor changes to the anchor
shape and the connect-point becomes highlighted as a black
dot.

X

db

Linking a Shape to a Line

Releasing the mouse leaves the shape linked to the line. If
the line is moved the shape follows.

Dragging the shape away from the line breaks the link.
However the shape can be dragged along the line and the
link moved to a new position, like sliding a bead on a
string.

Linking shapes to lines is a very useful technique for
drawing circuit diagrams and other engineering diagrams:
The circuit components can be dropped directly onto a line,
with multiple components linked to the same line.

3| Iva\’ [ £
&
Circuit Diagram Using Shapes Linked to Lines
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When the Line Shows Through the Shape
Sometimes when a shape links to a line, the line appears to
show through the shape. This is often because the line lies
in front of the shape in the front-to-back order. Selecting
the shape and using the Bring To Front command under
the Arrange menu corrects this.

/\
VAN

Line in Front of Shape

Bring to Front:

/\
[\

Shape in Front of Line

Align Shapes and Text on a Line

The Align Shapes and Text on a Line command under the
Lines menu controls the way shapes lie along the line they
are linked to. There are two settings: Along the Direction
of the Line and Horizontally. Select the line, (not the
shape) and choose one of these options from the Lines
menu.

When the line is set to Align along the Direction of the
Line, a shape rotates to follow the direction of the line.

Align along the direction of the line
When the alignment is set to Horizontally, a shape
maintains its own angle of rotation and can be rotated
independently of the direction of the line.

_—

/

Horizontally
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Shape Attachment Points

By default, shapes link to lines using their centers as the
point of attachment. The attachment point for library
symbols can be adjusted to any other point within the
shape’s boundaries using the Edit Symbol Dialog.

Linking Shapes to Each Other

When Allow Shapes to Link under the Arrange menu
shows a check mark, one shape can be linked to another.
However, shapes can never link to lines where a line is the
target. Instead the line must be linked to the shape.

When shapes link to each other, any of the connection
points on the linked shape can snap to any of the
connection points on the target shape. Shapes can only link
to one target at a time.

This feature is useful if you want to attach a background
text object to a shape so that it follows the shape around
when the shape is moved or re-sized.

Linking Lines to Each Other

Lines can link to other lines. This is useful for creating
branched networks of lines that remain attached when their
target objects (whether shapes or lines) change size or
move.
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Formatting with Automatic
Connectors

Using Automatic Connectors

One of the most powerful features of SmartDraw is the use

of Automatic Connectors to create regular arrangements

of shapes. Examples include organization charts, fishbone

diagrams, network diagrams and even flow charts.
Organization Chart

Metwark Diagram Fishbone Diagram

Using Connectors

Automatic Connectors are special line objects that both
shapes and other lines may link to. A connector is
programmed to arrange the objects linked to it in a
particular pattern. As shapes are linked to a connector, the
other shapes already linked to it adjust to accommodate the
new shape and maintain the arrangement. In the example
below, a new shape is added to a connector that maintains a
horizontal organization chart arrangement.

Adding a new shape to a Connector
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The new shape (white) is dropped between the two existing
shapes and is automatically inserted between them.

Adding Connectors to a Drawing

You add automatic connectors to a drawing in the same
way you add any other object: using drag and drop or the
pencil drawing method.

SmartDraw offers an Automatic Connector tool on the
Program Toolbar. Dragging an object from this tool
creates a horizontal connector with a linear arrangement.
Holding the shift key down while you drag creates a
vertical connector.

Many of the diagram templates also offer ready-made
connectors in other arrangements in their document toolbar.
For example, the organization chart template offers a
selection of connectors suitable for drawing organization
charts.

Changing a Connector’s Shape
Once you have added an automatic connector to a drawing,
you may change the arrangement it maintains (or its shape)
using the Change Connector Shape command on the
Lines Menu. (This replaces the Change Line Shape
command when a connector is selected).

Tewt  Draw  Libraier  Window  Help

2ue I N=
Color , U A A =
f— 1 — .
Change Connector Shape — =
Arrowheads.. + ] '—;:—' : T
Shaw Length |ar
Join to Make a Mew Shape... a0 o | ﬁ

Change Connector Shape

The Flip command (see page 68) can also be used to create
additional variations.

When no shapes are linked to a connector, it appears as
either a vertical or horizontal line. Its arrangement does not
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become apparent until two or more shapes have been linked
to it.

Adding Shapes to a Connector
When you move a shape or line close to an automatic
connector, connection points appear, and the outline of the
moving object jumps to the closest one, showing the
position the object would take if linked.

Releasing the mouse links the object to the automatic
connector, inserting the object at the link point.

&_L:—%J—Ajjmk% | |

Linking to an Automatic Connector
Moving a shape away from the automatic connector
disconnects it, and the shapes still linked to the automatic
connector move together to fill the space.

— Litlk Fernowed m
| | [ |

Breaking a Link to an Automatic Connector
Dragging a shape from one connection point to another
changes the order of the shapes.
— Shape Ivoved 2w

EC e EmEm

Re-arranging a Link to an Automatic Connector
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Linking Automatic Connectors to
Each Other

Automatic connectors can be linked to each other to create
more elaborate diagrams.

)

]
]

Organization Chart with Two Connectors
In the example above, the connector used to arrange the
four smaller shapes is linked to the one used for the two
larger shapes. This in turn is linked, like a line, to the top
shape.

Adjusting the Connector Spacing
There is normally an equal amount of space between the
edges of shapes linked to an automatic connector. This
regular spacing [C] is controlled using the grow handles at
each end of the main connector line.

In addition to this regular spacing adjustment, you can also
add to the space between each shape attached to connector
individually, by clicking and dragging on the adjustment
handles [D]

The length of the lines connecting the main line to each
shape is controlled by grow handles at the end of the first
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and last of these lines (where they connect to the shapes)
[B].
The length of the line connecting the connector to another

object [A] is controlled by the grow handle at the end of
this line.

These relationships are shown in the figure below.

-
Y

. e
N 1

C—||—D—|| ||_C_|

Grow Handles and their Parameters

Some connector arrangements have two lines that may
connect to other shapes at each end of the main connector
line [A]. Only one of these can be linked to another object
at a given time.

p

Ny

. !
NN
ul

Side Arm Connectors and their Parameters

The side arm lines of an automatic connector can be set to
zero length by tucking the grow handles "under” the line..
This gives a clean end to the main connector line, where
desired:
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Automatic Connector with a Side Arm Length of Zero

Changing an Automatic

Connector’'s Appearance

An automatic connector has the same attributes as a line,
and the Lines Menu commands can be used to set its
thickness, color and style.

Automatic connectors also can show arrowheads. These
appear on the lines connecting objects to the main
connector line. Right facing arrowheads always point to
the linked objects, regardless of their direction relative to
the main connector line. Left facing arrowheads point
towards the main connector line.

Automatic connectors cannot have text associated with
them (see Attaching Text to Lines on page 97) and cannot
be rotated.

Using Automatic Connectors in
Flow Charts

Linear automatic connectors can be useful as components
in a flow chart. A linear connector connects shapes in either
a perfectly horizontal or vertical line, as shown below:

<> ()

Horizontal Automatic Connector with Arrowheads
To branch, other automatic connectors can be linked to the
shapes attached to the first automatic connector. This is
shown below:
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Horizontal and Vertical Automatic Connectors with Arrowheads

Next, normal segmented lines can be used to create
additional connections:

Flow Chart with Segmented Lines and Automatic Connectors
Now, adding another step to the main horizontal or vertical
automatic connector is as easy as drag and drop! The chart
below was derived from the one above by simply dropping
the delay symbol on the horizontal automatic connector.

]

Chart is Automatically Reformatted

140 e Formatting with Automatic Connectors SmartDraw User's Guide



Beginning Users

While automatic connectors are a powerful addition to
flowchart design, most beginning users will be better off
using normal “straight” lines and links as described in
Connecting Lines and Shapes on page 128.
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Symbol Libraries

Libraries
In addition to the built-in shapes shown on the toolbar,
SmartDraw provides thousands more in Symbol Libraries.

Collections of symbols are divided into many separate
libraries. These are files on your hard disk.

Libraries are usually groups of symbols that are used by a
particular type of diagram. SmartDraw has hundreds of
libraries with symbols for flow charts, computer networks,
space planning, clip art, engineering, and many other kinds
of diagrams.

Library Windows

The symbols in a library are displayed in a Library Window
that “floats” above the program window. Up to 16 library
windows can be open at the same time, each showing the
contents of a different library.

Flowchart HiE

Librariez

== (| [N
A=K
BV=)Y

A Library Window
A library window shows rows of buttons, each displaying a
different symbol. The name of its library is shown in the
window title bar.

A library window has its own menu. This is used to change
the library displayed in the window, create new libraries
and edit the contents of the current library. It is the same as
the Libraries menu on the main menu bar.

When you click the minimize button at the top right of the
window, it shrinks the library to a minimized window at the
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bottom of your screen. This is useful if you want to
temporarily move a library window out of the way.

Changing the Size of the Buttons

The Small, Medium and Large commands on the
Libraries menu control the size of the buttons in a library
window. You may select the size that best suits both your
display resolution and your eyes. Complex clip art
drawings generally look better with larger buttons. These
commands have no effect on toolbars, which have buttons
the same size as those on the Program Toolbar.

Symbol Names

You can use the Names command under the Libraries
menu to show the name of each drawing on its button
instead of its picture. This is the same name that shows in a
ToolTip when the mouse is moved over the symbol button.

Showing Names and Symbols

You can also choose to see large buttons with the symbol
names underneath by selecting the Large Button with
Names command under the Libraries menu.

Showing Relative Sizes

Choosing the Show Relative Sizes command under the
Libraries menu controls the relative size of the images
shown on each button.

When the menu item is checked, the largest image fills the
space on its own button and the rest of the images are
scaled to be the correct size, relative to the largest.

When the menu item is unchecked, each image fills the
space available on its own button, and all images appear to
be the same approximate size.

Symbol Types

There are two types of library symbols: Automatic and
Metafile. Automatic symbols are native SmartDraw
objects, either alone or in groups. Metafile symbols are
images in Windows Metafile format (WMF).
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Both types have similar properties when added to a
SmartDraw document: They can be rotated, flipped,
colored, typed-into and manipulated in many of the same
ways. Only automatic symbols have all the special
properties of the native SmartDraw shapes, however.

Adding Symbols to a Drawing
Clicking on a button in a library window is the same as
clicking on a shape button in the Toolbar.

Clicking and dragging on a library button drags and drops a
copy of the symbol shown on the button into the drawing.
Clicking and releasing the button changes the cursor to a
pencil. Drawing with the pencil (by holding down the
mouse and dragging) draws a new copy of the symbol.
When an automatic symbol, made up of more than one
native object or group, is dragged onto the page, each of its
components is drawn as a separate object at its original
size.

Automatic Scaling of Symbols

Some symbols are set to size themselves based on the
current ruler settings automatically as they are added to a
drawing. For example, if a drawing has rulers set so that
one screen inch is equivalent to 48 inches, then a 36-inch
desk symbol will be sized automatically to be 0.75 inches
long in the drawing. This is useful for drawing floor plans
and other scaled drawings.

Removing a Symbol from a Library

Remove a symbol from a library by clicking on its button
in the library window, and then selecting the Remove
Symbol command in the Libraries menu.

To change the image of a symbol, you must remove it
completely and then add a new image.

Document Toolbars

You can change a library window into a Document
Toolbar by dragging it to the top of a document window.

144 e Symbol Libraries

SmartDraw User's Guide



As the library window approaches the toolbar area, its gray
outline changes to toolbar shape. Releasing the mouse
changes it to a document toolbar. This is called docking the
window.

You can do the reverse by dragging the toolbar away from
the top of the document window, so that the library window
once again floats over your drawing.

Each document can have only one toolbar at a given time.
Attempting to dock a second toolbar will fail. However,
you can dock a different toolbar to each open document.

When a document is maximized to fill the entire program
window, the document toolbar appears as a third row of
buttons below the program toolbar.
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Document Toolbar below the Program Toolbar.

Bringing a new document to the front, with a different
document toolbar, changes the third row.

A document toolbar behaves just like a library window:
You can add symbols to it using drag and drop, you can
transfer symbols to and from other libraries, and so on.

When a document is saved, its relationship to its toolbar is
saved too, and the next time it is opened, the toolbar
remains in place. Many of the SmartDraw templates use
this feature to automatically open their own toolbars.

The most recently docked library becomes the default
toolbar for all new documents that don’t already have their
own toolbars. You can use this feature to create your own
“permanent” third row to the program toolbar: Simply dock
your favorite library, and all new documents will
automatically have this toolbar.
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Opening a Symbol Library

Symbol libraries are normally opened using the using the
SmartDraw Explorer described on page 70.

Any library window that was left open when the last
drawing was closed is always re-opened automatically (in
the same location) whenever a drawing is opened again.

Like SmartDraw documents, you can also open a library
file by dragging it from the Windows Explorer, and
dropping it anywhere in the program window.

The Open command under the File menu also allows you
to open libraries.

Searching for Symbols

You can search for a symbol by name using the Search
Bar in the SmartDraw Explorer (See page 72).

Changing the Settings for a
Symbol

SmartDraw symbols have special properties used by
SmartDraw to control they way they change size or color
and the way they display text.

You can change the properties (but not the image) of an
existing symbol. To do this, either double-click on the
drawing's button in the library window, or select the button
and then select the Edit Symbol command in the Libraries
menu. This presents the Edit Symbol Dialog.

You can use this to change both existing symbols and new
symbols that you are adding to a library.
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Edit Symbol
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The Edit Symbol Dialog

Automatic Settings

If this box has a check mark (Automatic format), the
symbol was originally created with SmartDraw and it will
behave as a native SmartDraw object when added to a
drawing. It automatically has the properties of a native
SmartDraw object and you cannot override these using this
dialog. .

If the box is unchecked, the symbol behaves like an
imported image. You can set its properties (width, height,
resizing behavior and text entry) using this dialog.
(Metafile format).

Symbols created in SmartDraw itself can have either
format.

Symbols created outside SmartDraw cannot have automatic
settings so for these symbols the Automatic checkbox is
unchecked and disabled.

Preferred Size

The width and height fields control the size of the symbol
when it is created using Drag and Drop. If the Grow setting
is set to Proportional, changing one value changes the
other, so as to maintain the same proportions.
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This setting is grayed out for automatic symbols composed
of more than one native object, since their original size is
maintained.

There are two ways to set the preferred size for a symbol:
Use Fixed Size and Scale to Ruler Settings.

If Use Fixed Size is selected, the shape is sized to exactly
the width and the height specified on the screen, regardless
of the rulers’ settings for the drawing. Your control panel
sets the units of this measurement. If your system is set to
use metric units the dimensions are in cm, otherwise they
are in inches.

If Scale to Ruler Settings is selected, the symbol will scale
to the size dictated by the ruler settings of the drawing. For
example, if you set the preferred size for the symbol to be
1.0 meters, and you add the symbol to a drawing with a
ruler scale of 1.0 meter to the inch, the symbol will be
drawing exactly 1.0 inches long on the screen. However, if
you add the symbol to another drawing with a scale of 0.1
meters to the inch, the shape will be drawn 10 inches long.

Scale to Ruler Settings is very useful for drawing scaled
drawings like floor plans.

Grow

The four radio buttons control the way the symbols can be
resized. These settings are grayed out for automatic
symbols.

Proportional drawings have only four grow handles (one
at each corner) and maintain their proportions when re-
sized.

Horizontal Only drawings have only two grow handles
and can be re-sized only in the horizontal direction. This is
good for drawings that represent horizontal lines.

Vertical Only drawings have only two grow handles and
can be re-sized only in the vertical direction. This is good
for drawings that represent vertical lines.

No restrictions allows drawings to grow in all directions
without maintaining proportions. These drawings have the
usual 8 grow handles.
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These values can be changed for symbols already added to
a drawing using the Shape Sizing command (page 63).

Enter Text

You can enter text into symbols. This text can be Inside
the drawing like the standard 24 shapes, or Above or
Below it. The fourth choice, No text, means that the
drawing will not respond to the normal text entry
commands.

If Inside the drawing is selected, four margin lines appear
inside the Image window. These should be adjusted so that
the text area within the four lines does not overlap the
boundaries of the symbols.

These settings are also grayed out for automatic symbols.
The native objects in these symbols retain their own text
sizing properties.

Attaching to Lines

You can adjust the attachment point used to link the symbol
to a line by defining its position as a percentage (with up to
two decimal places) from the top-left of the shape. You can
also adjust it manually in the image window. The
attachment point is show as a hollow diamond in the image
window. You can drag it around using the mouse.

Only symbols that are non-automatic (metafiles), or that
have just one shape, can be linked to lines and hence show
attachment points.

Image Window

The image window shows the symbol image against a grid
of green lines. A dotted border shows the edges of the
rectangle that encloses the symbol.

A non-automatic symbol has 16 Connection Points shown
as solid black circles. These are the points at which lines
and other shapes will link to this drawing. Automatic
symbols use the connection points of their native objects.

Shapes that can be linked to lines also show a hollow black
diamond representing the attachment point.
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Clicking on the circles and dragging with the mouse button
held down moves them. The connection points should be
arranged on the borders of the symbol. To be active,
connection points must lie outside the margin lines
(whether text is entered Inside the Drawing or not).

You can finely adjust the position of connection points
using the F5, F6, F7 and F8 keys. The point you last clicked
on, moves left, right, up or down by 1 pixel when these
keys are typed.

When the text setting is Inside the Drawing, four margin
lines appear. Clicking on the square handles at each end
and dragging can move these. By default, these are set to
create the smallest text entry area possible between all four
lines. This should be expanded to allow the largest area that
still forces all text to lie within the borders of the shape.
When text is entered Above or Below the drawing, the
margin lines are ignored.

Colors

Checking this box allows SmartDraw to change the color of
the fills, lines, border and text that show in non-automatic
symbols. The style and thickness of borders and lines can
also be changed. These settings are controlled by the Shape
menu, not the Line or Text menu.

The color of the text, lines and borders follows the Border
Color setting. The fills follow the Fill Color. Transparent
fills are not affected by the fill color.

If this box is not checked, the drawing behaves like an
imported image. Applying a border style places a border
around the symbol but does not change the content of the
symbol itself.

The substitution of colors for lines, fills etc. may not work
for all symbols. If the image contains bit mapped images
these may be unaffected by checking the color box. The
rules are: All pens used follow the border style and color.
Black fills follow the border color. Text color follows the
border color. Non-black fills follow the Fill color.
Transparent fills used by the drawing are left alone.
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If you check this box you should experiment with a copy of
the symbol to see the effects of color changes. If these are
not satisfactory, return to the dialog and un-check the box
again.

The colors and other properties of automatic symbols can
always be changed. Remember that checking this box
causes a copy of the symbol to adopt the current default
color scheme when added to a drawing.

Symbol Name

You can assign each symbol in a library an optional name
using the Symbol Name field. This is the name that shows
in the ToolTip when the cursor is moved over the symbol
in the library window.

It is also the name that is displayed on the button if you
choose the Names command from the Libraries menu.

The naming feature is useful when more detail is required
than an image might show. For example, an IBM PS/2
computer may appear to be similar to another PC when
looking at the thumbnail image shown on the symbol
buttons. Their names are quite different however, and
showing the names in a ToolTip makes them easily
distinguishable.

Names are also used when searching for a symbol by word
(page 146). Additional keywords to be matched in searches
may be entered following the name. Just put a semicolon
after the name, then list your keywords, each separated by a
space. Words after the semicolon are not displayed in the
ToolTip, or when names are shown on the buttons.

You can add names in different languages. By default the
names searched and shown as ToolTips match the language
of your SmartDraw Installation. If a native name is not
present, English is used.

Adding New Symbols to a Library

Adding Symbols from SmartDraw
Adding a new symbol to a library is a simple Drag and
Drop operation. Any object, or collection of objects
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dragged from a SmartDraw document window and dropped
onto a library window, may be added as a new symbol.

This operation is an extension of a standard object move
operation. If, while moving one or more objects using the
mouse, you position the cursor over an open library
window, the cursor changes to the Library Drop Cursor,
shown at the left. If you release the mouse at this point, the
Edit Symbol dialog (page 146) appears. The new symbol,
composed of the objects that you were moving, shows in
the Image window. Pressing OK adds the objects to the
library as a new symbol.

You can use the Edit Symbol dialog to set the appropriate
properties for your new symbol, before adding it. You can
also use it later to modify the properties, if necessary.

Note that because collections of native objects can be
stored and retrieved in libraries unchanged, you can use
symbol libraries as a Scrapbook for pieces of diagrams
you might want to reuse.

Adding a Symbol from Another Program

You can use almost any Windows drawing program to
create a new symbol. All that is required is to be able to
load an image to the Windows clipboard in standard
Windows metafile format.

Metafiles are placed on the clipboard when you use the
Copy command under the Edit menu in most graphics
programs.

To add a symbol to a currently open library, first copy it to
the clipboard and then select the Add New Symbol
command under the Libraries menu. The Edit Symbol
dialog is presented just as if you had dropped an image
onto the library.

Images from other programs cannot have automatic
settings.
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Transferring Drawings between

Libraries

Copying a symbol from one library to another is also a
simple drag-and-drop procedure. Click on the drawing that
you want to copy, then drag with the mouse, just as if you
were going to drag a copy into the drawing. However,
instead of releasing the mouse button over the drawing
window (which adds a copy to the drawing), release it over
the library window, or document toolbar, that you want to
copy the symbol to.

When releasing the mouse would result in copying the
@ symbol to another library, the cursor will change to the
shape shown at the left.

This is a useful feature if you want to collect the symbols
you use most often into one or two libraries. You can also
use it to sort the order of the drawings in the library by
dragging them in the order you want to a new library.

Creating a New Library

You can create your own symbol libraries using the Create
New Library command in the Libraries menu. This
displays the Create a New Symbol Library Dialog.

Create a Hew Symbol Library

Marme: ak.
Choose a name far the libram

|T|]M| Cancel

Help

il B

Categony:
Select a cateqgaory or folder for the library [or create a new one].

Select...

Create a new categany...

The Create a New Symbol Dialog

To use this dialog to create a new library, enter a name for
into the Name field.
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Select a category for the library using the Select button.
This displays the Browse for Folder dialog, displaying the
current tree of library categories. Simply select the one you
want.

Browse for Folder

Select a category or folder far the libram.

S § Library
] Busineszs & Charting

] Clipart & Flyers

1 Electrical Engineering
] Floor Plans & Facilities
1 Maps & Geoagraphy

1 Mechanizal Engineering
1 Hetwork Diagrams

] Science & Math

1 Software Design

+

o o o e O e B P

k. | Cancel

The Browse for Folder Dialog
You can also add your own categories by pressing the
Create a New Category button. This displays the Create a
New Category Dialog

Create a Mew Category

Marme:
Chooze a name for the new categony
| Cancel

Help

il

Location;
Create either a new top-level category, or a sub-categony inside anather.
* Create a top-level categany.

" Create new sub-categony inzide:

The Create a New Category Dialog

154 e Symbol Libraries SmartDraw User's Guide



You can create a sub-category inside the category you
already have selected, or create a new top level category
that is not inside any other by selecting the appropriate
radio button.

You must enter a name for the new category before you can
press the OK button.

Once you have selected a category and a library name,
pressing OK from the Create dialog creates the new
library, and if necessary the new category. This is reflected
immediately in the SmartDraw Explorer panel and the
library is opened.

Your new library window, because it is empty, will show
no buttons. You can add drawings to the new library by
dragging them from SmartDraw drawings, other libraries,
or by using the Add New Symbol command as described
above.

The Library Builder Wizard

The Library Builder Wizard converts graphics files, in
many popular formats, into SmartDraw libraries. It can
convert an entire folder of graphics files into one or more
libraries, or it can convert a tree of many folders into many
libraries organized into categories.

The Library Builder Wizard is ideal for converting your
clipart files into SmartDraw symbols. It can convert
thousands of images in just a few minutes.

Open the Library Builder Wizard by selecting the
command of the same name from the Libraries menu.
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SmartDraw Library Builder Wizard
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STEF 4: Select the spmbol properties
Set the acale, and other properties. for 2ach of the syrmbals in Froeitiss
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All of the ‘Win Metafile files in each folder will be converted into one or

mare libraries with the same name az their folder. LConwvert Files
The name of each clipart file converted becames the name of that

zymbal in the nevs library,

The Library Builder Wizard
Converting your files requires just five steps:

STEP 1: Choose the File Format

Select the file format of the graphics files that you want to
import. The choices are the same as those offered by the
Import command. Files in scaleable formats like Windows
Metafiles (WMF), Postscript and AutoCAD format make
better SmartDraw symbols than non-scaleable bitmapped
files like BMP, JPG and GIF.

STEP 2: Select the Files to Convert
Use the Browse button to select the folder that contains the
graphics files you want to convert.

The radio button controls how the files in the selected
folder are converted into libraries.

Selecting Convert all of the files in this folder into one
library, will convert any files of the type selected under
STEP 1 that are stored in this folder into a library with that
folder name. For example, if you are converting 20 WMF
files from a folder called Garden Tools, these will be
converted into one library called Garden Tools.
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If there are more than 40 files in the folder selected, then
two or more libraries will be created. Their names include a
number: Garden Tools-1, Garden Tools-2 and so on.

Selecting Convert all of the files in this folder’s
subfolders into multiple libraries will convert any files of
the type selected under STEP 1 that are stored in each of
the selected folder’s subfolders into separate libraries, each
with the same name as their subfolder.

For example, if the Tools folder is selected, and it contains
three subfolders called Garden Tools, Garage Tools and
Woodshop Tools, three libraries called Garden Tools,
Garage Tools and Woodshop Tools will be created.

If the subfolders like Garden Tools, themselves contain
subfolders, then files in these subfolders will also be
converted into libraries with their subfolder name and so
on: The whole folder tree starting with the folder selected
will be converted into a tree of libraries.

STEP 3: Select the Category for the New Libraries
Use the Browse button to select the library category that
will contain your newly created library.

For example, if you choose Clipart & Flyers/Tools as the
category, using our earlier example, the new library Garden
Tools will be created in this category and will appear there
as an icon in the SmartDraw Explorer.

If you choose to generate a tree of libraries, by selecting
Convert all of the files in this folder’s subfolders into
multiple libraries in STEP 2, the whole tree will be added
to the category you choose.

STEP 4: Select the Symbol Properties

You can also specify the properties of each symbol in the
new library by clicking on the Properties button in STEP
4. This displays the Set Symbol Properties Dialog.
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Set Symbol Properties Dialog

You can choose how each symbol will grow, where text
will be attached to it, and whether it will respond to color
changes. These settings are explained in more detail in
Changing the Settings for a Symbol.

The settings for Preferred Size allow you to set the scale
for each symbol.

If you check the Use Fixed Size radio button, symbols

maintain their actual size. For example, if a picture of a
desk is actually one inch wide, the preferred size of the
symbol in the completed library will be 1.00 inches.

Checking Scale to Ruler Settings allows you to scale each
symbol. If you are converting a collection of symbols that
are drawn to scale, say 48 inches to the inch, you can set
this scale by entering 48 into the Scale field. Then each of
the symbols imported will be created with Preferred Size
set to Scale to Ruler Settings, and a size equal to 48x their
actual size. A one-inch desk will be set to a preferred size
of 48 inches, and will scale to the ruler settings when it is
added to a drawing.

STEP 5: Convert the Files

The final step is to press the Convert Files button to begin
the conversion process. You can watch the libraries being
built, symbol-by-symbol. Once completed, the SmartDraw
Explorer updates itself and expands to show the new
libraries.
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Adding Credits to a Library

You can add supplemental (or credit) information to any
library that you create. If a library has credits, a button
appears at the bottom of the library window. You can
define the text on that button and the message that appears
when a user clicks on the button. Do this by selecting the
Credits command from the Library menu. The Define
Library Credits Dialog is displayed.

Define Library Credits

| English =]
Cancel
Credit Button Label
- Help
|Ellck here for EXTRA symbols

Credit Dialog Text

If wou want more symbals vizit our web site below, J

[

YWeb Site Button RL

|htl|:|:.-’.fwww. smartdraw. com

Advizor File
|f|owcharts|

[ Apply these creditz to all the libraries in this categorny

The Define Library Credits Dialog

The text you enter in the Credit Button Label field will
show in a new button that appears at the bottom of the
library window.
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Clicking on this button, or selecting the Credits command
on the Library menu again, displays the Show Credits
Dialog.

Click here for EXTRA symbols

|F waw want more spmbaols visit our web site below,

Show Advizor

Show Credits Dialog

The text you entered in the Dialog Text field appears in the
body of this dialog. If you enter a web address in the Web
Site Button field, the Go To Web Page button will appear
in the Show Credits dialog. Pressing it will launch the
browser and load that web address.

Entering an advisor name (see page 220) into the Advisor
File field will cause that advisor to open automatically
when the library is opened (except as a document toolbar)
and will cause the Show Advisor button to appear in the
Show Credits Dialog. Pressing this button shows the
advisor manually.

The Credit button appears as a copyright symbol when the
library is docked as a toolbar.
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To edit existing credit settings for a library, hold the Ctrl
Key down as you select the Credits command from the
Libraries Menu. This will cause the Define Library
Credits Dialog to display.

Using the Language list control you can enter different
Credits information for each language supported by
SmartDraw. You can also apply the Credits information
defined in the dialog to all libraries in the same category
folder by checking the box at the bottom of the dialog
before you click on the OK button. Note that the credits are
applied for all languages, not just the one showing in the
Language list.

Sharing Libraries on a Network
Libraries can be shared by multiple users on a network, or
by multiple document toolbars used by the same user.

When a library is opened more than once, the second and
later clients open the library as read-only. Only the first
client to open the library has write permission. Read-only
libraries cannot be edited, and symbols cannot be added or
removed.

SmartDraw User's Guide Symbol Libraries e 161



Creating Your Own Shapes

Joining Lines to Make a New
Shape

You can create a new shape by joining together any
collection of lines and curves that form a closed loop. Use
the Join to Make a New Shape command, under the Line
menu.

Join to Make
\ a MNew Shape

-

Joining Lines to Make a New Shape

The newly created shape is like any other: It can be filled.

It can be rotated and you can type text into it. You can also
drop it on a library window or document toolbar to create
a new library symbol.

Shapes created this way are called Polygon Shapes. They
have infinite connect points, and their text editing areas that
are assigned automatically.

If the lines do not quite touch each other to form a closed
loop, the Join command will fail. If this happens use a view
of 200% or more to clearly see the ends of the lines you are
trying to join, and adjust them until they meet.

Changing Existing Shapes

Any of the 24 built-in SmartDraw shapes, and Polygon
Shapes made by joining lines, can be split apart into their
component lines and curves using the Edit Shape Outline
command under the Shapes menu. This is the reverse of the
Join command described above.

| | a4—H
Edit Shape o

. 0 4
Ctlitie \ /aa

[ [ =

N
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Separating a Shape into its Components

Once separated into lines and curves, the outline of the
shape can be adjusted and then re-combined into a re-
designed shape.

Q—Ch&mge} —Re-Join-

Re-designing a Shape

Grouping and Ungrouping

Two or more objects may be combined into a Grouped
Object using the Group command under the Arrange
menu. The Ungroup command reverses this. Ungrouping
can also separate imported images into native SmartDraw
shapes (page 180).

Properties of Grouped Objects

Object groups behave as a single object in some respects,
and as individual objects in others. The following
operations treat a group as a single object:

e Clicking on any member of the group selects the group.

e Changing properties (color, thickness, font etc.) affects
all members of the group.

e Moving the group moves all members of the group.

e Sizing the group sizes all members of the group.

e Rotation rotates the group as if it were a single object.

e Flipping reflects the group as if it were a single object.

e Duplicating, copying and pasting applies to the group
as awhole.

The following operations treat a group as individual

objects:

e Lines link to individual objects within a group.

e Shapes attach to automatic connectors and other
shapes as individual objects.
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e Text is edited and entered independently for each object
in the group.

e Other files remain hyperlinked to individual group
members after they are grouped.

Grouping objects that are already in a group with other
objects simply combines them all into a single group. There
is no hierarchy of groups.

Ungrouping Imported Images

You can also ungroup most imported images into native
SmartDraw objects. This is described in Ungrouping
Imported Images.

Adding Groups to Symbol Libraries

A grouped object may be added to a library as a new
symbol by simply dragging it onto a library window.
Groups retain their properties as library symbols, and are
drawn as a grouped object when introduced into a drawing.

Note that grouping a grouped object with other objects and
then ungrouping it again will break it apart into its
constituents.
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Viewing and Printing

The SmartDraw Drawing Area
SmartDraw has a drawing area with a fixed size of 50x50
inches, and it is one of the few drawing programs that will
let you draw a diagram this large.

Very few printers support paper sizes that are this large, so
the drawing area is divided up into page-sized rectangles
(or tiles) shown with dotted lines.

& SmartDraw - [Drawing_sdr] =]
@ File  Edit “iew Shapes Lines Table Tewt Amange Took
Librariez  Window  Help - |E |5|

DI2|E| Sl & [BB-] 2|2 W £ B|r|u]a
2N e Bl g e e e e o o o [ P

————————————————————

—————————————————————————

Fit to Window View Showing Page-sized Tiles

Since the dotted lines represent the dimensions of the page
currently selected for this document, they change position
when you change page orientation from Portrait to
Landscape, or change the paper size using the Page Setup
command under the File menu.

If the currently selected printer supports large format paper
sizes (like E-sized) you can select this as the current paper
size and the dotted page boundaries will reflect this,
allowing you to print a large drawing on a single sheet.
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Changing the View

While all SmartDraw drawings can occupy an area of up to
50x50 inches, unless your drawing is very large, you
normally work only with a small part of this potential area,
up in the top left corner.

The View menu items 200%, 150%, 100%, 75%, 50%,
Fit to Page, Fit to Window and Custom... control the
scale used to display a drawing in its drawing window.
100% is the scale used by most Windows programs to show
objects at their natural size. The other scales make objects
look smaller or bigger than they really are.

These scale factors have no effect on the size of shapes and
lines when they are printed out, only as viewed on the
screen.

As you change the view, SmartDraw attempts to keep all of
your objects in the visible part of your window. If this is
not possible, it tries to keep all selected objects in view. If
this is not possible, it tries to keep the center of the selected
set of objects centered in the window.

You can cycle up and down through the views using the
Scale Up and Scale Down toolbar buttons.

Choosing the Custom... command under the View menu
presents the Set Window Scale Dialog. You can use this to
set the scale to any values between 5% and 400%.

Set Window Scale 1]
— Scale window by, ———————————
Percent: |43 =t
=l Cancel |

— Hint
This dialog zets the zcale that your Help |

drawings show in the window. [t has no
effect on printed autput.

Set Window Scale Dialog

The Fit to Page selection scales the window to show at
least one complete page.

The Fit to Window selection shows the whole 50 inches of
the drawing in the document window.
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Setting the Ruler Scale

Two rulers normally appear at the top and left of the
document window. You can set their divisions, units, and
origin using the Set Rulers and Grids Dialog, which is
accessed via the Define Rulers and Grid command under
the View Menu.

Set Rulers And Grids
Scale:

' Inch oK
Show: 1.0 Inches  *| azone ~ ° on the screen.
il

Cancel
Set the pozition of 0 an the rulers [the angin]:

Horigontal Ruler: Place 0at [0.00 Inches units from the left edge. Help

i

Wertical Ruler: Place 0 at [0.00 Inches unitz fram the top edge.

Hint: rou can alzo get the zero pozition of a mler by holding the Chil key
down and clicking in the ruler. Double-clicking in a ruler warks too. v'ou can
zet the zero pozition back to the top-left by double-clicking in the commer
where the rulers mest.

Diiviziong Frevig

Select the number of i} ‘1 ‘
divisions shown in AR T AT
each inch on the
sCreEn,

. -

Hide and Show
[ Check here
ta hide the rulers

|1
A A

Snaps
Snapthe & Center O Top-Left of a shape to the grid

Set Rulers and Grid Dialog

Entering a value for Show sets the number of units for each
major division on the ruler. Major divisions fall either
every inch or every centimeter on the screen. This is set
using the Inch or cm radio buttons.

The actual units chosen using the drop down list do not
change the appearance of the rulers, but do affect the units
shown for lines with automatic dimensioning. This is
described in more detail on page 98. They also affect the
automatic sizing of shapes added from libraries (page 144).

The number of subdivisions per major division can also be
set using the drop down list.

The rulers can be hidden by checking or un-checking the
Hide and Show checkbox in the dialog.
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Setting the Ruler Origin

You can set the position where you want the origin (the
zero point) of the rulers, by typing in a distance from the
left or top edge.

An easier way to do this is to hold down the Ctrl-key and
click the ruler with the mouse at the point that you want to
be zero. Double-clicking the ruler accomplishes the same
thing.

Double clicking in the area in the top-left of the drawing,
where the rulers intersect, sets the origin back to the top-
left.

Snaps

The Snaps setting, at the bottom of this dialog, controls the
way shapes align to the snap-to grid. The default setting
snaps the centers of shapes to the grid. This is important if
line linking (see page 129) is used to connect shapes (as in
flowcharting) because it ensures that the lines connecting
the centers of shapes remain perfectly horizontal or
vertical. On the other hand, if you were drawing a floor
plan, you would want the top left corner of your objects to
snap to the grid.

Printing

For drawings that fit on one page, printing is very
straightforward. Pressing the Print button on the toolbar
prints a single copy to your default printer.

Using the Print command under the File menu presents the
Print dialog, which gives you many more options, including
the number of copies and the range of pages to print. The
range is only relevant when a drawing extends across
multiple pages. The shape and size of these pages are
determined by the Page Setup selections, described on
page 170.

Printing Multiple Page Drawings

SmartDraw does not normally print the entire 50x50 inch
drawing area. It prints only the rectangular array of pages
that the drawing actually touches. If your drawing lies
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completely within one page, only that page is printed. If
your drawing extends across a page boundary, it is printed
on two or more pages.

3! 7
T

--------------------------------

Multiple Page Drawing
In the example above, four pages are printed, marked 1,2,3,
and 4. The top-left page of the array of pages that contain
the drawing is printed as page 1. The remaining pages are
then printed, starting with the page to the right of page 1,
and proceeding from top left to bottom right across each
row.

When a page range is specified in the Print dialog, the page
numbering follows this scheme. For example, to print the
bottom right page only, in the example above, you would
specify a range of page 4 through 4.

If your drawing occupies more than one page, an ideal
printer would print to the edge of each sheet of paper so
that the drawing could be pieced together afterwards to
form one continuous sheet. However, almost all printers
have a gap, between ¥4 inch and % inch, at the edge of each
page, into which they cannot print. SmartDraw takes this
minimum margin into account and shows the printable area
of each page with dotted lines on your screen.

Printing on One Page

Even if your drawing takes up more than one page on the
screen, you can still print it on one sheet of paper by
checking the Print on One Page box in Print dialog. You
won’t see this dialog if you print by clicking on the Print
button in the toolbar, so use the Print command on the File
menu instead.
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For best results, choose a page orientation (Portrait or
Landscape) that matches the shape of your drawing (tall or
wide). Of course, if your drawing is very large it may not
be readable when printed on one page.

Page Setup
The Page Setup command, under the File menu, is used to
set the following parameters:

e Page orientation
e Paper size

e Printer

e Printer properties

This information is stored with each drawing. If you change
a printer property using this command it will affect only the
drawing in the front-most window. Changes will have no
effect on any other program, any other drawing, or on the
global printer settings.

The Page Setup command presents the Page Setup
Dialog.

Page Setup

Frinter

Marne: HF DeskJet 1120C Printer Properties

Status: Ready
Type: HF DeskJet 1120C Printer
Wwhere:  MWWINIBAWDESKJET 1120

Comment:
FPaper Orientation
Size: |Letter [35=11in) ﬂ o Puortrait
Source: ||r'| Tray ﬂ " Landscape
[ Allow 14".5". overlap I:nF-Ttween each page IT' Carcel |
when printing on multiple pages.

The Page Setup Dialog

The printer assigned to a particular drawing may be either
the Default or a Specific printer.
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The Default printer is the one currently specified in the
Windows Control Panel. If the printer assigned to a
drawing is set to the default, its assigned printer changes to
the new default each time you change the default printer,
either by using the Control Panel or by moving the drawing
to a different computer. New drawings are set to the default
printer when they are created.

If you choose a printer other than the default, you assign a
Specific printer to that drawing The next time you print it,
it will automatically select the same printer, no matter what
the default printer setting is. If this printer is no longer
available, you are prompted to select another when the
drawing is re-opened.

The remaining controls in the Page Setup dialog let you
choose a paper size and orientation. If you have more than
one drawing open, these choices apply only to the current
front-most drawing.

Overlap

Checking the checkbox marked Allow 1/6" Overlap...
causes a small strip of each page to be printed again on the
pages that surround it (on multiple page drawings). This
makes it easier to paste together the pages of large
drawings.

Print Preview

@J The Print Preview command puts SmartDraw into Print
Preview mode. The Print Preview button on toolbar (shown
at left) can also be used as a shortcut for this command.
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e SmartDraw
File  Edit “iew Shapez Lines Test Draw  Libraries  Window  Help

[

Print Preview: Page 1 of 2 Print

E@

Print Preview Mode
In print preview mode, the program window shows a
representation of a printed page. For drawings that require
more than one page to print, the scrollbar on the right
controls which page is previewed. The current page number
is shown at the top left of the toolbar.

The toolbar has three buttons: Close, which ends the
preview mode, Print, which ends the preview and presents
the Print dialog, and a Help button.

The Print Dialog

The Print command under the File menu presents the Print
Dialog. You can use this to control the range of pages
printed, the number of copies and several other options.
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Print EE

— Prinker
Properties |

Hame;

Status: Default printer; Ready

Type: HF Laserlet ||IP

Where:  LPTT:

Comment: ™ Print ta file

— Print range Copiez

e Al Mumber of copies: |1 3:

" Pages [mm:|1 _tl:n:|1 ﬁ ﬁ
{ Selection

— Optionz
[ Pritt on Qe Page ak. I Cancel
v Prink N Clar

" Frint Page Footers

The Print Dialog

Printer

The currently selected printer is shown at the top of the
dialog. You can change to a different printer using the drop
down list.

Selecting a Range to Print
The Print dialog provides three choices for the range of
pages to print.

e All causes all the pages that the drawing touches to
be printed.

e Selection causes all the pages that the selected
objects in the drawing touch to be printed.

e Pages, allows a range of the pages touched by the
whole drawing to be selected for printing.

Printing Multiple Copies

You can print more than one copy of your selected range of
pages, by entering the number of copies you want in the
Copies field.

SmartDraw User's Guide Viewing and Printing e 173



The Collate Copies checkbox determines the order in
which the copies of the pages of a drawing will be printed.

If the range selected requires only one page to print, this
setting has no effect.

If the range selected involves more than one page, then
checking the box will cause multiple copies to be printed so
that the pages are in collated order: page 1, 2, 3... followed
by page 1, 2, 3.... and so on.

Un-checking the box will cause all copies of page 1 to be
printed, followed by all copies of page 2 and so on. Non-
collated printing (where available) is often faster than
collated printing.

For printers that do not have enough memory to store a
whole page (like dot matrix printers) the Collate Copies
box is often checked and made inactive.

Print on One Page

Checking this box causes the entire drawing to be scaled
down and printed on a single page. This may result in
reduced legibility. This affects only the printed drawing,
and will not change the view of the drawing on your screen.

Print No Color

Checking this box causes the drawing to be printed in black
and white only. All borders, lines and text are made black,
and the background and shape fills are made white. This
often gives sharper results with non-color printers, and
requires much less printer memory than printing in color.

Print Page Footers

Checking this box causes a footer showing the name of the
drawing, the number of the page, and the current date and
time to be printed at the bottom of each page.

Define Footer

This button becomes visible when the Print Page Footer
box is checked. Pressing it brings the Define Footer Dialog
into view.
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Define Footer l
— Position;
-~ . These selections move ]9 I
" Battom+1/2 the footer up from the
¢ Bottoms 1/4" battamn of the printable Caricel I
S ey . area of the page in 1/4"
g zteps Help |

-~ Tupeface: Hint:

Changing the footer sethings
Fant... I affects all drawings, not just the
are pau are about ta prink.

The Define Footer Dialog

Changing the setting of the Position buttons changes the
position of the footer. The footer can be placed at the very
bottom of the printable area of the page, or 1/4 inch or 1/2
inch above the bottom.

Pressing the Font button displays the Windows Font
Dialog. This lets you choose the font, size and style for the
footer text. A point size of 10 or less is recommended.

Print To File
Checking this box causes the printed image to be stored in
a file on disk instead of being printed to the printer.
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Keyboard Navigation

Selecting with the Tab Key

If no objects in your drawing are selected, typing the Tab
key selects the first one. If one or more objects are already
selected, typing the Tab key moves the selection from the
current Target object (page 125) to the next object in the
drawing.

Twpe the Tab Key

| |
Selecting the next object with the Tab key

By typing the Tab key in this way, you can select each
object in the drawing one-by-one.

Typing a Shift-Tab reverses direction and selects the
previous object in the drawing.

The Tab Order

The order in which objects become selected as you type the
Tab key is called the Tab Order. It is the same as the front-
to-back order described on page 127.

It is also the order in which objects were created, unless
you use the Bring to Front or Send to Back commands to
change this order.
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Text Entry and the Tab Key

If you are entering text into a shape, typing the Tab key
selects the next shape in the tab order and opens it for text
editing. shift-Tab does the same in the reverse order.

You can use this feature to enter text in your shapes the
way you would fill in a form: Double-click on the first
shape and enter text. Then tab to the next shape, enter text,
tab again and so on.

If you are entering text into a table (page 106) the Tab key
moves you to the next text entry field in the table. Once
you reach the last table field, a tab takes you to the next
shape. The keyboard navigation in tables is smoothly
integrated into navigation between shapes.

You can enter a tab character into a shape by typing Ctrl-
alt-tab.

SmartDraw and Forms

The combination of SmartDraw’s table objects and the
ability to tab from shape to shape make it an ideal solution
for designing interactive forms that you can fill out on the
screen.

Another key to designing interactive forms is the ability to
prevent certain objects and fields within tables from being
edited. You don’t want the labels and other fixed text in a

form to be edited by someone filling it out. You also want

to avoid having these fixed objects selected for text editing
as you tab from field to field.

In tables you can eliminate cells from the tab order by
freezing them using the Do Not Allow Text Editing
command under the Table menu.

You can also freeze the text in shapes using the Text Entry
Properties command described on page 94.
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Using SmartDraw with Other
Programs

Copying and Pasting

You can exchange information between SmartDraw and
other programs using the clipboard and the standard Edit
commands, Cut, Copy and Paste.

The clipboard is a place that Windows temporarily stores
text, pictures and other data that have been Copied so that
they can be transferred to another document or program
with a Paste command.

When you are editing text, Copy, Cut and Paste act on the
text in the standard Windows way. When you are not
editing text entire images are transferred to and from the
clipboard.

Each of these commands has a button on the toolbar you
can use instead of the Edit menu.

Cut and Copy
The Copy command transfers all or part of the drawing to
the clipboard. Its behavior depends on what is selected.

When nothing is selected, a representation of the whole
drawing is copied to the clipboard (as a metafile). This
drawing can then be pasted into word processors and other
applications.

SmartDraw is an OLE Server. If another application
supports Object Linking and Embedding (OLE) as a
client, pasting the drawing also pastes a copy of the
SmartDraw file itself into the application, so that double-
clicking on the pasted drawing will open it up in
SmartDraw again. This is explained in more detail in Using
SmartDraw with Microsoft Office on page 193.
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When one or more shapes or lines are selected, the Copy
command copies just those shape and lines to the clipboard.
They can be pasted back into a SmartDraw drawing, or
pasted (as a picture) into another program.

Cut is a combination of Clear and Copy. It first copies any
selected objects to the clipboard, and then deletes them.

Paste

If the clipboard contains shapes or lines copied from
SmartDraw, using Paste adds these to the current drawing.
If the clipboard contains an image from another program it
is pasted into the drawing as an Image Object.

Image Objects

When images from other programs are imported or pasted
into SmartDraw they become Image Objects. These can be
thought of as rectangular shapes, initially with no border,
with the image inside.

An image object can be moved and arranged like any other
shape. Normally when you resize them they maintain their
proportions. However, if the Shift Key is held down while
the object is resized, you can resize it to any proportion.
Like other shapes, you can change an image object’s sizing
behavior using the Shape Sizing command (see page 63),
under the Shapes Menu.

When you try to type into image object, the text goes
beneath the object (as a linked background text object),
instead of inside.

Applying color and border changes to image objects either
adds a border, or changes the colors in the image,
depending on the Change Colors setting in the Shape
Sizing dialog. (See page 146.)

You can also ungroup most imported images into native
SmartDraw objects using the Ungroup command under the
Arrange menu. (See page 180).
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Importing Images From Other

Programs

You can import images from other programs into
SmartDraw using the Import command under the File
menu. This shows the Import Dialog. This is the same as
the Open Dialog and is used to select the file to be
imported.

Before you can import a file you must select the correct
type using the Files of Type control.

SmartDraw Standard supports import of files in Windows
Metafile format, and several bitmapped formats, including,
BMP, PC PaintBrush (PCX), GIF, JPG and TIFF.

. SmartDraw Professional imports a much wider variety of
Professional . .
formats including:

e Encapsulated Postscript (EPS)
e AutoCAD(DXF)

e CGM

e HPGL

e PDF

e Adobe lllustrator

e CorelDraw

e MicroGrafx Draw

e Visio

Once imported, images become Image Objects.

Ungrouping Imported Images

With the exception of the bitmapped formats (BMP, PCX,
GIF, JPG and TIFF), all image objects, whether imported
or pasted into SmartDraw, are stored in WMF (Windows
Metafile) format. You can ungroup these images into native
SmartDraw objects using the Ungroup command under the
Arrange menu.

When you use the Ungroup command on an image object
the Separate Drawing dialog is presented.

If, when you select a imported image, the Ungroup
command is gray and not available then your image is most
likely a bitmap and cannot be ungrouped.
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Separate Drawing

SmartDraw will zeparate thiz drawing into individual SmartDiraw objects.
To determing how thiz will done, choose the most appropriate default setting.

Caticel |

Defaults
[F Flawcharts and similar drawings ' Freehand and complex drawings | Help... |

— Settings
I Combine test into paragraphs.

Combine lines that are ISingIe 'I zpaced into the same paragraph.
[™ Place text inside existing shapes where possible.
[ Convert small shapes at the end of lines into arowheads.
¥ Separate segmented lines into individual line objects.

[ Separate curves and other zequences of lines inta many individual ohiects.

Separate Drawing Dialog

This dialog presents several options that control the way
the image will be separated into SmartDraw objects.

SmartDraw performs many advanced techniques to convert
crude metafile images into useful formats for flowcharting,
including joining shapes to the end of lines as arrowheads,
combining lines of text into paragraphs, placing text inside
shapes, and joining line segments together into one
segmented line. These techniques are based on empirical
rules and are not always perfect. If you have imported
images that do not convert well to flowcharts contact us
support@smartdraw.com. We are always working to
improve this process.

Defaults

Selecting the Flowcharts choice automatically selects the
optimal combination of the separation settings for
decomposing images of flowcharts. The Freehand choice
does the same for freehand drawings.

Combine text into paragraphs

Text in imported images is separated into single line
strings, where each string has one typeface. If this box is
checked SmartDraw will attempt to combine these strings
into one paragraph. The setting for single or double space
indicates how much space SmartDraw should allow
between lines before it terminates one text block and
creates another.
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Place text inside existing shapes

When this box is checked, the text blocks detected by
SmartDraw’s conversion process are placed inside any
shapes detected if they lie on top of each other. SmartDraw
will even detect the appropriate alignment of the text inside
the shape.

Convert small shapes at the end of lines into
arrowheads

With this box checked SmartDraw attempts to recognize
arrowheads at the end of lines.

Separate segmented lines into individual line
objects

With this box checked, SmartDraw will treat perpendicular
lines that could be represented as a single segmented line as
separate lines.

Separate curves and other sequences of lines into
individual objects.

Freehand drawings often have many complex curves. These
can be decomposed into hundreds (and sometimes
thousands) of SmartDraw lines, or left combined as a single
curved image. Checking this box forces their
decomposition into many short straight lines. This is
usually best left unchecked.

Opening Files Created with Other

Flowchart Programs

SmartDraw uses its ability to decompose metafiles into
useable flowcharts to convert files created with other
programs into SmartDraw format.

To convert a file from Visio into SmartDraw format, just
open the Visio file using the Open command under the file
menu. [Note! Your Visio file must be saved with a Detailed
Preview. Check this using the Properties command under
the Visio File menu.] Choose Visio for the file type in the
Open Dialog. The file opens and the Separate Drawing
dialog appears (page 180). The settings for conversion of
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flowcharts are already selected, but this gives you an
opportunity to adjust them if your drawing does not convert
well with the default settings. Press OK and the drawing is
converted to native SmartDraw shapes and lines.

With other programs likes Flowcharter, Flow Charting
PDQ, and others, your must first save your flowchart to
Windows Metafile format (WMF) using the program’s own
export or save command. Then you can open the WMF file
with SmartDraw.

Opening native Visio files requires SmartDraw
Professional. WMF files from Visio, and other flowchart
programs, can be opened with SmartDraw Standard.

SmartDraw File Conversion
Wizard

The SmartDraw File Conversion Wizard is designed to
make it easy for you to join the thousands of users who
have switched from another competing product to
SmartDraw.

It can be used to convert whole folders of files created with
Visio, ABC Flowcharter and other programs into
SmartDraw format.

To convert files Using the Wizard, the program you are
converting from must be installed on your system, because
the wizard uses that program as part of the conversion
process.

If you do not have a copy of Visio, you can still convert
Visio files to SmartDraw format using the Open command
(File menu), but the conversion may be limited. To use the
Open command, the files must have been saved from Visio
with a detailed preview. The Open method is also limited
in that it converts only one page of a multi-page Visio file.
The File Conversion Wizard, however, uses the installed
Visio program to convert all of the pages, and does so
without regard to the type of preview.

You open the File Conversion Wizard from the
SmartDraw File menu.
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SmantDraw File Conversion Wizard [ %] I

Corwvert vour files from Yisio and other programs to SmartDraw farmat by following the three Cloze |
zimple steps below.

—STEP 1: Choose the type of file you want to cornvert ™
Help |
[wisio (~.vsd) =l
MOTE: To use this Wizard pou must have Visio, or the program you want to convert fram,
installed on your systen.

“r'ou can convert Yisio and other files to SmartDraw format without having any other
oroarams installed on vour sustem using the Ooen command on the SmartDraw File Menw,

—STEP & Choose the file(z] you want to convert,
' Convert just one Yisio file
& Convert ALL the Yisio files in the folder:

|E:\My Documents

—STEP 3: Press the Convert Files Button to begin...

. Eachi file will be corverted into a SmartDiraw file with the same name in
Conert Files | the zame folder. Yisio files that have more than one pages will be

converted into a separate SmartDraw file for each page.

Files are converted into SmartCiraw fram their Windows . .
Metafile Images. Fine-tune this by pressing this button, Fine-Tuning... |

File Conversion Wizard

Converting your files requires just three steps.

STEP 1

First use the list control to select the type of file you want
to convert. Several popular formats are listed, but you can
choose Other to convert a format not listed. For any format
you choose, the source program must be present on your
computer, and this program must be an OLE server. The
Wizard will warn you if you choose a format that does not
meet these criteria.

STEP 2

Next choose the file or files that you want to convert. You
can choose to convert all of the files of the type you have
selected that reside in particular file folder, or just one file.
Before you choose to convert all the files in a folder you
might want to convert one of them as a test.

STEP 3

Start the conversion process. As the Wizard converts your
files you may see activity from the application that created
the files and SmartDraw itself. It typically takes between 10
and 60 seconds to convert each file. The converted files are
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Professional

stored in the same folder as the original files with the same
name, but different file type. For example, if you have a
Visio file:
C:\MyDrawings\flowchart.vsd
The Wizard will create a corresponding SmartDraw file:
C:\MyDrawings\flowchart.sdr

If the Visio file has multiple pages the Wizard will create a
SmartDraw file for each page:

C:\MyDrawings\flowchart-Pagel.sdr
C:\MyDrawings\flowchart-Page2.sdr

Fine Tuning

The Wizard extracts a Windows metafile from each file to
be converted. Then it decomposes the metafile into native
SmartDraw objects. By default, the settings for this
decomposition are optimized for converting flowcharts,
organization charts and similar diagrams. You can adjust
these settings by pressing the Fine Tuning button in the
Wizard dialog to display the Separate Drawings dialog
described on page 180.

Exporting Drawings

You can export SmartDraw drawings in several standard
Windows file formats using the Export command under
the File menu. This presents the Export Dialog, which is
used to specify the name of the exported file and its format.
This is similar to the Save Dialog.

Use the Files of Type control to change the format of the
exported file.

SmartDraw Standard supports export of files in Windows
Metafile, and several bitmapped formats, including, BMP,
PC PaintBrush (PCX), GIF, JPG, TIFF and HTML.

SmartDraw Professional exports a much wider variety of
formats including:
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Encapsulated Postscript (EPS)
AutoCAD(DXF)

CGM

HPGL

PDF

Adobe Illustrator

MicroGrafx Draw

Exporting to Bitmapped Files
SmartDraw exports to several bitmapped file formats
including BMP, TIFF, GIF, JPG and PCX. All of these
formats represent an image as a pattern of colored dots,
called a bitmap.

Bitmaps are commonly used as image formats on web
pages, but otherwise are not the best format for transferring
SmartDraw drawings to other programs. The Windows
Metafile format is almost universally shared among
Windows programs and is a much better choice. Metafiles
are scaleable. They retain their sharpness when they are
scaled or printed. Bitmaps are very large and memory
intensive. They also do not scale well.

The number of dots used to represent each inch of an image
is called its resolution. The number of different colors that
each dot can represent is called its color depth. The higher
the resolution and color depth of a bitmap, the better it
looks, but the more memory and disk space it occupies.

When creating a bitmap, there is always a trade-off
between resolution and color depth, and memory
requirements. SmartDraw lets you control this trade-off
when you export to a bitmapped file format by displaying
the Export Bitmap Dialog.
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Export Windows Bitmap

Select the zize pou want for your exported image:

Urits widk Height
It pigels [or dots] 285 142 Back <<

Inches on the zoreen (at 100 dpi) 280 1.42 Hel

Inches on the printer at |EEIEI dpiﬂ |D.4? |EI.24

Arnount of memony [Bakd] required to export: 316 Kb

b &irnurn Mumber of Colors:

Select the maximumn number of calars pouw want to allow in pour exparted image.
The more colors you choose the more memaony your image will use.

If wour drawing uses more colors than the number vou chooze, the colors will be
changed to reduce the number used,

Some export formats restict the number of colors pou can chooze.

Select the masimum number of colors; (16777216 =

Export Bitmap Dialog

The Export Bitmap Dialog lets you specify the width and
height of the bitmap you are about to export, in dots, screen
inches and printer inches. It also lets you specify the
number of colors that each dot can represent (the color
depth).

Your entire SmartDraw drawing is always scaled to fit the
size of the bitmap you choose. The size you choose should
always be the size you want it to be in the application that
will use it, so that you don’t have to scale the bitmap after it
is exported. (Bitmaps scale poorly.)

For example, if you are exporting your drawing to a GIF to
use as part of a web page, and you want the resulting image
to be 400 dots (or pixels) across, then enter 400 in the first
row of the Width Column. The other width and height
values will all change to reflect this width. The height
changes because the proportions of your drawing are
always maintained.

Selecting the Maximum Colors drop-down list selects the
color depth for your exported bitmap. Some bitmapped
formats do not allow all color depths. For example, GIF’s
always have a color depth of 256.

The memory required for your export is also shown in the
dialog, If this number exceeds 32,000 most systems will
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not be able to export the bitmap. If you have trouble
exporting large bitmaps, try shutting down other programs
to free up additional memory.

Exporting Images to Web Pages
SmartDraw exports directly to HTML format. Do this by
selecting HTML from the list of formats in the Export
Dialog.

SmartDraw then displays the Export HTML Dialog.

Export HTML

Select the zize pou want for your exported image:

Unitz it Height i
I pizels [or dats) 100 i Back <<
Inches on the screen [at 100 dpi) 1.00 0.50 Help
Inches on the printer at |EEIEI dpi ﬂ |D.1 7 |EI.I:I8

Amount of memary [Rék] required to export; 8 Kb

b awirurn Mumber of Colors:

Select the maximum number of colors pou want to allow in pour exported image.
The more colore you chooze the more memony your image will use.

IF wour drawing wzes more colors than the number you chooze, the colors will be
changed to reduce the number uzed.

Some export formats restrict the number of colars pou can chooze.

Select the maximum number of colors: | 256 - Transparent?...

HTHL Options:
Export Image as: ¢ JPG & GIF [Set tranparency options with button above]

v Include hyperinks

The HTML Export Dialog

This is similar to the Bitmap Export Dialog, described on
page 186, but with an extra panel for HTML options.
Controls in the panel allow you to choose either a GIF or
JPG as the image file format.

When SmartDraw exports to an HTML file it also includes
a GIF or a JPG file with the same name followed by _img.

For example, if you export to Flowchart.htm, a bitmapped
file called Flowchart_img.gif (or jpg) is also created. You
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must upload both files to your web server in order to view
the exported image in a web browser.

When exporting to a GIF you can specify a background
color that will become transparent when viewed with most
web browsers. You can also choose whether the exported
file should be in interlaced or non-interlaced format.
Interlaced images display more quickly than non-
interlaced, but take longer to come into focus.

These options are specified in the GIF Format Options
Dialog. This is displayed when GIF format is selected and
you press the Transparent button in the HTML export
dialog.

GIF Format Options

You may expart to a GIF file with the following options. Ok
These will affect the way the image iz dizplayed by w'orld
Wide \Web Browsers. Cancel

Help

adil

Tranzsparency

& Treat the curent background caolor as ransparent

bdary web browsers will replace your drawing's background color
with the background colar of pour web page.

" Make all colors opaque.
'our drawing's background will always retain its own caolar.

|nterlacing

* |ze interlaced format
YWhen they are downloaded, these images initially appear fuzzy
and then come inta focus.,

" Uze non-interlaced format
These images are always in focus and display sequentially from the
top az they download.

GIF Format Options Dialog

Including Hyperlinks

SmartDraw allows you to attach hyperlinks to any shape in
your drawing. This is explained in more detail in
Hyperlinking to Files and Web Pages.

If your drawing contains these hyperlinks, you can check
the Include Hyperlinks checkbox when you export to
HTML and preserve them in the web page generated. If
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you select this option, clicking on the shapes with
hyperlinks in the web page will have the same effect as
clicking on the shapes in SmartDraw.

Using this feature of SmartDraw’s HTML export makes
generating HTML click-maps a breeze.

Hyperlinking to Files and Web

Pages

One of the more powerful features of SmartDraw is its
ability to hyperlink any shape to another SmartDraw
drawing file, a web address (URL), another application’s
document, or even a program command line, using the
Hyperlink commands under the Tools menu.

To create a hyperlink, you first select an object in the
drawing, and then select the Create a Link command
under the Hyperlink submenu. This shows the Create a
hyperlink dialog.

Create a Hyperlink
Mame of Link

Type in the name of a document, web site, or a program and
SmarntDraw will open it when you double click on the zhape that you

selected.
bt/ e,
Tuvpe of Link Hint
. Tepe in the web address you want this
. Sm Draw Lrzirg object to link to.

If wour browser iz confiqured correctly, it
~ will automatically open this page.
D ocumert Y'eh Page links are preserved when

yaou expart ko HTHL.

Cancel

~
Program Help

Ble

Hyperlink Dialog
Here you can choose to link another SmartDraw drawing, a
web address, a document, or a program to the currently
selected object.

You enter the file name, the web URL, or the program
command line of the file that you want to link to. You can
also use the Browse button to search for a particular file.
This presents the standard Open dialog.
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Once you select a file, or address, it is hyperlinked to the
currently selected object.

From this point on, if you select this object and use the
Open Link command (type the F11 Key as a short cut), the
linked file, or web address, will be opened. You can break
this link by selecting the object and using the Clear Link
command.

You can only use the Open Link and Create a Link
commands when a single object is selected. You can use
the Clear Link command when more than one object is
selected. The hyperlinks will be cleared from all selected
objects.

Shapes and lines that have hyperlinks are shown with a
special symbol that consists of a plus sign inside a small
box.

Thiz rectangle has
an attached drawin

The Hyperlink Symbol

Double clicking on this symbol opens the linked file or
URL.

Using Hyperlinks

Nested Drawings
You can use hyperlinking to create hierarchical or “nested”
drawings that let you drill down to more detail.

For example, suppose you are creating a flowchart for a
process that includes one very complex step. On your
summary (or high-level) flowchart, you can represent the
complex step by a single shape and then hyperlink the
shape to a detailed flowchart illustrating the complex
process. Later, if you double-click on the hyperlinked
symbol in the summary chart, the detailed chart represented
by the shape opens up.
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Web Site Mapping

The ability to hyperlink a shape to a web page URL makes
SmartDraw a very useful tool for a drawing a flowchart that
documents a web site. Each page may be represented by a
symbol that is actually hyperlinked to the page itself.

When you export to HTML, you can preserve these links.

Notes and Background Information

You can attach a page or more of notes to any shape in a
drawing by hyperlinking it to a word-processing document.
You can also attach a help file or a web address. For
example, in a network diagram you can attach the web
address of the manufacturer of the piece of hardware
represented by a symbol.
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Using SmartDraw with
Microsoft Office

While SmartDraw can exchange drawings with most
Windows programs, it is designed to work especially
closely with Microsoft Office.

Transferring Drawings from
SmartDraw to Office.

Copy and Paste

The easiest way to transfer drawings you create in
SmartDraw to Microsoft Word (and the other Office
programs) is to simply copy all or part of the drawing in
SmartDraw and then paste it into Word.

OLE (Object Linking and Embedding)

Because Word is an OLE Client and SmartDraw is an OLE
Server, Word stores all of the SmartDraw drawing
information in its document when you paste, not just the
picture you see. This is called Embedding. A copy of your
SmartDraw drawing is embedded in the Word document.

If you double-click on the SmartDraw drawing in Word it
will re-open in SmartDraw and you can to edit it.

Another way of transferring a SmartDraw drawing to Word
is to paste an OLE Link using Word’s Paste Special
command (page 197). If you choose to paste a link, using
this dialog, the picture you see is transferred to Word along
with the name of the SmartDraw file it came from.

If you double-click on the linked SmartDraw drawing in
Word it opens the original SmartDraw file allowing you to
edit it, just as with an embedded drawing. OLE Linking is
useful if you want just one copy of your drawing to be
shared between several documents. When you embed a
drawing, changing the embedded copy does not change any
other copy. When you paste an OLE link, changing the one
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linked drawing changes all the linked copies of that same
drawing.

Drag and Drop

You can also drag selected parts of a drawing from
SmartDraw into Word and other office programs. Unless
you hold down the Ctrl key while you do this, the selection
will be deleted from the drawing after it is transferred to
Word. This conforms to the standard Windows interface for
drag and drop between applications.

Inserting a SmartDraw Object

into Word

. You need not actually run SmartDraw at all in order to
insert a SmartDraw drawing into a Word document. Word
has an Object command on its Insert menu. You can use
this command to insert a SmartDraw drawing directly into
your document. You can insert a new drawing or an
existing one. The details of this are described on page 197
and in Word’s own documentation.

When you insert a new document, the last type you picked
from the New Drawing dialog is created by default.

Transferring Objects from Office

to SmartDraw

In addition to being an OLE server, the Professional edition
of SmartDraw is also an OLE Client, like Word,
PowerPoint and Excel.

This means that when you paste images from other
programs that are OLE servers into SmartDraw, they
become embedded or linked OLE objects that can be re-
opened and edited by their parent programs.

For example, if you paste a graph from Excel into a
SmartDraw drawing, both the image of the graph and the
underlying Excel file structure are stored in the embedded
drawings. Double clicking on the graph in SmartDraw
opens it again in Excel, for editing.
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The images you paste from Office behave just like library
symbols in SmartDraw. You can link lines to them, flip
them, rotate them, and resize them. They also have the very
special property that you can open them in Office, simply
by double clicking on them in SmartDraw, and modify
them.

Perhaps most important of all, you can add OLE objects to
libraries, and they retain their OLE object nature.
SmartDraw Professional supports libraries not only of
symbols, but also of live objects that can be opened in other
applications! This is the basis for the Office Companion.

Microsoft Office Companion

With SmartDraw Professional and Microsoft Office you
can add real graphs, bitmaps, equations, spreadsheets and
all of the Office clipart to your SmartDraw drawings with
just one click.

If Microsoft Office is installed on your computer,
SmartDraw Professional shows a special set of toolbar
buttons on the right end of the top toolbar.

22 | 35| (2] v | #1| #9

Office Companion Toolbar

If you click on one of these buttons you can add any of the
following objects your drawing.

Bitmap (Paint)

Graph (MS Graph)

WordArt (MS WordArt)

Clipart (Clipart Gallery)

Equation (MS Equation)
Spreadsheet (Excel)

Word processing document (Word)

If any of these applications are not installed on your
system, their buttons do not appear.

When you click on the Bitmap button the Windows Paint
application is launched. The image your draw will appear
in your drawing when you close Paint. A similar thing
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occurs when you press the Equation, Spreadsheet and
Word Processor button.

Pressing the Clipart button shows the Office Clipart
Gallery. By using this button the thousands of images that
are included with Office become SmartDraw symbols too.

Pressing the Graph or WordArt buttons shows the
Gallery Dialog. Here you can choose from a collection of
symbol libraries containing pre-formatted Graphs or
WordArt examples.

Select Object Gallery

Select a Gallery: Preview

Area Charts [20) -
Area Chartz [30) ]
Bar Chartz [20]

Bar Charts [3D]

Calurnn Charts [20]
Colurnn Chartz [3D]
Cormbination Charts

&=
Cie Ehats (20) - S

Line Chartz [3D]

Hint:
Select a library of objectz by clicking in the list above. Click,
the Open button to open it,
To add one of the objects in the library to pour drawing just Cancel
drag it there with the mouse.
To edit the object, just double-click it with the mouse. Help

Mew Dbject Create a new emphy object.

Object Gallery Dialog

Selecting a library from the list displays its preview on the
right. If you open one of these libraries, you can drag one
of the sample objects into your drawing and then open it by
double clicking or using the object menu commands (page
198).

Adding Objects with Paste and

Paste Special

In addition to using the Office Companion toolbar buttons,
you can also Paste an object from Office, or other OLE
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Server applications, into the Professional Edition of
SmartDraw. When you do this, SmartDraw makes its own
copy of the application file and stores it in the drawing.
This is called embedding.

When you paste using the Paste Special command you can
choose between several different ways of pasting. The
command shows the Paste Special Dialog.

Pazte Special

Source: SheetlIR1CT:ABC2
A Cancel

) Past |
Easte e
" Paste Link [~ Display As lcon

Result
Ingerts the contents of the clipboard inko pour

P B document o that you may activate it using
E Microzoft Excel 97,

Paste Special Dialog

The dialog shows a list of formats. When you select the
first format at the top of the list, depending on the program
you copied from, you may be offered the choice of Paste or
Paste Link. Pasting a Link pastes the picture plus the
name of the file it came from. Then, whenever you change
the contents of this linked file, SmartDraw will update the
picture to the newest version.

Choosing the second item in the list (Picture) does not give
you the choice of Paste Link and normal pasting just
transfers an image into SmartDraw without the underlying
data. If you paste just an image and then change the
original file you copied from, you’ll need to paste it into
SmartDraw again to get the revised image.

Inserting Objects

You can also add OLE objects to SmartDraw with the
Insert Object command under the Edit menu. This shows
the Insert Object Dialog.

SmartDraw User's Guide

Using SmartDraw with Microsoft Office e 197



Inzert Object EHE

Object Twpe: OE I

& Create Mew Microsoft Clip Galleny =]
Microsoft Draw 97 Drawing &I

| Create from File  |Mictasoft Drawing 1 (1]
iicrozalt Equation 3.0 Help |
ticrozoft Excel Chart
ticrozoft Excel ‘Worksheet I Display s |
ticrozoft Graph 37 Chart LIEpIEY As lEon
Micrasoft Photo Editor 3.0 Phato ]

Result

Ihizertz a niew Microzoft Equation 3.0 object into

s
wour document,

Insert Object Dialog (Create New)
When the Create New radio button is selected, the list
shows all of the object types installed on your system. To
create a new object just select one of the items in the list
and press OK.

When the Create from File button is selected the dialog
changes to the form shown below

Ingert Object

ok, |
' Create Mew '
Fle: Cancel |
¥ Create from File D:ASDrawd
Help |

™ Link

™ Dizplay &3 lcon

Fesult
|nzerts the contents of the file az an abject into

P M your document so that you may activate it using
E the program which created it

Insert Object Dialog (Create from File)

This allows you to pick an existing file and create an
embedded or linked object from it.

Editing OLE Objects

When an OLE object is selected, the bottom item of the
SmartDraw Edit menu changes to a submenu showing the
name of the object.
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You can use the commands on this menu to Open the
object for editing. You can also double-click on the object
itself to open it for editing.

Managing Links

When an OLE Linked object is selected, the Links
command under the Edit menu presents the Links Dialog.
You can use this to manage links in your document.

Links 2]

Links: Type Update Cancel |

C:h . ABook3xlzlSheetlIRTCT:RBCE  “Worksheet Automnatic

Update Mow |
Open Source |

Break Link |

Source: LWy DocumentsiB ook 3 xls!SheatlIR1C1:RAEC2
Type: Microsoft Excel Warksheet

Update: & Automatic " Marwal Help |

The Links Dialog
The list shows all of the linked OLE objects in your
drawing. You can change the parameters of the selected
object in the list using the buttons on the right.

Open Source opens the file associated with the link.
Change Source lets your fix a link that has been broken
because the file moved.

Update Now causes SmartDraw to get the current image
from the linked file. Break Link breaks the OLE link,
making the object a simple image object that no longer
updates.
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Text Tools

Professional

Spelling Correction

The Professional version of SmartDraw can check the
spelling of the text you enter while you are typing. If you
misspell a word, it is underlined with a wavy red line.

Ilary had a litle
lambn

Misspelled words are underlined with red wavy lines.
Right clicking (clicking with the right mouse button) on the
misspelled word shows a menu with alternative spellings
and other commands.

Iflary ha_d alitle
ml“lﬂ

NN lamb

larnbz
larm
lambent
larbda
larmp

| grore All
Add

Auta Corect »
Speling...

Right-clicking on a misspelled word.

If you select one of the alternative spellings, the word is
replaced with this selection. The other commands:

e Ignore All. Ignores the word for this session.

e Add. Adds the word to your user dictionary, so that
it is considered correct in all future sessions.

e Auto Correct. Adds the word to your user
dictionary along with the misspelling, so that if you
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use that misspelling again, SmartDraw will correct
it for you automatically.

e Spelling. This shows the Check Spelling dialog.

To prevent SmartDraw from checking your spelling as you
type, turn off the Check Spelling While You Type
command under the Tools menu. You can use the same
command to turn it back on again. On slower computers,
turning off spelling correction while you type will speed up
text editing.

The Check-Spelling Dialog

You can check the spelling of an entire document (or just
the selected text or shapes) interactively using the Check-
Spelling Dialog.

When you use this command to check spelling
interactively, either the selected range of text, or the
selected object(s), are checked first. You are then given the
opportunity to continue correct spelling in the rest of the
document.

Check Spelling

Mat in Dictianary: [lambn " Lock Pos.
Change To: IIamI:u
Suggestions: larmb - A Ignore Al |
lambs
lamn LChange I Change &)l |
lambent &
Add I Suggest |
Add words to: querdic.tl:-t j [ de I Cancel |
Dictionaries... | Dptiong. .. | Help... |

The Check-Spelling Dialog
The Check Spelling Dialog has the following controls

Add

This causes the reported word to be added to the dictionary
currently selected in the Add Words To list. Use the Add
button if a correctly spelled word you use often is reported
as a misspelling (e.g., your family name). If the word is not
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used frequently, you may want to select the Ignore or
Ignore All buttons instead.

Add Words To

This indicates which user dictionary words will be added to
when you select the Add button. The Add Words To list
shows all user dictionaries currently open. You can open or
close other dictionaries via the Dictionaries dialog, which
is accessible by selecting the Dictionaries button.

Cancel
Stops the current spell-checking operation.

Change

Causes the reported word to be replaced with the word in
the Change To box. Only this occurrence of the reported
word is replaced. If you want this and all following
occurrences of the word replaced, select the Change All
button. If the Change To box is empty, such as when a
repeated word is reported, the Change button changes to
Delete.

Change All

Causes this and all following occurrences of the reported
word to be replaced with the word in the Change To box.
If you want only this occurrence of the word to be replaced,
use the Change button. If the reported word is one you
frequently misspell, you might consider adding it to a user
dictionary via the Dictionaries dialog. You can display the
Dictionaries dialog by selecting the Dictionaries button.

Change To

Contains a word that will replace a misspelled word when
you select the Change or Change All buttons. You can
enter a word in the Change To box by typing, or you can
select one of the suggested replacements from the
Suggestions list.
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Consider Changing

Contains a word that may be misspelled or otherwise
incorrect, and is presented with a candidate replacement
word. You can change the word by selecting the Change
button, or skip it by selecting the Ignore button. Note that
the label of this box changes to “Not in dictionary” when a
misspelled word is detected.

Dictionaries

Causes the Dictionaries dialog to be displayed. You can
use the Dictionaries dialog to open or close user
dictionaries, and to edit the contents of user dictionaries.

Ignore

Causes this occurrence of a misspelled word to be skipped.
If the same misspelled word appears later, it will be
reported.

Ignore All

Causes this and all further occurrences of this misspelled
word to be skipped. You might use this button if the word
reported as a misspelling is actually spelled correctly. If the
word is one you use frequently, you may wish add it to
your dictionary by selecting the Add button.

Lock Pos

Locks the position of the Check-Spelling dialog in place.
Normally the Check-Spelling dialog attempts to position
itself to avoid the window containing the text being
checked. When the Lock check-box is checked, the Check-
Spelling dialog will always appear at the last place you
positioned it.

Not in dictionary

Indicates that a misspelled word was detected. The word is
considered misspelled because it could not be located in
any open dictionaries. Note that the label of this box
changes to “Consider changing” when a word and a
suggested replacement are displayed.

SmartDraw User's Guide

Text Tools e 203



Options
Causes the Options dialog to be displayed. You can use the
Options dialog to set spelling-checker options.

Suggest

Search more thoroughly for suggested replacements for the
current misspelled word. Each time you press the Suggest
button, a "deeper" search is made. The Suggest button is
disabled once all possible suggestions have been located.

Suggestions

Contains a list of suggested replacements for the misspelled
word reported as misspelled. This list is filled in
automatically when a misspelled word is detected.
Subsequent presses of the Suggest button may yield more
suggestions. A word selected in this list will be
automatically copied to the Change To box, where it can
be substituted for the misspelled word by pressing the
Change button.

Undo button
Removes the last change made.

Selecting a Spelling Language
The Spelling Language submenu, under the Tools menu,
lets you switch languages with a single menu command.
Each language supported is shown on the submenu. The
currently selected one is shown with a check mark. The
language selection applies to SmartDraw as a whole, not
just the document that you are working on. SmartDraw
supports the following languages.

American English
British English
Brazilian Portuguese
Danish

Dutch

Finnish

French

German
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Norwegian

Italian

Spanish

Swedish

These dictionaries are available on the SmartDraw CD, or

via download from
http://www.smartdraw.com/dictionaries.htm.

Dictionary Organization

The language dictionaries are stored in the Spelling folder
inside the SmartDraw program folder. Each language has
its own folder inside the Spelling folder. All users on a
network share these dictionaries.

The custom dictionaries that users edit are stored in a folder
inside their Windows folder called SmartDraw. Each user
on a network has his or her own custom dictionaries.

The Dictionary Dialog

Pressing the Dictionaries button in the Check-Spelling
dialog, or using the Spelling Dictionaries command under
the Tools menu, opens the Dictionary Dialog. This allows
you to manage your own custom dictionaries, where your
own private words (like your name, special acronyms, etc.)
are stored.

The Dictionaries Dialog allows you to open and close user
dictionaries, and to edit the contents of an open user
dictionary. The contents of dictionaries are saved in disk
files. You can open some or all of your user dictionary files
at any time. Only open dictionaries are consulted during a
spell-checking operation.

SmartDraw User's Guide Text Tools e 205



Dictionaries

Wwiards: Other word:

ISmartDlaw

Beddington a

Mepean Add Word | [mport... |
S5CE =]  Dektewod | Expor.
Actioh:

I.-’-‘«uto change [uze caze of other word)

Files: Ascld File

Iuserdic.tlx j

Language: Amenican Englizkh

Hewa File...

Ik .

Bemowe File

Help | Cloze I

The Dictionaries Dialog
The Dictionary Dialog has the following controls:

Words
This contains the list of words in the currently selected user
dictionary, as well as the currently selected word.

Other Word

This contains an alternate word associated with the
currently selected word. The other word is used in the Auto
change and Conditionally change actions to supply a
replacement word. You can enter more than one word in
the Other Word box, but the total length should be limited
to 63 characters.

Action

The action tells the spelling checker what to do when it
finds a word in the dictionary. The following actions can be
selected:

Auto change (use case of checked word)

This action allows you to automatically replace one word
with another. For example, if you often type recieve instead
of receive, you might enter the word recieve with receive
as the other word and Auto change (use case of checked
word) as the action. The spelling checker will then
automatically correct recieve wherever it appears. If recieve
were capitalized (Recieve) the spelling checker would
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automatically replace it with Receive. Note that the
replacement is made automatically only if the Auto
Change option is enabled (see the Spelling Options
Dialog for information on the Auto Change option).

Auto change (use case of other word)

This action allows you to automatically replace one word
with another, without considering the case of the replaced
word. This action is useful for automatically expanding
abbreviations. For example, you could enter the word TBD
with to be determined as the other word and Auto change
(use case of other word) as the action. The spelling
checker will automatically replace TBD with to be
determined wherever it appears.

Conditionally change (use case of checked word)

This action is the same as Auto change (use case of
checked word) above, except that the replacement is only
suggested by the Check-Spelling dialog. It does not
happen automatically.

Conditionally change (use case of other word)
This too is like Auto change (use case of other word) but
is only suggested by the Check-Spelling dialog.

Exclude (treat as misspelled)

This action tells the spelling checker that the word is
misspelled, even if it is listed in another dictionary. Words
marked with this action will never be offered as
suggestions for misspelled words, and they will be reported
as misspellings when they are encountered by the spelling
checker. Note that the spelling checker looks up words in
user dictionaries in the order in which the dictionary files
appear in the Files list. If you want to exclude a word, make
sure it doesn't appear in a previous user dictionary.

Ignore (skip)

This action tells the spelling checker that the word is
spelled correctly, and can be skipped over. This is the most
common action.

Add Word

This causes the word entered in the edit area of the Words
list to be added to the currently selected dictionary. The
currently selected action and other word are associated with
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the word. You can use the Add Word button to change the
action or other word associated with a word. Note that the
Add Word button is enabled only when a new word is
typed in the edit area of the Words list. The words you add
may contain virtually any character, but only words which
contain embedded periods should have trailing periods
(e.g., U.S.A.is OK, but USA. is not).

Delete Word

This causes the word appearing in the edit area of the
Wordes list to be removed from the currently selected
dictionary. The associated action and other word are also
removed.

Files

This contains the list of open dictionary files. When you
select a dictionary file from the list, its contents are
displayed in the Words list.

Add File

This opens a user dictionary file. When you select the Add
File button, a dialog appears which you can use to select
the dictionary file to open. The set of open dictionary files
is remembered, so once you add a dictionary file you don't
need to add it again. If you need to create a new user
dictionary, use the New button. You can open other
applications' user dictionary files, including those of
Microsoft Office.

Your Office user dictionary is usually called custom.dic.
Search for this file and add it to the file list and you can
share a common list of your personal words with
SmartDraw.

Remove File

This closes the currently selected dictionary file. Closed
dictionaries are not checked during a spelling check.
Although the file is closed, it is not deleted. Closed
dictionary files can be later reopened using the Add File
button.
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New

This creates a new user dictionary file. When you select the
New button, a dialog appears which you can use to specify
attributes of the new dictionary.

Export

This saves the contents of the currently selected dictionary
to a text file. When you select the Export button, a dialog
appears which you can use to select the name of the text
file to which words in the dictionary will be exported. The
words are written to the file one per line.

Import

This adds the words contained within a text file to the
currently selected dictionary. When you select the Import
button, a dialog appears which you can use to select the text
file to be imported. Each word in the selected file is loaded
into the dictionary.

Language
This displays the language (e.g., English, or French, etc.) of
the words in the currently selected dictionary.

Spelling Options

The Spelling Options command opens the Spelling
Options Dialog. This lets you specify several options that
affect the way the spelling checker operates.
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Options |

[ Ignare capitalized wards [e.q.. Canadal

[ Ignore all-caps words [e.q., ASAP]

[ Ignare words with numbers [e.qg.. Wings]

[ Ignaore words with mized caze [e.g., SuperBaze]
¥ Feport doubled words [e.q., the the)

¥ Caze sensitive

[T Phoretic suggestions

¥ Tupographical suggestions

¥ Suggest split words

¥ Auto comect

Suggestions
% Fazt but less accurate

i~ Moderately fast and accurate
™ Slow but accurate

Cancel |

Spelling Options Dialog

Ignore Capitalized Words

When enabled, any words beginning with a capital letter
are ignored (i.e., are skipped over without being checked).
You might enable this option if the text being checked
contains many proper names.

Ignore All-Caps Words

When enabled, any words consisting entirely of capital
letters are ignored. You might enable this option if the text
being checked contains many acronyms.

Ignore Words with Numbers
When enabled, any words containing embedded digits are
ignored. Examples of such words include Win95 and Q4.

Ignore Words with Mixed Case

When enabled, any words containing an unusual mixture of
upper- and lower-case letters are ignored. Examples of such
words include SmartDraw and CapsLock.
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Report Doubled Words
When enabled, any word appearing twice in a row is
reported via the Check Spelling Dialog.

Case Sensitive

When enabled, a distinction is made between capitalized
and non-capitalized words. For example, canada is
considered different from Canada, so canada would be
reported as a misspelling. When the option is disabled,
canada and Canada are considered identical. Note that the
performance of the spelling checker will be reduced if this
option is disabled.

Phonetic Suggestions

When enabled, suggestions are made on the basis of
phonetic (sounds-like) similarity to the misspelled word.
This option tends to improve suggestions for badly
misspelled words. Enabling this option will increase the
time required to locate suggestions. Note that either this
option or the Typographical Suggestions option must be
enabled or no suggestions will be offered.

Typographical Suggestions

When enabled, suggestions are made on the basis of
typographical (looks-like) similarity to the misspelled
word. This option is appropriate for people who are
generally good spellers. Note that either this option or the
Phonetic Suggestions option must be enabled or no
suggestions will be offered.

Suggest Split Word

When enabled, two separate words will be suggested as a
replacement for a misspelling containing two joined words.
For example, is the would be suggested as a replacement
for isthe.

Auto Correct
When enabled, words marked with Auto Change actions
will automatically be changed to their specified
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Professional

replacements. When disabled, you will be prompted before
the words are changed.

Suggestions

Determines the speed and accuracy of the initial search for
suggested replacements for misspelled words. When a
misspelled word is detected, a search is automatically made
for suggestions. This option controls the speed and
accuracy of this automatic search. Pressing the Suggest
button in the Check-Spelling dialog causes an increasingly
more accurate (but slower) search for suggestions, with
each successive click.

Find and Replace

Using the Professional version of SmartDraw, you can find
and replace any word in your drawing.

The Find command, under the Edit menu, shows the Find
and Replace Dialog.

Find and Replace

FindWhat  |Mand Find Next

Beplace »»
™ Match whole word only " Match case Close
Ilary had a little
lamb

Find and Replace Dialog

You can enter any target string into this dialog. If you press
the Find Next button, SmartDraw will search for a match.
Once a match is found, it is highlighted and scrolled into
view. Pressing Find Next again, finds the next occurrence.

Initially only the selected range is searched. This is either
the selected range of text within a shape, or the selected
shape(s) or table. Once all selected instances of the target
word have been examined, you are then given an
opportunity to search the remainder of the drawing.

Normally SmartDraw searches for the target string without
regard to upper or lower case, and it will report matches
that are not whole words. For example, if you search for
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mary it will find Maryanne. You can change this behavior
by checking the checkboxes in the dialog.

Match case causes SmartDraw to find matches only when
the case of the characters in the drawing also match the
target.

Match whole word only causes SmartDraw to ignore
matches when the target appears as part of another word.

Replacing Words

If you click on the Replace button in the Find and Replace
Dialog, or select the Replace command under the Edit
Menu, the dialog opens out to its expanded form.

Find and Replace

Findwhat:  [Many Find Mext

Feplace Yith: |J ohn

[ Match whale word only [ Match case Feplace Al
Close

Ilary had a httle
latrh

Expanded Find and Replace Dialog

If the target string is highlighted in a shape, pressing the
Replace button will replace the target with the replacement
string and then go on to find the next match. Pressing
Replace again replaces the next match and so on.

You can replace all instances (initially in your selected
range and then in the entire document) automatically by
pressing the Replace All button.

“Find Next” Menu Command

After you close the dialog, your target and replacement
strings (and checkbox settings) are remembered (even
between sessions). You can find the next instance of the
current target string at any time without showing the Find
and Replace Dialog, by using the Find Next command
under the Edit Menu.
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The shortcut to the Find Next command is the F3 key.
Holding the shift key down and typing F3 finds the
previous match. The search order is the same as the tabbing
order in the drawing (See page 176).
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Customizing SmartDraw

New Drawing Buttons

The buttons shown on the New Drawing Dialog (page 18)
are actually read from the SmartDraw program folder at run
time. This means that you can add your own drawing types
and templates, and create your own custom buttons for
them.

Each drawing type that shows as a button in the New
Drawing Dialog represents a folder inside the Templates
folder, which is inside the SmartDraw program folder. For
example, the Flowcharts drawing type has a folder
Templates/Business & Charting/Flowcharts.

A drawing type folder must contain the following files to
show up as a button on the New Drawing dialog:

e Anicon.bmp file
e At least one template file

The icon.bmp file is a 60x60 bitmapped image in BMP
format that will show up as the picture on the button for the
new category. If you don’t put this file into your folder, it
will not show up as a button.

If you want part of your icon to be the color of the button,
use the gray (0x0c0c0c) as a transparent color.

The position of a button in the dialog is controlled by the
presence of a file whose name has the format nnn.ord,
where nnn is a weighting (or ranking) number. For
example, 500.ord will give your new drawing type a
weight of 500 when SmartDraw sorts the buttons in the
dialog from the top left. Changing the number in front of
the ord extension lets you choose the position of the button
in the dialog. This applies to existing drawing types too!

There must be at least one SmartDraw template in the
folder. If your template is called EMPTY.SDT it will be
opened when you press Create Blank Drawing at the New
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Drawing dialog. It is the “default” template for this
drawing type.

If you have no other templates in the folder, then the View
Templates button in the dialog will be gray and
unavailable. If you have other templates but no
EMPTY.SDT then the Create Blank Drawing button will
be unavailable and you will be forced to select a template.

Creating SmartDraw Templates

Creating your own SmartDraw Template files is very
straightforward. A template file is exactly the same as a
regular SmartDraw drawing, but it has been saved using
the Save As Template command in the File menu .

Using this command displays the Save As Template
Dialog.
Save this Drawing as a Template

Manme:
Choogze a name for the template.

|Drder Farm Cancsl
Help

Select a category or folder for the template [or create a new one).

Select... | Buzineszz & ChartingForms

Create a new category...

Cateqary:

when searching for thiz template match the following words:
Enter words that describe the template zeparate by spaces or commag.

|Invoice, Farma, Order Entry

The Save As Template Dialog
Enter a name for the template in the Name field.

Select a category for the template using the Select button.
This displays the Browse for Folder dialog, displaying the
current tree of template categories. Simply select the one
you want.
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Browse for Folder EH

Select a categony or folder for the template,

=1-_] Templatez -
—-|_] Buziness & Charting
1 Flowchartz
=} o
1 More Chartz
1 QOrg Chartz & Trees
1 Time Lines
1 Clipart & Flyers
1 Electrical Engineering
._ Floar Planz & Facilities -
1 Mapz & Geography
Mechanical Engineerin
_E I ehanrk r'lianr.agm-c § ﬂ

Ok, | Cancel |

The Browse for Folder Dialog
You can also add your own categories by pressing the
Create a New Category button. This displays the Create a
New Category Dialog

Create a New Category

Choose a name forthe new category

|Inv0ices calse.
Help

Location:

Create either a new top-level categany, or a sub-categary inside anather,

" Create atop-level category.
f* Create new sub-category inside:

Business & Chating\Forms

The Create a New Category Dialog
You can create a sub-category inside the category you
already have selected, or create a new top level category
that is not inside any other by selecting the appropriate
button.

You must enter a name for the new category before you can
press the OK button.

The Save as Template Dialog also allows you to enter
words that you want to associate with the template when
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searching by keyword using the Search Bar. Enter as many
as you like separated by commas.

Once you have selected a category and a name, pressing
OK from the Create dialog saves your drawing as a new
template, and, if appropriate, creates the new category. This
is reflected immediately in the SmartDraw Explorer
panel.

Designing Templates

Templates are used both to store a desired set of default
settings for new documents and to store a sample drawing.

These are some of the defaults that are saved with a
template:

Snap-to-grid alignment

Line and Shape linking settings
Document toolbar

Colors and shadows

Line and border thickness

Font

Rulers and their scale

Page orientation and size
Zoom level

The first two of these are perhaps the most important
because they have a large impact and have very different
settings for different kinds of drawing.

Snap to Center vs. Snap to Top-Left

Shapes can either snap to the grid so that their centers align
with the grid lines, or so that their top and left edges snap to
the grid lines..

If your template is to be used to create drawings that make
use of the linking of lines to shapes, such as flowcharts,
organization charts, circuit diagrams, network diagrams and
engineering diagrams, then you should choose Snap to
Center. This parameter is set in the Define Rulers and
Grid Dialog (page 167).
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If, on the other hand, your template will be used to make
drawings where shapes are placed at exact locations so that
their edges line up, you should choose Snap to Top-Left.
Examples of diagrams of this kind include floor plans,
forms, timelines etc.

Line and Shape Linking

Also stored with the Template are the settings of Allow
Lines to Link, Allow Lines to Link to Shapes, and Allow
Shapes to Link under the Arrange Menu.

For diagrams in which lines are typically linked to shapes
(like flowcharts) line linking should be turned on and shape
linking turned off.

For diagrams that require alignment of shapes, like floor
plans, both should be off.

For diagrams that rely on the linking of shapes to lines, like
circuit diagrams, Allow Lines to Link to Shapes should be
turned on.

There are some drawing types that make use of shape
linking. These include "block flow" diagrams and chemical
formulae. Both of these types use shape linking to align and
connect library symbols.

Document Toolbar

If a Document Toolbar is attached to your drawing when
you save it as a template, it is stored as part of the template
definition. It will reopen as part of the new drawing created
with that template. You can use this to automatically open
the most useful symbol library for your drawing type as a
document toolbar.

Fonts and other Settings
The choices for default fonts, colors etc., are mainly a
matter of taste.

You set these defaults by applying them to a shape and a
line in the drawing you are using to design your template.
The changes you make to the shape and line also set the
default settings for new objects. Before you save the
template, you can delete the sample shape and line you
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used to set the defaults and the defaults will still remain in
force.

As an example, to change the default font for a template
first add a shape and type "hello™ inside it. Select the shape
so that it shows selection handles. Use the Font command
under the Text menu to change the font, size and style of
the text in the shape.

Now delete the shape by typing the backspace key (while it
is still selected). This drawing, saved as a template, will re-
open with the default font, size and style set to the values
you selected in the Font dialog.

Settings for Empty Drawings

If you want to change the default font or color scheme for
the new drawings you create using Create New Document
dialog, simply replace the EMPTY.SDT template in the
drawing type folder (page 215) with one that has your
desired defaults already set.

IMPORTANT: Make sure that the template you replace
EMPTY.SDT with was created from the same drawing-type.

Adding an Advisor

You can also add your own advisor to a template (or
library, see page 159). An advisor is just an image exported
from SmartDraw. You can export any drawing you create
to an advisor file using the Export command (page 185).
Just select SmartDraw Advisor (SDV) from the list of
formats. Make sure that you export the SDV file into the
ADVISOR folder within the SmartDraw Program folder,
otherwise you will not be able to assign it to a document.

You can mix text and graphics in your advisor image, but
for best results give the advisor a colored or opaque white
background and make three inches or less wide.

Once you have exported your advisor file, you can assign it
to a document by selecting the Show Advisor command
under the Help menu. If no advisor is currently assigned to
the document, you are asked if you want to assign one.
Clicking yes displays the Assign Advisor Dialog.
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Aszszign Adviszor File

Hame oK,
Type a narme for the advizor file. -
|My.-’-\c|visnr| Cancel
Al advisar files are stored in the: Help

ADVISOR folder inzide the
SmartDrave Program folder,

Assign Advisor Dialog

You can also change the advisor assignment for a
document by holding the Ctrl Key down as you select the
Show Advisor menu item.

Type the name of the advisor stored in the ADVISOR
folder (without its file extension) that you wish to assign to
this document and press OK. If you save the document, or
save the document as a template, the assignment will be
remembered and the advisor will open automatically each
time you re-open the document.

If this does not happen, make sure that you uncheck the
Advisor box in the Options dialog (page 222).

Skipping the New Drawing Dialog
You can change a setting in the Options Dialog to skip
showing the New Drawing dialog each time you want to
create a new drawing, and instead automatically open a
copy of the template SMRTDRAW.SDT.

To use this feature, create a drawing with defaults that you
want for all new drawings. Delete any objects and save it as
a template, in the same directory as the SmartDraw
program, with the name SMRTDRAW.SDT.

Next, use the Options command under the Tools menu and
click on the Copy the SMRTDRAW.SDT template radio
button.

Now each time you create a new drawing the New
Drawing dialog will not be shown. Instead a drawing with
the characteristics of the SMRTDRAW.SDT file that you
saved will be opened automatically.

SmartDraw User's Guide

Customizing SmartDraw e 221



The Options Dialog
The Options command under the Tools menu shows the
SmartDraw Options Dialog.

SmartDraw Options
Start Up: Mew Drawing:
: . : - ak

‘wihen starting the program show: ‘when creating a new drawing:

Ol g " Create an empty drawing [Mo dialog) Cancel
r Open dialog " Copy the "SMRTDRAW.SDT" template

" Mo Dialog. Create a nevw drawing. % Show the New Drawing Dialog Help
Page Linesz Hupeilink.

Show the dotted page separation lines in the following views: [~ Open Maximized

% Al magnifications  © B03% magnification or below Check this box to

open hyperlinked
Quick Previews drawings in their

Diraw comples symbaols as simple rectangles in Fit To Page view: maximized state.

* Mewer " flways € When they appear to be smal

Hints:

If you are new uger, SmartDiraw can provide hinks that pop-up the first time that you by
zomething new. Check the bowx below if you wish ta see hints.

[ Shaw Hints

SmartDraw Advizor
Check the box below if each time you open a template that has an agsociated SmartDraw
Advizor you do HOT want it to open automatically.

[T Da Mot Open Advisors Autormatically

The SmartDraw Options Dialog

This controls the way the program behaves when starting
up, when a new drawing is created and other options.

Start Up

When SmartDraw first starts up it can either show the
Welcome dialog, create a new empty drawing, or show the
Open dialog, depending on which radio button is selected.

New Drawing

When you create a new drawing with the New command,
(or by simply starting SmartDraw), SmartDraw can either
(a) present the New Drawing dialog, (b) automatically
create a blank drawing with the flowchart defaults, or (c)
look for the template file SMRTDRAW.SDT and attempt
to open it as a new untitled drawing.

You can save your own version of SMRTDRAW.SDT to
control the default colors, styles and other drawing
parameters for your newly created drawings (page 221).
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Page Lines

At magnifications of 50% or below, the boundaries of the
currently chosen page size are shown as dotted lines.
Selecting the All Magnifications radio button causes these
lines to be displayed in all magnifications.

Quick Previews

For large drawings that have lots of complex symbols
previewing in the Fit to Window view can sometimes be
time consuming. In these cases, you can increase redraw
speed by choosing to draw only a rectangular frame instead
of the whole image in this view, either always, or only
when a symbol is small.

Hints

SmartDraw will display hints for beginning users if this
box is checked. These are dialogs that pop-up automatically
when you try to use certain features of the program for the
first time. They attempt to explain what you are about to do
and provide a direct route to more detailed help.

Each hint will only appear once in each SmartDraw
session. Hints can be switched off from any Hint dialog.
We recommend that you leave the Hints switched on the
first few times you use the program.

SmartDraw Advisor

The SmartDraw Advisor window opens automatically
when certain templates and libraries are opened. The
Advisor is a special help screen with tips for using that
particular file.

You can prevent any Advisor window from opening
automatically by checking Do Not Open Advisors
Automatically in the dialog. You can also do this for each
individual advisor by closing that particular Advisor
window with a mouse click (page 17). Unchecking the box
allows all Advisors to open automatically again.
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Changing the Program Toolbar
The buttons on the Toolbar that show shapes can be
changed to show any of the 24 standard shapes. You can do
this either by double-clicking on the shape button that you
wish to change, or by clicking on it once and then selecting
the Toolbar command under the Tools menu. Both of these
actions present the Edit Toolbar Location Dialog.

Edit Toolbar Location EHE |
— Preferred Size: — Presiews:
-
width: LA
Height: ID-5D ﬂl

[Inches] Help
—Shape:————

Select Shape: T |
Adjuztment: ID.SD

— Info:

Select the shape for this location on the toolbar by pressing an
the "Select’’ button above.

Adjuzst the default shape by entering a number in the
Adjuztrent field.

Edit Toolbar Location Dialog

This dialog can also be used to set the default size of the
shape when it is added to the drawing using a drag and drop
operation, as well as setting the "shape" parameter itself.

Select Shape

A button shows the shape currently selected for this toolbar
location. Pressing the button presents a menu of standard
shapes. Selecting one changes the assignment of the button
to the selected shape.

Preferred Size

The width and height fields control the size of this shape
when a copy is added to the drawing using a drag and drop
operation. For circles, and other shapes that can only be
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sized proportionately, changing one value changes the
other, so as to maintain the same proportions.

Adjustment

The shape adjustment applies only to certain shapes and
adjusts their outline. For example, the degree of roundness
for rounded rectangles, the proportion of angled arrows,
and so on.

The Adjustment field is only visible if the shape selected
for the button may be distorted in some way. The parameter
value represents a proportion of the width or height of the
shape and is usually limited to a range of 0.1 to 0.4, or
sometimes less. The effect of the change can be seen in the
preview window if you click on it or click in another field.

Changing these parameters has no effect on any existing
shapes in your drawing. They affect only new shapes that
you add later. The outlines of existing shapes can be
adjusted by clicking on their adjustment handles, as
described in Adjusting Shape Outlines on page 81.

Changing the shape assigned to the button will change the
parameter to its default value for that shape.

Defining Your Own Menu Colors
The SmartDraw color menu shows a choice for More
Colors. If you choose this, you see the Color Dialog. This
lets you pick from any of the 16 million colors Windows
offers.
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Color

Menu color

4

EENC T
BEEC
|
EEECCr
mEErrr
HEE[ [
EENC
mEEC O

Hug: Iﬁ Bed: Iﬁ

Bevert Menu to Default | ; Sat |0 Greer: | 255
ColarlSolid Lurn: |24D Elus: |255
ok, | Caricel | Help |

The Color Dialog

To define a custom color, first move the slider control up
and down to achieve the amount of black and white you
want in the color. Next, click in the color window to choose
the hue of the color you want. You choice shows in the
Color/Solid box.

You can also enter an explicit RGB or HSL value for the
color in the fields that show these values.

Once you have chosen the color you want, press OK to
apply it to your drawing.

You can also use this dialog to customize the SmartDraw
color menu. Once you have chosen the color using the
color controls, pressing the Update Color Menu button
will update the currently selected square on the color menu
with the color in the color box. This new color will show in
this square in all the color menus from now on. You can
click on any square in the color menu before you press the
Update button, to select the square whose color you want to
replace.

Double clicking on a menu square copies its color to the
color box.

Pressing the Revert Menu to Default button changes all
the menus back to their default settings.
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SmartDraw Licenses

SmartDraw Licenses

SmartDraw will not run without a license. The license is
created when the program is installed with a valid serial
number. You can inspect the licenses installed on your
system by selecting the Licenses command under the Help
menu.

SmartDraw Licenses

Licenses for this installation of SmartDraw

Serial Murnber License Wersion Expires Enils Seats
SD-00-000000-0000-00000-50-00000 Single User License Professional §
S0-00-000000-0000-00000-50-00000 plus 5

4] |

For more infarmation about licensing SmartDraw library and template collections, go to www smartdraw.com

Licenses Dialog

This displays the Licenses dialog. It displays a list of all
licenses installed on your system.

Network Licenses

The standard SmartDraw network license allows ten or
more computers to access SmartDraw on a network. For
example, a 10-Seat license permits 10 different computers,
(other than the server itself) to access the program.

SmartDraw keeps track of the identity of each computer
that runs the program, and will not permit access to more
than is specified by the license.

The list of computers that have used the networked
installation is maintained on the server and can be
inspected and edited by selecting the Licenses command,
under the Help menu, to display the Network
Administration Dialog.
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SmartDraw Network User Administration

License Count:
Mumber of seats licensed: 3 Buy more...

MNumber of SmanDraw users 3 Disabled: 0 Cancel

Infarmation:

Pl |

Help
Your network license is based on the number of computers thatuse
SmanDraw on this netwark. A list of all computers that hawve used the
program (other than the server itself) is shown below.

If ywou are running SmantDraw from the server itself, you can "disakle"
any user thatyou no longer wantto hawve access to the program. This will
release one of your seats for use by another computer.

LUsers that hawe executed this installation of SmartDraw
Status  Serial Number User Mame

i John 14
Enabled 131000194 Martha Mars
Enabled 681234654 Mike Mercury

User Status: * Enahled = Disabled

The Network Administration Dialog

The number of seats supported by all network licenses
installed is shown at the top of the dialog, along with the
number of users (computers) that have run this installation.

The SmartDraw installation tracks the number of
computers that have accessed it using the serial number of
their hard disk.

If a user has run SmartDraw accidentally or no longer
needs access, you can disable their account by clicking on
the user and selecting the Disabled radio button. This frees
a license for use by another computer. The counts of
enabled and disabled users are updated immediately to
reflect this. You can also use this technique to disable old
hard disk serial numbers when computers are replaced or
upgraded with new drives.

As a security measure, these changes can only be made if
you log-on to the server itself.
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Adding Additional Network Licenses

If you find that you want to add licenses to an existing
networked installation, you can purchase more and add
them to the number available. You can do this online at
smartdraw.com, or by contacting SmartDraw sales at 858
549 0314.

When you purchase an additional license, running the
installation on the network server adds the new licenses and
increases the total available. For example, if you purchase
two 10-seat licenses and install each in the same program
folder, the single shared copy of SmartDraw will permit 20
seats.

SmartDraw Collections

SmartDraw offers more than 30,000 symbols, templates
and examples included in the nine, add-on SmartDraw
Collections. To use these fully, you must buy a license to
each collection, or buy SmartDraw Professional Plus
(which includes a license to all of the collections).

Without a license, each symbol appears with an unlicensed
stamp superimposed upon it.

1
—
=
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[mnl
=
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Unlicensed Symbol

Once a valid license is installed, the stamp no longer
appears, even in drawings already completed.

The serial number entered during installation controls
which licenses are installed on your system.
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Appendix A Technical

Support

SmartDraw.com provides technical support under the
following terms and conditions:

Registered Users

Up to 30 minutes of support is provided at no charge for the
first 90 days following purchase. Please have your serial
number ready. This is shown clearly on your CD or
download page.

After 90 days you may call with a credit card and obtain
support at the rate of $7.50 per 5 minutes. There is no
charge for time spent on hold and no charge if the problem
is identified as a "bug™ in SmartDraw. Whether the
problem qualifies as a bug is at the sole discretion of
SmartDraw.com

If a user reports a bug that prevents proper use of the
program during the first 90 days following registration,
SmartDraw.com will either fix the bug, or offer a complete
refund.

Suggestions
We invite suggestions. There is never any charge for
suggestions. Please contact us.

Using the Web
Please visit our Web site at:

http://www.smartdraw.com

Here you will find news of the latest releases, patches, tips
and useful information. If your web browser is installed in
the right (Microsoft) way, you can connect to our web site
by simply selecting the Browse SmartDraw Web Page
command, under the Help menu.
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Downloading the Latest Version

We frequently offer free updates that include bug fixes and
new features. To download these simply use the Get Latest
Version command, under the Help menu. Or visit

http://www.smartdraw.com/techsup.htm

Getting Support
The best way to do this is via electronic mail. There is
currently no charge for email support. Our email address is:

support@smartdraw.com
You can also call us at (858) 549 0314.

When reporting a problem, please include the following
information:

1) Your system configuration (version of Windows, printer,
display type etc.)

2) A description of how to reproduce the problem.
3) A sample file that exhibits the problem (if possible).

Troubleshooting

To get instant information about the most common user
problems, use the Get Latest Version command, under the
Help menu to connect to our technical support web pages
or visit

http://www.smartdraw.com/techsup.htm
Below we address some of the more common problems:

Windows Errors or Crashes

If SmartDraw crashes (stops working) when you attempt to
create a new drawing, or open an existing one, the most
common cause is the printer setting.

When SmartDraw does either of these things it loads the
current printer’s driver to determine the size of the
printable area of the current page setting.
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If your printer’s block of default parameters is corrupted or
the driver is not correctly installed, this can cause the
system to crash.

To test whether this is the cause of your problem, go the
Windows control panel and change the default printer
setting to some other printer. Now try SmartDraw again. If
the problem goes away you know that the original default
printer’s driver causes it.

To correct the problem, try re-installing the driver using the
Windows printer control panel.

If this does not appear to be the problem, please contact us
at support@smartdraw.com and email us a copy of the
file that causes the SmartDraw to crash upon opening.

Crashing when building the SmartDraw Explorer
Tree

You refresh the SmartDraw Explorer tree control by
closing and opening the very top folder, or by right clicking
on the top folder and choosing the Refresh Symbols and
Examples command from the right-click menu.

If this causes your system to crash it is most likely caused
by an incorrect version of the Windows system file (DLL)
that manages the tree control. You can fix this by installing
Internet Explorer 5.0 (or above). This updates these DLL’s
with a consistent set. You can obtain Internet Explorer from
Microsoft’s web site at the following URL:

http://www.microsoft.com/windows/ie/

Drawing Problems. The Graphics Acceleration
Setting.

Some graphics controller boards use some hardware
optimizations in attempt to speed up common graphics
operations. Leaving these features turned on can cause
graphic-intensive applications like SmartDraw to fail.

Two common symptoms of this problem are small dots that
are left behind on the screen when you move and object,
and the wrong colors appearing inside shapes when you
paste an image into another program.
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To correct these and similar problems, turn these
optimizations off.

To do this, go the Windows Control Panel and open the
System icon. Go to the Performance tab and press the
Graphics button. Move the slider control all the way to the
left, to turn off graphics acceleration. Now press OK and
restart your application.

Trial Version Runs Instead of Purchased Version
If, after you have installed your purchased SmartDraw
program, it still says Trial Version, when you run it then
you are in fact still running your old Trial Version (which
is still on your computer) instead of the new purchased
version that you installed.

You probably have a "shortcut” to the Trial Version, either
on your desktop or in your Start Menu. You need to stop
using this shortcut (you can also delete it if you like).
Instead use the new shortcuts (on your desktop and start
menu) that the purchased version of SmartDraw created
during its installation. If SmartDraw failed to create these
new shortcuts for some reason, you can create your own.

First start Windows Explorer and locate the file named
smartdraw.exe in the directory where you installed
SmartDraw on your hard disk. Right-click on the file with
your mouse, and choose "create shortcut” from the menu.
A shortcut will be created in that directory. Simply drag
the shortcut onto your desktop, and it will become an icon
that you can click on to run SmartDraw.

Colors Do Not Print

If your drawing has colored shapes and lines but they do
not print in color (even though you have a color printer)
make sure that the Print No Color box in the Print dialog
is unchecked. If this is not the problem, check the
Properties in the print dialog to make sure that your printer
IS set up to print color.
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Index

Add New Symbol, 152

Add New Table, 106

Add To Favorites, 73

Adding Automatic Connectors, 135
Adding notes to shapes, 192

Adding objects to drawings, 54, 144
Adding symbols to a library, 151
Adjusting shape outlines, 81, 82, 225
Advisors, 17, 160, 220, 223

Align, 59, 61, 125

Align Shapes and Text on the Line, 98, 132
Alignment, 95, 98, 102

Allow Lines to Link, 130, 219
Allow Shapes to Link, 130, 219
Allow Shapes to Link to Lines, 219
Arcs, 56

Arranging shapes, 136

Arrow button, 22, 59

Arrow keys, 61, 63

Arrowheads, 82, 139

Arrowheads, creating your own, 84
AutoCAD, 180, 185

AutoFill, 121

Automatic Connectors, 23, 42, 58, 68, 134
Automatic Connectors, combining, 137
Automatic Connectors, removing stubs, 138
Automatic Connectors, spacing, 137
Automatic dimension lines, 99
Automatic text resizing, 93, 96, 110
Background Color, 86

Background text object, 97

Bitmaps, 195

Bitmaps, colors, 186

Bitmaps, memory required, 187
Bitmaps, resolution, 186

Border Color, 80

Border Style, 80

Borders, 79

Breaking a link, 129

Bring to Front, 127, 176

Browse SmartDraw Web Page, 230

Bullets, 104

Cascade Windows, 21

Cause and Effect diagrams, 134

CD Dialog, 77

Cell Background Color, 112

Cell Background Shading, 112

Center Drawing on Page, 61, 126

Change Connector Shape, 58, 68, 135

Change Line Shape, 56, 57, 58, 68

Changing shape, 81

Check Spelling, 201

Check Spelling While You Type, 201

Circuit diagrams, 131

Clear, 69, 120

Clear Link, 191

Clipboard, 178

Close, 19

Collections, 8

Collections, Licenses, 77, 229

Color Menus, defining your own, 225

Colors, 41, 79, 82, 86, 87, 105, 112, 139, 150,
179, 225

Colors and Shadows, 52, 87

Column widths, 114

Communications link, 56

Connecting lines and shapes, 128

Connecting many lines to one shape, 129

Connection Points, 129, 149

Connectors, 23, 58

Control key, 55, 62

Convert To Table, 107

Convert To Text, 108

Converting files created in other programs, 182,
183

Coordinates, entering, 65

Copy, 120, 152, 178, 193

Create a Link, 190

Create New Library, 153

Creating a drawing, 32

Credits, 159

Curved lines, 56, 57
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Custom View, 166

Customize Arrowhead Dialog, 85

Cut, 120, 178

Dashed lines, 82

Dates, 121

Decomposing into SmartDraw shapes, 180, 185

Defaults, 28, 220

Define Colors and Shadows Dialog, 89

Define Library Credits, 159

Define Rulers and Grid, 24, 46, 167

Delete Cells, 120

Deleting objects, 69

Deleting text, 103

Digital link, 56

Dimensioning, 99, 167

Dimensions, entering, 65

Do Not Allow Text Editing, 110, 177

Docking, 144

Document toolbar, 23, 144, 219

Dotted lines, 27, 82, 165

Download Dialog, 76

Downloading SmartDraw, 13

Drag and Drop, 21, 33, 54, 145, 146, 151, 153,
194

Drawing area, 165

Drawing shapes and lines, 23, 33, 54, 144

Drawing size, 166

Drawing styles, 87

Drawing to scale, 49, 144, 158

Drawing types, creating your own, 215

Drawings, more than one in the same file., 28

Drawings, nested, 191

Duplicate, 69

Edit Shape Outline, 82, 162

Edit Symbol, 133, 146

Editing OLE objects, 198

e-mail, 231

Equations, 195

Exit, 29

Export, 185

Export Bitmap Dialog, 186

Exporting to bitmapped files, 186

Exporting to HTML, 188

Exporting to web pages, 188, 189

Favorites, 73

File Conversion Wizard, 183

File types, 180, 185

Fill Color, 79, 150

Find, 212

Find and Replace Dialog, 212

Find Next, 213

Find Previous, 214

Fit to Page, 166

Fit to Window, 166, 223

Flip, 57, 58, 68, 135

Flipping objects, 68

Floor plans, 218

Flowchart symbols, 29
FlowCharter, 183

Flowcharts, 128, 134, 139, 218
Font, 99

Font Dialog, 99

Font, changing default, 28, 219, 220
Footers, 174

Format Table, 109, 119

Forms, 96, 123, 177

Get Latest Version, 231

GIF Format Options, 189
Graphs, 195

Grid, 24, 124, 167, 218

Grid Line Color, 113

Grid Line Style, 113

Group, 46, 163

Growing objects, 62, 115
Guides, 24

Hard space, 104

Help, 15

Help button, 16

Hide Shadow, 89

Hints, 15, 223

HTML, 188

Hyperlink to Another File, 190
Hyperlinks, 190, 191

Hyperlinks in web pages, 189
Images, 179, 180

Import, 180

Insert Cells, 117

Insert Object, 197

Insert Symbol, 103

Inserting a SmartDraw object into Word, 194
Inserting an Office object into SmartDraw, 194
Install Dialog, 75

Installing SmartDraw, 12

Join Cells, 116

Join to Make a New Shape, 82, 162
Landscape vs. Portrait, 27, 170
Large Buttons with Names, 143
Large drawings, 165

Libraries, 24, 142, 196

Libraries menu, 142, 146
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Libraries, creating your own, 153, 155
Libraries, credits, 159

Libraries, finding, 71, 72

Libraries, opening, 73

Libraries, ordering symbols, 153
Libraries, using as a scrapbook, 152
Library Builder Wizard, 155
Library button size, 143

License, network, 14

Licenses, 227

Licenses, collections, 76, 78

Line button, 22

Line Color, 82

Line shape, 56

Line Style, 82

Lines, 22, 38, 68, 82

Lines, arcs, 56

Lines, attaching text, 97

Lines, connecting, 128

Lines, curved, 56, 57

Lines, drawing, 34

Lines, kinked, 129

Lines, linking, 34

Lines, segmented, 23, 57

Lines, showing dimensions, 99
Linking lines to each other, 133
Linking lines to shapes, 128
Linking shapes to each other, 133
Linking shapes to lines, 131
Linking, turning off, 130, 219
Links, 130, 199

Links, breaking, 129

Lock Object, 127

Make Same Size, 59, 63, 125
Margins, 27

Measurement, 24, 167

Microsoft Office, 193, 194, 195
Microsoft Office Companion, 195
Microsoft Word, 193, 194
Microsoft Word spelling dictionary, 208
Mirror image, 68

More Colors, 225

Moving objects, 61, 125, 126, 127
Moving with keys, 61

Multiple selection button, 22, 37, 60
Names, 143

Nested drawings, 191

Network Administration Dialog, 227
Network diagrams, 134

Network installation, 13, 161, 205, 227

Network license, 14

Network, adding users, 228, 229
New Drawing, 32

New..., 18, 129, 215, 218, 222
Notes, 192

Object Linking & Embedding, 178, 193, 194,

197
Object menu, 198
Objects, 54
OLE links, 199
Open, 20, 182
Open File Button, 20
Open Link, 191
Open Symbol Library, 47, 70
Opening a drawing, 20
Opening OLE objects, 198
Options, 221, 222
Ordering objects, 127, 176
Organization charts, 123, 134
Page margins, 27
Page numbers, 174
Page overlap, 171
Page Setup, 165, 170
Page size, 27
Paper size, 170
Paste, 120, 178, 179, 193, 194, 196
Paste Special, 193, 197
Pencil drawing, 55
Polygon Shapes, 162
Position and Size, 65
Postscript, 180, 185
Preview Files, 75
Print, 168, 172
Print Preview, 171
Printer, 170
Printing in color, 174
Printing large drawings, 171

Printing on large format printers, 165

Printing on one page, 126, 169, 174
Remove Symbol, 144

Replace, 212, 213

Right mouse button menus, 22, 200
Right Mouse Menus, 74

Rotate, 66

Rotating and Snaps, 66

Rotating multiple objects by the same angle, 67

Rotating objects, 66

Rotating, using menu commands, 66

Rotation, aligning objects, 67
Row heights, 114
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Rulers, 167

Rulers and Grid Dialog, 124
Running SmartDraw, 14
Save, 20

Save As, 20

Save As Template, 216
Scale to Ruler Settings, 144
Scaling the window, 166
Search Bar, 72

Searching for Symbols, 72
Segmented lines, 23, 57
Select All, 60

Selecting more than one object, 22, 37, 59, 60

Selecting objects, 36, 59

Selecting tables, 112, 113

Selection target, 45, 59, 67, 125

Send to Back, 60, 127, 176

Separating imported drawings, 180, 185
Set Angle, 66

Set Rotation Angle Dialog, 66
Shading, 80

Shadows, 87, 89

Shadows, applying only to certain shapes, 89

Shadows, text, 88, 89

Shape, 81

Shape borders, 79

Shape Sizing, 179

Shape Properties, 63

Shapes, 23, 41, 79

Shapes, adding text, 39, 93
Shapes, attachment points, 131, 133, 149
Shapes, connecting, 128

Shapes, creating your own, 162
Shapes, default size, 224

Shapes, drawing, 33

Shift key, 55, 59, 60, 61, 63, 67, 135, 179
Show Advisor, 17, 220

Show Explorer, 70

Show Grid, 24, 124

Show Length, 98

Show Relative Sizes, 143

Show Toolbar, 22

Size changes, on deleting text, 103
Sizing objects, 62, 115

Sizing rules, 63

Sizing with keys, 63

SmartDraw Explorer, 25, 48, 70
SmartDraw Explorer, closing, 70
SmartDraw Explorer, opening, 70
SmartDraw Explorer, width, 70

SmartDraw overview, 7

SmartDraw web page, 230, 231
SmartDraw, exiting, 29

SmartDraw, installing, 12
SmartDraw, Professional Plus, 8
SmartDraw, Professional Edition, 8
SmartDraw, Standard Edition, 7
SmartDraw, what’s new in SmartDraw 5, 8
SMRTDRAW.SDT, 221

Snap to grid, 45

Snaps, 24, 115, 124, 168, 218

Snaps and rotating objects, 66

Snaps, background text, 97

Soft hyphen, 104

Software diagrams, 122

Space Columns Evenly, 115

Space Evenly, 45, 61, 126

Space Rows Evenly, 115

Spacing in Automatic Connectors, 137
Spacing lines evenly, 69

Special characters, 104

Spelling correction, 64, 200

Spelling correction, turning it off, 63
Spelling Dictionaries, 205

Spelling Language, 204

Spelling Options, 209

Split Cells, 116

Square shapes, 55

Styles, 87

Styles, defining your own, 89

Styles, overriding, 92

Subscript, 101

Superscript, 101

Symbol colors, 64, 150, 179

Symbol libraries, 25, 142

Symbol names, 143, 146, 151

Symbol sizing, 148

Symbol types, 143, 147, 150, 151, 152
Symbols, adding your own, 151
Symbols, editing, 146

Symbols, finding, 71, 72

Symbols, removing, 144

Tab character, 104

Tab key, 111

Table colors, 112

Table Dialog, 106, 109, 119

Tables, 50, 106

Tables, adding rows and columns, 117, 119
Tables, appearance, 121

Tables, changing row and columns sizes, 114
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Tables, deleting rows and columns, 120 URL, 190

Tables, examples, 122 Use Snaps, 124

Tables, navigation, 111 View, 166

Tables, rows and columns, 108 Visio, 182, 183

Tables, scaling, 115 Web pages, 188, 189, 190
Tables, selection, 112, 113 Web site flowcharts, 192
Tables, text, 110, 120 Welcome Dialog, 14, 222
Target object, 45, 59, 67, 125 What’s New in SmartDraw 5, 8
Technical support, 230 Window Menu, 21
Template categories, adding your own, 217 Window scale, 166
Templates, 19, 33, 145 Window, drawing, 19, 21
Templates, creating your own, 216, 218 Window, library, 24, 142

Templates, finding, 71, 72
Templates, opening, 73

Text alignment, 95, 98

Text and the resizing of shapes, 93, 96, 110
Text button, 22, 93

Text Color, 105

Text entry, 39, 93

Text entry areas, 106

Text entry in fields, 177

Text Entry Properties, 94, 110, 177
Text in symbols, 149

Text in tables, 110

Text margins, 96

Text on lines, 97

Text shadows, 88, 89

Text Style, 101

Text, alignment, 102

Text, background, 97, 102

Text, bullets, 104

Text, color, 105

Text, fitting more inside a shape, 96
Text, fonts, 99

Text, preventing changes, 96, 110, 177
Text, single-click editing, 96

Text, using the enter key, 96

Tile Windows, 21

Timelines, 121, 122

Tips, 16

Toolbar, 22, 26, 55, 81, 101, 135, 171, 178, 195
Toolbar, changing, 23, 224

Toolbar, document, 23, 135, 144, 219
ToolTips, 22, 143

Transparent shapes, 59, 79
Troubleshooting, 231

Tutorial, 31

Undo, 26

Ungroup, 163, 180

Units, 167

SmartDraw User's Guide Index e 239



